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1 Introduction 

Signals InventaTM powered by the Signals Data Factory and Spotfire® empowers scientific professionals to readily 

access the scientific data the need to discover better drugs faster.  Through Revvity Signals proprietary Signals Data 

Factory, structured and unstructured scientific data are normalized and contextualized such that it can be discovered 

by Signals InventaTM scientists in an intuitive and efficient workflow. Through Spotfire, those data are automatically 

presented in a well-organized SAR workflow that encourages data exploration and drug candidate assessment. 

Moreover, Signals InventaTM includes features to drive the full life-cycle of data.  Data Generators ( scientists who are 

actively performing assays and publishing the processed results of those assays) can more easily publish their data 

with the confidence that those data will be discovered and re-used by the project teams.  Data consumers (scientist, 

project lead, med chemist who need to analyze aggregated data across assays) can dedicate their time to 

understanding the science rather than painstakingly assembling data. 

For Data Generators Signals InventaTM enables: 

• Definition of how their data should be captured and represented. 

• Upload data from flat files and Spotfire or integrate data from existing data sources. 

• Definition of reusable data mappings such that data from regular protocols upload easily. 

• Data verification and validation. 

• Fine-grained data set management.  

 
For Data Consumers Signals InventaTM enables: 

• Point-and-click data discovery. 

• Real-time feedback of what structures and data matches the defined query criteria. 

• Direct integration between search and analysis in all versions of Spotfire® (Spotfire Analyst, Business Analyst 

and Consumer).  

• Create complex nested queries and interrogate any subset of the stored data of interest. 
• Query over Structure, any compound attribute, and any assay or measurement, and query over an expanded 

set of comparison operators. 

• Control system performance directly by choosing estimated vs. precise query result counts at different levels 
of precision. 

• Save queries for easy re-use. Saved queries can be public or private.  
 
Note: Configurable entity names (e.g. Compound/Batch, Antibody/Lot) allow Signals Inventa assets/instances to be 

more meaningful. The model is configured by the System Administrator during system configuration. Only one name 

pair per Signals Inventa instance. Refer to the Signals Inventa Installation Guide for more information.   

For the purpose of screenshots, the Compound/Batch model is depicted throughout this User Guide. 

1.1 Out-of-the-Box (OotB) Dashboards 

Signals Inventa is a flexible and powerful tool for decision analytics.  Analytics dashboards and their underlying data 
schema are highly configurable by users.  Out-of-the-Box (OotB) Example Data is provided which can be used to 
recreate the pre-configured OotB Dashboards.  The Quick Start Guides will take users step-by-step through 
generating an example dashboard containing the most-frequently used visualizations. To follow the Quick Start 
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Guides, ensure that the example data is loaded. The guides and the example data can be downloaded from the 
Signals Inventa Online Help (Example Data Tutorials Quick Link).  
 
The Quick Start Guide is divided into 3 main sections: Beginner, Intermediate, Advanced, with each building on details 
of the previous sections. The guide can be followed chronologically, or users can skip specifically to those sections 
most relevant to their workflows. Some tutorials can be completed in under 5 minutes. Previous knowledge of Spotfire 
or Signals Inventa is not required, so even brand-new users should feel enabled to follow topics in the Advanced 
section.   
 
 
Beginner Dashboard (~15 mins) 
 

• This Beginner Dashboard will teach users to query data using Global Search, generate a SAR table, generate 
a dose response curve for a reported IC50, and analyze the correlation between two related inhibition assays. 
The inhibition data in this dashboard was produced using the OotB 4P Dose-Response IC50 Assay Workflow 
from Signals VitroVivo. The following topics and common questions are addressed:  

 
Loading the OotB Example Data with Global Search  

How can I query all assay data related to any of my compounds so I can generate a SAR table? 
Creating a SAR Analysis with the OotB Example Data 

How can I customize a SAR table to only show certain assays, and have it update with the latest data? 
Building Well Level Details using OotB Example Data 

How can I build a visualization that represents IC50 data and its corresponding dose response curve data? 
Building Assay Correlations using the OotB Example Data 

How can I plot the performance of two related assays and calculate the ratio between them? 

  
Intermediate Dashboard (~25 minutes) 
 

• This Intermediate Dashboard builds upon the beginner dashboard and expands it by teaching users how to 
configure SAR table and Measurement table views, as well as leverage common Chemistry tools such as 
substructure searching, scaffold extraction, and R-group decomposition. The following topics and common 
questions are addressed:  

 
Customizing the SAR Analysis for OotB Example Data 

How can I view data in the SAR table based on Batches instead of Compounds? 
How can I color code assay results in the SAR table so I can quickly identify actives? 
How can I view the individual assay values alongside aggregated value sin my SAR table? 

Customizing Well Level Details using the OotB Example Data 
How can I use my own values to generate a dose response curve rather than using Spotfire automatic curve fit? 

Chemistry Calculations using the OotB Example Data 
How can I calculate physical properties of my compounds?  
How do I perform a structure or substructure search on an existing data table? 
How can I identify compounds in a series by extracting a common scaffold? 
How can I compare properties and activities of compounds that are related by a conserved core? 

  
Advanced Dashboard (~35 minutes) 

 

• This Advanced Dashboard is designed to teach data stewards how to define entity and measurement data 
schemas, and to teach assay scientists how to load and standardize their assay results. The visualizations in 
this dashboard build upon the intermediate dashboard and expand upon it by introducing powerful, but less-
frequently used configurations. The following topics and common questions are addressed:  

 

 
Loading Entity Data into Signals Data Factory (Data Administrators only) 
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How can I define my own entity and data schema in Signals Inventa (via Signals Data Factory)? 
Loading Results Data into Signals Inventa 

How can I load my own experiment assay data into Signals Inventa? 
Building a Global Search Query 

How can I use Global Search's unified interface to query my newly added entity and measurement data? 
Customizing the SAR Analysis for the OotB Example Data - Advanced 

How can I modify which experimental variables are aggregated in my SAR table? 
How can I add a compound or batch property to my SAR table while limiting the number of columns that are 
created? 
How can I include standard deviation, count, and other metrics to a SAR table endpoint cell?  
How can I create collections of compounds so I can easily filter to that set and see relationships between sets of 
compounds?  

 
Optional Guide: Related Entities (~20 minutes) 

 

• This optional dashboard will teach data administrators how to configure related entities and enable scientists 
to leverage the relationships with core entities within the Global Search. Refer to the section Search by 
Related Entity for more information.  

  
Optional Styling Guide (~30 minutes) 

 

• This optional guide will build upon the Advanced Dashboard to add additional flair to visualizations including 
custom color schemes, text formatting, and gallery form configurations. 

  
 

OotB Dashboards Description Download 
Supporting Files 

Inventa Beginner Dashboard 
Inventa Intermediate Dashboard 
Inventa Advanced Dashboard 
Related Entities 
Optional Styling Guide 

Out-of-the-Box (OotB) Example Data is provided 
which can be used to recreate the pre-configured 
OotB Dashboards.   

 

 

 
 
If there are additional OotB dashboards or visualizations you would like to see in future releases, please submit them 
to Revvity Signals Software  Ideas Portal for consideration:  https://revvitysignals.com/ideas-portal 
 
 

  



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 11 of 366 

  

2 Setting Preferences 

Preferences for Signals Inventa can be set to define default values through the Spotfire Administration Manager.  

You will need to ensure that the SDF Base URL and Signals Data Factory project name is set as Spotfire preference.  

2.1 Accessing the Signals Inventa Preferences 

To access the Signals Inventa preferences:  

1. Open the Spotfire client, and logon as a Spotfire Administrator. From the Tools menu, select the 

Administration Manager sub-menu item. The Administration Manager is only enabled if you logon connected 

to the Spotfire Server.  

The Administration Manager window opens.  

 

2. Click on the Preferences tab.  
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3. Select the Group Name to which the preferences should be applied. 
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4. Expand Signals Lead Discovery 

Note: For the Signals Inventa 3.5.1 release, the Spotfire preference category name will remain as Signals Lead 

Discovery.  
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2.2  Setting the Auto Mapping Threshold 

The algorithm used in Auto Mapping feature of the Publish Measurements tool is dependent on a threshold value to 

adjust the accuracy of the mapping result. The default value for Auto Mapping is 0.4.  If you find that the automapping 

behavior is too fuzzy or not fuzzy enough, you can modify the threshold for the comparison algorithm in the Spotfire 

preferences. 

Refer to the section Automapping for information on this feature.  

To set the Auto Mapping preference: 

1. Access the Signals Inventa preferences via the Administration Manager (refer to Steps 1-4 above - Accessing 

the Signals Inventa Preferences section). 

2. Select Auto Mapping. 
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3. Click on the Edit button to open the Edit Preferences dialog. 
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Note: The default value for Auto Mapping is 0.4. However, Spotfire does not display the default value, and therefore 

the field appears blank. 

4. Enter a decimal value to indicate the threshold of string comparison when doing the auto mapping between 

Measurement Type attributes and Spotfire data table columns. This value should be between 0 (inclusive) and 

1 (inclusive), where 0 represents no match and 1 indicates a full match. 

5. Click OK. 

Note: It is recommended that you restart the Spotfire Client in order for the new Preference settings to take effect. 

Note: If the Web Player is open, it is necessary to log out and log in again in order for the new Preference settings to 

take effect. 

2.3 Setting the SDF ApiKey 

Once the SDF ApiKey preference is set correctly, users are able to suppress the login dialog by setting the Suppress 

Login Dialog preference to True, so that the API key will be used for authentication and users don’t need to provide 

username and password when using Signals Inventa apps. 

Note: Refer to the Manage Users (API Keys) section for information on how to create an API key for a given user.  
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To set the SDF ApiKey preference: 

1. Access the Signals Inventa preferences via the Administration Manager (refer to Steps 1-4 above – Accessing 

the Signals Inventa Preferences section). 

2. Select General. 

 

3. Click on the Edit button to open the Edit Preferences dialog. 
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Note: The default value for SDF ApiKey is blank. This option enables Signals Data Factory authentication.  

4. Enter the SDF ApiKey for the user.  

5. Click OK. 

Note: It is recommended that you restart the Spotfire Client in order for the new Preference settings to take effect. 

Note: If the Web Player is open, it is necessary to log out and log in again in order for the new Preference settings to 

take effect. 

2.4 Setting the SDF Base URL 

To set the SDF Base URL preference: 

1. Access the Signals Inventa preferences via the Administration Manager (refer to Steps 1-4 above – Accessing 

the Signals Inventa Preferences section).  

2. Select General. 
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3. Click on the Edit button to open the Edit Preferences dialog. 
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Note: The default value for SDF Base URL is “http://localhost ”. However, Spotfire does not display the default value, 

and therefore the field appears blank. 

4. Enter the SDF Base URL. 

5. Click OK. 

Note: The SDF Base URL must begin with “http” or “https”. A host name, an FQDN or an IP address is not a valid 

setting for this preference. 

Note: It is recommended that you restart the Spotfire Client in order for the new Preference settings to take effect. 

Note: If the Web Player is open, it is necessary to log out and log in again in order for the new Preference settings to 

take effect. 

2.5 Setting the SDF Project Name 

To set the SDF Project Name  

1. Access the Signals Inventa preferences via the Administration Manager (refer to Steps 1-4 above – Accessing 

the Signals Inventa Preferences section).  

2. Select General. 



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 21 of 366 

  

 

 

 

3. Click on the Edit button to open the Edit Preferences dialog. 
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4. Enter the SDF Project Name to which Signals Inventa will point to. The SDF Project Name is the name of the 

project that you previously created in Signals Data Factory specifically to be used by Signals Inventa. For 

more information about the Signals Data Factory projects, please refer to the section “Configuring the Signals 

Data Factory”. 

5. Click OK.  

Note: It is recommended that you restart the Spotfire Client in order for the new Preference settings to take effect. 

Note: If the Web Player is open, it is necessary to log out and log in again in order for the new Preference settings to 

take effect. 

2.6 Setting the Show SDF Project Selector  

A preference can be set to show the SDF Project Selector in the Global Search, Publish Measurements and Assay 

Details visualization interfaces.  

To set the Show SDF Project Selector preference: 

1. Access the Signals Inventa preferences via the Administration Manager (refer to Steps 1-4 above – Accessing 

the Signals Inventa Preferences section). 
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2. Select General. 

 

3. Click on the Edit button to open the Edit Preferences dialog. 
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Note: The default value for Show SDF Project Selector is False. However, Spotfire does not display the default value, 

and therefore the field appears blank. 

4. From the Show SDF Project Selector preference drop down list, select True to show the Project Selector on 

the Global Search and Publish Measurements interfaces.   

5. Click OK. 

Note: It is recommended that you restart the Spotfire Client in order for the new Preference settings to take effect. 

Note: If the Web Player is open, it is necessary to log out and log in again in order for the new Preference settings to 

take effect.  

2.7 Setting the Suppress Login Dialog  

A preference can be set to suppress the Login Dialog for Global Search and Publish Measurements Tool.   

To set the Suppress Login Dialog preference: 

1. Access the Signals Inventa preferences via the Administration Manager (refer to Steps 1-4 above – Accessing 

the Signals Inventa Preferences section).  
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2. Select General. 

 

3. Click on the Edit button to open the Edit Preferences dialog. 
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Note: The default value for Suppress Login Dialog is False. However, Spotfire does not display the default value, and 

therefore the field appears blank. 

4. Select True to suppress the login dialog . Users will be logged in directly if the SDF ApiKey has been set up 

correctly. Refer to Setting the SDF ApiKey section.  

5. Click OK. 

Note: It is recommended that you restart the Spotfire Client in order for the new Preference settings to take effect. 

Note: If the Web Player is open, it is necessary to log out and log in again in order for the new Preference settings to 

take effect. 

2.8 Setting the Default Search Scope in Global Search   

A preference can be set to define the default search scope in Global Search when it is first opened. The preference 

can be set to Compounds, Batches or Measurements.  

To set the Default Search Scope in Global Search: 

1. Access the Signals Inventa preferences via the Administration Manager (refer to Steps 1-4 above – Accessing 

the Signals Inventa Preferences section).  
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2. Select Global Search.  

 

3. Click on the Edit button to open the Edit Preferences dialog. 
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Note: The default value for Default Search Scope is  HierarchicalEntityLevel2. However, Spotfire does not display 

the default value, and therefore the field appears blank. 

4. From the Default Search Scope preference drop down list, select the default search scope ( 

HierarchicalEntityLevel1, HierarchicalEntityLevel2 or Measurements) to be used by Global Search when it is 

opened.      

Note: HiearchicalEntityLevel1 refers to the first level hierarchical entity, and HierarchicalEntityLevel2 refers to the  

second level hierarchical entity. If the user has configured the hierarchy to use “Compound/Batch” for example, 

HiearchicalEntityLevel1 corresponds to Compounds, whereas HiearchicalEntityLevel2 corresponds to Batches. If the 

user has configured the hierarchy to use “Antibody/Lot”, as another example, HiearchicalEntityLevel1 corresponds to 

Antibody, whereas HiearchicalEntityLevel2 corresponds to Lot. 

5. Click OK. 

Note: It is recommended that you restart the Spotfire Client in order for the new Preference settings to take effect. 

Note: If the Web Player is open, it is necessary to log out and log in again in order for the new Preference settings to 

take effect. 
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2.9 Setting the Include Attributes by Default in Global Search   

A preference can be set to include measurement attributes by default when downloading results from Global Search 

into Spotfire.  

To set the Include Attributes By Default preference: 

1. Access the Signals Inventa preferences via the Administration Manager (refer to Steps 1-4 above – Accessing 

the Signals Inventa Preferences section).  

2. Select Global Search. 

 

3. Click on the Edit button to open the Edit Preferences dialog. 
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Note: The default value for Include Attributes by Default is True. However, Spotfire does not display the default value, 

and therefore the field appears blank. 

4. From the Include Attributes by Default preference drop down list, select False to exclude the attributes by 

default when downloading results from Global Search into Spotfire.     

5. Click OK. 

Note: It is recommended that you restart the Spotfire Client in order for the new Preference settings to take effect. 

Note: If the Web Player is open, it is necessary to log out and log in again in order for the new Preference settings to 

take effect. 

2.10 Setting the Search Deleted Signals Notebook (SNB) Materials   

In the case where you are sending materials from Signals Notebook to Signals Inventa, you can indicate if materials 

that have been deleted from Signals Notebook but still exist because of associated measurements are searchable in 

Global Search.    

Refer to Appendix E: Signals Notebook Integration for more information on Signals Notebook Materials 

Synchronization.   
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To set the Search Deleted SNB Materials preference: 

1. Access the Signals Inventa preferences via the Administration Manager (refer to Steps 1-4 above – Accessing 

the Signals Inventa Preferences section).  

2. Select Global Search. 

 

3. Click on the Edit button to open the Edit Preferences dialog. 
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Note: The default value for Search Deleted SNB Materials is False. However, Spotfire does not display the default 

value, and therefore the field appears blank.    

4. From the Search Deleted SNB Materials preference drop down list, select True to include deleted Signals 

Notebook materials in the Global Search.  In this case, two additional attributes will be added for a user to 

create conditions for searching for the deleted Signals Notebook materials.  

 

5. Click OK. 

Note: It is recommended that you restart the Spotfire Client for the new Preference settings to take effect. 

Note: If the Web Player is open, it is necessary to log out and log in again for the new Preference settings to take 

effect. 
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2.11 Setting the Turn Off Summary Button In Global Search 

In the case where you want to load the assay summary results automatically, there is the option to hide the Show me 

the summary button on the Summary search panel in Global Search.     

Refer to the section Getting the Summary of the Query to be performed for more information.  

To set the Turn Off Summary Button preference: 

1. Access the Signals Inventa preferences via the Administration Manager (refer to Steps 1-4 above – Accessing 

the Signals Inventa Preferences section).  

2. Select Global Search. 

 

3. Click on the Edit button to open the Edit Preferences dialog. 
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Note: The default value for Turn Off Summary Button is False. However, Spotfire does not display the default value, 

and therefore the field appears blank.    

4. From the Turn Off Summary Button preference drop down list, select True to hide the Show me the 

summary button on the Search summary panel.   

5. Click OK. 

Note: It is recommended that you restart the Spotfire Client in order for the new Preference settings to take effect. 

Note: If the Web Player is open, it is necessary to log out and log in again in order for the new Preference settings to 

take effect. 

2.12 Setting the Undefined Measurement Type Display Name 

In the case where data is loaded directly into the Assay Endpoints Results table and measurement types are not 

defined, the resulting node in the assay hierachal tree is  labelled ‘Endpoints’ by default. The Undefined Measurement 

Type Display Name preference allows you to specify a display name if you choose not to use the default name.     

In the case, where there is a mix of some and no measurement types, the resulting node in the assay hierarchal tree is 

labelled ‘Other Endpoints’ by default. The Undefined Measurement Type Display Name preference allows you to 

specify a display name if you choose not to use the default name of Endpoints. For example, the node will be labelled 

“Other {preference value}”.   
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To set the Undefined Measurement Type Display Name preference: 

1. Access the Signals Inventa preferences via the Administration Manager (refer to Steps 1-4 above – Accessing 

the Signals Inventa Preferences section).  

2. Select Global Search. 

 

3. Click on the Edit button to open the Edit Preferences dialog. 



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 36 of 366 

  

 

Note: The default value for Undefined Measurement Type Display Name is Endpoint. However, Spotfire does not 

display the default value, and therefore the field appears blank.    

4. Enter a display name for the undefined measurement type.    

5. Click OK. 

Note: It is recommended that you restart the Spotfire Client in order for the new Preference settings to take effect. 

Note: If the Web Player is open, it is necessary to log out and log in again in order for the new Preference settings to 

take effect. 

2.13 Setting the Default SAR Layout Sharing Groups in SAR 

Analysis App 

A preference can be set to define the default SAR Layout Sharing Groups in SAR Analysis App. The preference can 

be set to Compounds, Batches or Measurements.  

To set the Default SAR  Layout Sharing Groups in SAR Analysis App: 

1. Access the Signals Inventa preferences via the Administration Manager (refer to Steps 1-4 above – Accessing 

the Signals Inventa Preferences section).  
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2. Select SAR Analysis App.  

 

3. Click on the Edit button to open the Edit Preferences dialog. 
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Note: The default value for Default SAR Layout Sharing Groups is Empty. However, Spotfire does not display the 

default value, and therefore the field appears blank. 

4. Enter default sharing groups for the group sharing mode; separated by commas. If this preference is set, the 

Groups drop down list when defining SAR layout permissions will automatically populate the group names 

specified here.      

5. Click OK. 

Note: It is recommended that you restart the Spotfire Client in order for the new Preference settings to take effect. 

Note: If the Web Player is open, it is necessary to log out and log in again in order for the new Preference settings to 

take effect. 
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2.14 Setting the Default SAR Layout Sharing Mode in SAR Analysis 

App 

A preference can be set to define the default SAR Layout Sharing Mode in SAR Analysis App. The preference can be 

set to Private or Groups.   

To set the Default SAR Layout Sharing Mode in SAR Analysis App: 

1. Access the Signals Inventa preferences via the Administration Manager (refer to Steps 1-4 above – Accessing 

the Signals Inventa Preferences section).  

2. Select SAR Analysis App.  

 

3. Click on the Edit button to open the Edit Preferences dialog. 
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Note: The default value for Default SAR Layout Sharing Mode is Private. However, Spotfire does not display the 

default value, and therefore the field appears blank. 

4. Enter Private or Groups to define the default SAR Layout Sharing Mode to be used when the SAR Analysis 

App is first opened.       

5. Click OK. 

Note: It is recommended that you restart the Spotfire Client in order for the new Preference settings to take effect. 

Note: If the Web Player is open, it is necessary to log out and log in again in order for the new Preference settings to 

take effect. 
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2.15 Adding the SDF Base URL to Whitelist for Allowed URIs 

In order for Spotfire to open the SDF login page in a pop-up web browser window, the SDF Base URL must be added 

to the Whitelist for Allowed URIs Spotfire application preference.  

To add the SDF Base URL to Whitelist for Allowed URIs: 

1. Open the Spotfire client, and logon as a Spotfire Administrator. From the Tools menu, select the 

Administration Manager sub-menu item. The Administration Manager is only enabled if you logon connected 

to the Spotfire Server. 

2. Click on the Preferences tab. 

3. Select the Group Name to which the preferences should be applied. 

4. Expand Application and select ApplicationPreferences. 

5. Click the Edit button. 

6. Click the ellipsis icon on the Whitelist for Allowed URIs item. 

 

7. In the String Collection Editor, add the SDF Base URL in the text box. 

8. Click OK to close the String Collection Editor. 

9. Click OK to close the Edit Preferences dialog. 
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10. Click Close to close the Administration Manager. 

Note: It is recommended that you restart the Spotfire Client in order for the new Preference settings to take effect. 

Note: If the Web Player is open, it is necessary to log out and log in again in order for the new Preference settings to 

take effect. 
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3 Manage Measurement Types Tool 

The Manage Measurement Types tool allows data administrators to manage measurement types. It is implemented 

via a website deployed together with the metastore service. You need to configure the SDF Base URL in Spotfire 

Preferences before using this tool. Refer to Setting the SDF Base URL section for information on setting this 

preference. 

3.1 Accessing the Manage Measurement Types Tool 

The Manage Measurement Types tool is accessed through the main Spotfire Interface. You will be required to login to 

the Signals Data Factory using your SSO credentials before you can access the Manage Measurements Types tool if 

you have not already been authenticated or your session has expired.  

Note: If the SDF ApiKey Spotfire preference has been set, you will not be required to logon. Refer to Setting the SDF 

APIKey section for further information.   

Note: If you are using Safari web browser, please make sure that it won’t block the pop-up dialog from Signals Data 

Factory domain. To enable the pop-up dialog from Signals Data Factory: 

1. In Safari, select Preferences menu. 

2. In the Preferences dialog, choose Websites tab. 

3. In the Configured Websites list, make sure that the Signals Data Factory web page has been set to Allow.  

To access the Management Measurements Type tool:  

In both Spotfire Analyst Client and Web Player:   

1. Open data in Spotfire. 

2. Select Tools > Signals Inventa > Manage Measurement Types from the main menu to open the Manage 

Measurement Types in your system default web browser. Alternatively, you can open the Visualization types 

flyout and click the   item to open it.  

3.2 Managing Attributes 

Measurement attributes are a definition of the measurement values collected. Attributes are managed in the Edit 

Attributes page.  

To access the Edit Attributes page: 

1. From the Information Design drop-down list box, select Measurement Attributes. 
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The Edit Attributes page opens, similar to the example shown below.  

 

The Edit Attributes page is a single page application for querying, adding, editing and deleting attributes. 

The table lists all currently defined measurements attributes. Each row represents an attribute template. From the 

table, attributes can be edited or deleted.  

3.2.1 Defining a New Attribute 

Note: You can enter a query string in the text box located to the right of the Add New Attribute button to filter the 

attributes in the table. 

To add a new attribute:  

1. Click the +Add New Attribute button to add a new row to the bottom of the table, similar to the example 

shown below.  
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2. Enter a unique Attribute Name in the New (change to save) text box. If the attribute name already exists, you 

will be notified that an attribute with the same name already exists, and that you must edit the name to save 

the attribute. The text in the row will change to red until this violation is resolved.   

 

3. Select the Data Type (Number, Text, Date or Image) from the drop-down list. An optional description can be 

entered.   

After navigating from this new row, the attribute is automatically saved to the metastore service.  

3.2.2 Editing an Existing Attribute 

To edit an attribute: 

1. Click the cell to edit.  

2. Make the necessary modifications.  

After navigating from the cell, any edits are automatically updated in the metastore service. 
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3.3.3 Deleting an Attribute 

To delete an attribute: 

1. Hover the mouse over the attribute to delete. An ‘X’ icon appears in the last column for that row.  

 

2. Click the ‘X’ icon. The attribute is deleted, and the following message is displayed. 

 

3.3 Managing Measurement Types 

Measurement types are a category of measurements that are similar. The measurement types are managed in the 

Edit Measurement Types and Attributes page. Measurement types can be associated with a Compound or Batch.  

To access the Edit Measurement Types and Attributes page: 

1. From the Information Design drop-down list box, select Measurement Types. 

 

The Edit Measurement Types and Attributes page opens, similar to the example shown below. 
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The Edit Measurement Types and Attributes page is a single page application for adding measurement attributes to a 

selected measurement type. In addition, you can delete attributes from the selected measurement type. From here, 

you can also choose a measurement type as the details of another measurement type. You can also change the 

‘Required’ status from Yes to No and vice versa. From here, you can also create new Measurement Types, and 

proceed directly to defining the mapping for the endpoint publication map.   

The table lists all currently defined measurement attributes for the selected measurement type. Each row represents 

an attribute template.  

3.3.1 Defining a New Measurement Type 

To create a new measurement type:  

1. Click the + Create New Measurement Type button to open the Create New Measurement Type page, similar 

to the example shown below. 
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2. Enter a unique name for the new Measurement Type.  

3. Click the Add button. The Associate New Attribute with Measurement Type dialog is displayed.  

  

From here, you can select an existing attribute to associate with the measurement type or create a new attribute. 

a) From the drop-down list box, select an existing attribute directly or type to search for an existing attribute and 

then click the Add New Attribute button to add the selected attribute to the measurement type. 

b) To create a new attribute, type a new attribute name to display the Create New Attribute option, similar to the 

example shown below. 

Note: The attributes that have already been added to the measurement type will not be shown in the   drop-

down list box. 

Note: If you have very large number of attributes available in the system, the drop-down list box will only list 

2000 items for selection. You will need to keep typing in order for it to update continuously and narrow down 

the available items for selection. 
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i. Select the new attribute name (create new Attribute) to expand the dialog, similar to the example shown below. 

 

 

ii. Specify the Attribute properties for the new attribute (data type, optional description).  

iii. If the attribute is required, enable the Required to be Present checkbox. 
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iv. Click the Add New Attribute button to add the new attribute to the current measurement type.  

v. Repeat these steps to add additional new attributes to the measurement type. Click Close when you are 

finished. 

vi. Enter an optional description for the measurement type. 

vii. Select if the new measurement type is associated with a Compound or Batch. By default, Batch is selected.  

If applicable, select the measurement type category (PKStudy, PKDetail, Ppb). These refer to measurement 

types from Signals VitroVivo. If a measurement type is identified with one of these categories, it will 

subsequently be targeted for use in the Target Engagement Profile App. For example, the PK Parameters 

measurement type which comes directly from Signals VitroVivo is tagged with PKStudy measurement type 

category, the PK Time Concentration measurement type is tagged with PKDetail measurement type category 

and the Plasma Protein Binding measurement type is tagged with Ppb measurement type category.  

3.3.2 Configuring a Measurement Type as Details of another Measurement 

Type 

From the Edit Measurement Types and Attributes window, you can choose a measurement type as a detail of another 

measurement type.  

Details measurements store the inputs that make up a final result (e.g. the wells of an IC50).  

For example, the “Well-level % inhibition” assay could be designated as a detail of the “IC50” assay. In the Publish 

Measurements app, you could publish both the details result to the details Measurement Type (e.g. the well-level % 

inhibition assay) as well as the main assay result (e.g. the IC50 assay). 
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To configure a measurement type as details of another measurement type:  

1. Enable the “This measurement type’s details are stored again measurement type:” checkbox.  

2. From the drop-down list, select an existing measurement type to be the details of the selected measurement 

type. Note a measurement type cannot be the details of itself.  

 

Note: This drop-down box will list all the measurement types with the exception of the current one allowing you to 

choose any measurement type in the system to be the details of the current measurement type. In doing so, you can 

achieve a multi-level parent-detail hierarchy across multiple measurement types, or even a circular reference between 

measurement types. However, in other Signals Inventa apps, only the first two levels of the hierarchy will be used to 

represent the parent and detail relationship, and remaining levels in the hierarchy are ignored. 

3.3.3 Editing an Existing Measurement Type 

From the Edit Measurement Types and Attributes page, you can add or delete attributes to/from an existing 

measurement type. 

Note: You can enter a query string in the text box located to the right of the Add button to filter the attributes in the 

table.  

To add an attribute to an existing measurement type: 

1. From the Measurement Type drop-down list, select the measurement type to which you want to add an 

attribute.  

2. Click the Add button. The Associate New Attribute with Measurement Type dialog is displayed.  
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From here, you can select an existing attribute to associate with the measurement type or create a new attribute. 

a) From the drop-down list box, select an existing attribute directly or type to search for an existing attribute and 

then click the Add New Attribute button to add the selected attribute to the measurement type. 

b) To create a new attribute, type a new attribute name to display the Create New Attribute option, similar to the 

example shown below 

  

i. Select the new attribute name (create new Attribute) to expand the dialog, similar to the example shown 

below. 
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ii. Specify the Attribute properties for the new attribute (data type, optional description).  

iii. If the attribute is required, enable the Required to be Present checkbox. 

 

iv. Click the Add New Attribute button to add the new attribute to the current measurement type.  

viii. Repeat these steps to add additional new attributes to the measurement type. Click Close when you are 

finished. 
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To delete an attribute from an existing measurement type:  

1. From the Measurement Type drop-down list, select the measurement type from which you want to delete an 

attribute.  

2. Hover the mouse over the attribute to delete. An ‘X’ icon appears in the last column for that row.  

 

3. Click the ‘X’ icon to delete the attribute from the selected measurement type.  

To change the description of the measurement type: 

1. From the Measurement Type drop-down list, select the measurement type for which you want to modify the 

description.  

2. In the Description text box, type the description for the measurement type. 

3. Move the focus out of the text box, the description will be persisted automatically. 

3.3.4 Deleting a Measurement Type 

To delete a measurement type:  

1. From the Measurement Type drop-down list box, select the measurement type to delete. 

2. Click the Delete Measurement Type  icon. You will be prompted to confirm the deletion.  Any endpoint 

publication maps using this measurement type will also be deleted.   

 



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 55 of 366 

  

3.3.5 Defining the Assay Details Layout 

For each measurement type, you can define how the assay data of that measurement type will be presented. With the 

Assay Details Layout definition tool, you can define which attributes of a particular measurement type to display in the 

Assay Details page , and also you can choose the presentation layout and data format for the attributes. 

The Assay Details Layout button on the Edit Measurement Types and Attributes page will redirect you to the 

Assay Details Layout page, which will be described in more detail in the Edit Assay Details Layout section. 

3.3.6 To Publish Endpoints 

After defining a measurement type, you are encouraged to proceed with the workflow and define the mapping against 

the endpoint publication map. This can be accomplished by clicking on the To Publish Endpoints button. This will 

take you directly to the Prepare Measurement Types for Publication page. Refer to the section “Managing Publish 

Endpoints”.   

3.4 Managing Publish Endpoints 

Endpoint Publication maps relate a measurement type, and most importantly, the endpoints of the measurement type 

to the Signals Inventa data index. The Endpoint Publication Maps are managed in the Prepare Measurement Types 

for Publication page. 

To access the Prepare Measurement Types for Publication page: 

1. From the Information Design drop-down list box, select Publish Endpoints.  

 

The Prepare Measurement Types for Publication page opens, similar to the example shown below.  

 

According to the system design, each measurement type has an endpoint publication map.  
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To display an Endpoint Publication Map for a Measurement Type: 

1. From the Select Measurement Type drop-down list, select the measurement type for which you want to 

display the endpoint publication map.  

The endpoint publication map information is displayed for the selected measurement type, similar to the example 

shown below.  

 

The Prepare Measurement Types for Publication page is a single page application for displaying and editing the 

endpoint publication maps for a measurement type. Publication refers to making the data available to an index. 

The table lists the Published Columns (attributes of the index), the attributes (the definition of the published column), 

and the current expressions for the attributes.  

The Published Columns represent different types of attributes outlined in the table below: 

Type Description 

Organizational Hierarchy Organizational hierarchy attributes are used to present the 

published endpoints in a hierarchy which the user can browse 

to locate the desired endpoints.   

Annotations Annotative attributes provide information about how the 

measurement was performed that may be useful to publish.   

Experimental Factors Experimental factors are conditions of the experiments that 

would typically affect the actual measured value.  For example, 
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a temperature, pH, or concentration that would affect the 

outcome.   

Endpoints Endpoints are the actual measured values of interest.   

 

All the required fields (with red box) must be mapped before the measurement type can be used.  

Note that adding more endpoints to a measurement does not add columns to the endpoint results table.  It actually 

adds rows to it.  On the other hand, adding Annotations or Experimental factors will add columns to results table.  As 

each measurement type can add its own set of attributes, the endpoints results table will become wider and more 

sparsely populated.  These types of attributes are automatically added to the published table.  

Setting the Display Names for the Measurement Type Organizational Hierarchy:  

The display names for the Measurement Type Organizational Hierarchy can be customized for each endpoint 

publication map.  

To set the Display Names for the Measurement Type Organizational Hierarchy: 

1. Click on the icon located in the top right hand corner of the page.  

 

The Set Display Names for Measurement Type Organizational Hierarchy dialog is displayed, similar to the example 

shown below. 

 

From here, you can define the display names for the measurement type organizational hierarchy.   

The organization hierarchy is the index (table with summary of results).  In Global Search, instead of showing a long 

list of all endpoint names, they are organized into categories (folders).  The Set Display Names for Measurement Type 

Organization Hierarchy screen allows the naming of those folders in the Endpoint Publication mapping screen.  The 

actual values you will see on the tree are the values mapped in.  For example, if you want the Solubility endpoint to 

appear under ADMET> Project Avalon > Solubility > Solubility (gr/sml) at 25C, you would map the first three values 
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above to the top three hierarchical columns and the fourth value above to the Endpoint Name column.  If you added a 

second endpoint to the map, it would appear in the tree under the same folder as the first endpoint.  .   

3.4.1 Defining the Mapping for a Published Column 

For each Published column, you can define the definition of the published column (attribute).  The attribute defines 

what values will be published. By default, the Published Columns are set to <Undefined>. You have the option to 

select a current attribute or create an expression.  

To map to an attribute:  

1. From the Attribute drop-down list for the selected Published Column, select the Attribute name.  

 

To map to an expression: 

1. From the Attribute drop-down list for the selected Published Column, select <Expression> to open the 

Expression Editor dialog. 



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 59 of 366 

  

 

2. From the Select Expression Type drop-down list box, select the expression type.  

 

The following options are available:  

Option Description 

Constant 

Value 

The expression will return a user-defined constant value. 

Concatenate 

Values 

In this expression you can concatenate Attributes and literal strings. When the 

Signals Data Factory ingests CSV data, the expression will return values by 

concatenating the values of the Attributes and literal strings for each row. 

Apply 

Regular 

Expression 

In this expression, user can select an Attribute and specify a regular expression as a 

pattern. When the Signals Data Factory ingests CSV data, the expression will use 

the regular pattern to extract the result values from the Attribute for each row. 

 

a) To create a Constant Value expression: 

i. Select Constant Value from the Select Expression Type drop-down list. A dialog, similar to the example 

below appears.  
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ii. Input a value in the text box.  

iii. Click OK to save the expression.  

Note: When creating an expression for Organization Hierarchy published columns (e.g. Assay Type, Biology Project, 
Assay Name), it is important that these hierarchy names do not have the same string value with differing capitalization 
(e.g. cell, Cell) when they define AER mapping.  

b) To create a Concatenate Values expression 

i. Select Concatenate Values from the Select Expression Type drop-down list. A dialog, similar to the example 

below appears. 

 

 

 

ii. Select an Attribute from the drop-down list. Click the +Add button to add the selected attribute to the 

expression.  

iii. Select <Literal> from the drop-down list box. Input the literal expression in the textbox. Click +Add button to 

add the literal expression.  
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iv .Repeats steps ii and iii to add all attributes and literal values to the expression.  

ix. Click OK to save the expression.  

c) To create an Apply Regular Expression:  

i. Select Apply Regular Expression from the Select Expression Type drop-down list. A dialog, similar to the 

example below appears. 

 

ii. Select an attribute from the Applied to attribute drop-down list box.  

iii. Enter a regular pattern in the Enter pattern text box.  

iv. Click OK to save the expression.  

To edit an expression:  

1. Select the  icon to open the Expression Editor dialog. 

2. Edit the expression 

3. Click OK to save the expression.  

  



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 62 of 366 

  

3.4.2 Adding and Removing Published Columns to/from the Endpoint 

Publication Map 

To add a published column:  

1. Click on the  icon next to the heading (e.g. Annotations).    

The Add Attribute dialog is displayed.  

 

2. From here, you can select an existing attribute or create a new attribute. 

a) From the drop-down list box, select an existing attribute directly or type to search for an existing attribute and 

then click the Add button. The published column is added to the table.  

Note: When a new attribute is created in this use case, it will also be added as a measurement attribute in the 

Signals Data Factory. As a result, the next time you choose an existing attribute from this dialog box, you will notice 

that some of the attribute names in the list are suffixed with an asterisk(“*”) indicating that they are already a 

measurement attribute in the Signals Data Factory and were created by other measurement types.  

b) To create a new attribute, type a new attribute name to display the Create New Attribute option, similar to the 

example shown below. 

 

i. Select the new attribute name (create new Attribute) to expand the dialog, similar to the example shown 

below. 
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ii. Specify the Attribute properties for the new attribute (data type, optional description).  

iii. Click Add. The published column is added to the table.  

 

To delete a published column:  

1. Click on the  icon located to the right of the published column. The published column will be deleted from 
the endpoint publication map.  

 

 

3.4.3 Adding/Removing Endpoints from the Endpoint Publication Map 

Endpoints are multi-valued attributes that include the key measured value together with additional information (e.g. 
name, type, numerical measured value, textual measured value, qualifier, and unit).  
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When a new endpoint is added to the endpoint publication map, all attributes are added as Published Columns.  

To add a new endpoint:  

1. Click on the  icon next to the Endpoints heading.    

 

A new endpoint (e.g. Endpoint 2) and its attributes are appended to the table as Published Columns.  

To delete an endpoint: 

1. Click on the  icon located on the right of the Endpoint row. The endpoint will be deleted from the endpoint 
publication map.  
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3.4.4 Viewing the Endpoint Publication Map 

Clicking on the Show All button gives you the option to Show Mapped or Show Unmapped published columns. You 

can also select to Show All (mapped and unmapped).  

 

Clicking the Clear button will set all mappings to <Undefined>. 

Published columns with an asterisk (*) suffix indicate mandatory columns that must have a mapping defined for them, 

similar to the example shown below.  

 

The Attribute field will have a red border if mapping is required for the published column but is currently <Undefined>.   
A yellow border indicates that mapping is optional for the published column.  

 

 

3.5 Guided Measurement Type Definition 

In the case where you have your assay data in CSV files , and you would like to create a measurement type and 

define the attributes for your assay data, typically, you would  first open the Edit Attributes page to define the attributes 

according to the columns of your data source, then use the Edit Measurement Types and Attributes to create a new 

measurement type and attach the pre-created attributes to this measurement type, then define the assay endpoint 

mappings by using the Publish Endpoints tool, and finally use the Publish Measurements tool to define the mappings 

between your data and the measurement type. This workflow is often complex and be prone to error especially when 

your data contains a large number of columns. 
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The Guided Measurement Type Definition tool assists you to do all of these operations in a single screen with less 

typing and mouse-clicks. In this section, you will learn how to create the attributes, measurement types and generate 

the mappings for when you already have your data on hand.  

3.5.1 Creating the Measurement Type and Mappings from Flat Files 

You may use the Guided Measurement Type Definition screen to create the measurement types and AER mappings 

from an existing flat file which contains your assay data. 

1. In the Edit Measurement Types and Attributes page, click the down arrow icon at the right side of the 

Create New Measurement Type button. You will see the Guided Measurement Type Definition button. 

 

2. Click the Guided Measurement Type Definition button to open the Guided Measurement Type Definition 

dialog. 

 

3. Click the Browse button to open the File Upload dialog, from which you can select a file with .csv, .txt, .dat 

extension. A file which contains the comma-separated content format but without an extension is also 

supported. 

4. Select if the new measurement type is associated with a Compound or Batch. By default, Batch is selected.  
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5. If applicable, select the measurement type category (PKStudy, PKDetail, Ppb). These refer to measurement 

types from Signals VitroVivo. If a measurement type is identified with one of these categories, it will 

subsequently be targeted for use in the Target Engagement Profile App. For example, the PK Parameters 

measurement type which comes directly from Signals VitroVivo is tagged with PKStudy measurement type 

category, the PK Time Concentration measurement type is tagged with PKDetail measurement type category 

and the Plasma Protein Binding measurement type is tagged with Ppb measurement type category.  

6. To configure a measurement type as details of another measurement type, enable the “This measurement 

type’s details are stored against the measurement type:” checkbox. From the drop-down list, select an existing 

measurement type to be the details of the newly created measurement type.  

7. In the Measurement Type text box, input the name for the new measurement type. 

8. Select if the new measurement type is associated with a Compound or Batch. 

9. In the Mapping text box, input the name for the mapping which maps the measurement type attributes to your 

data columns. 

10. In the Material Identifiers and Columns grid, if the Measurement Type is set to Batch, choose the column 

which you want to map to the Compound entity and Batch entity. Specifically, choose an ID column from your 

measurement data to be mapped to the Compound Batch ID column, and choose an ID column from your 

measurement data to be mapped to the Compound ID column. Note that the Compound Batch ID is a 

mandatory identifier which must be mapped.  Compound ID, on the other hand, is optional and if it is absent, 

will use the same mapping as Compound Batch ID column. If the Measurement type is set to Compound, only 

an ID column from your measurement data to be mapped to the Compound ID is required.  

11. In the Columns and Attributes grid, choose the columns which you want to convert to the measurement type 

attributes. Once a column is selected, the corresponding drop-down box in the Attribute cell will be 

surrounded by a red rectangle if the attribute has not been defined. 

12. In the corresponding Attribute drop-down, select an existing attribute which you wish to map to the current 

data column. If the type of the selected attribute does not match with the column data type, a yellow rectangle 

will display. 
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13. You can also click the “+” button at the right side of the Attribute drop-down to quickly add a new attribute. By 

clicking this button, the grid will expand with an additional section, within which you can define the properties 

for the new attribute. All the properties are the same as the ones that you can see from the attribute 

management screen. 

 

14. You can click the Cancel button to discard the changes or Create button to save the changes. 

15. Similarly, once you have mapped an existing attribute to the data column, you will be able to modify the 

mapped attribute by clicking the “ ” icon. This will also expand the grid allowing you to modify the mapped 

attribute that will be attached to the newly created measurement type. 

16. You will be able to filter the rows in the grid by using the type-ahead text box at the upper-right corner of the 

Columns and Attributes grid. 

17. If any error occurs, the error information will be shown at the bottom of the dialog, similar to the example 

shown below: 

 

In such case, you will not be able to click the Create button to save the measurement type 

18. Once the settings have all been defined correctly, a green check icon will display at the bottom of the dialog, 

and you will be able to create the measurement type and corresponding mappings by clicking the Create 

button. You can also click the Create and Publish Endpoints button, such that the Prepare Measurement 

Types for Publication page will be shown immediately after the measurement type has created successfully. 

19. After the file has been parsed and read successfully, the fields will be populated to the Columns and 

Attributes grid automatically.  

3.6 Managing Assay Details Layout 

The Assay Details visualization shows the assay data from different measurement types for a particular candidate 

(usually chemical compound). Users can define how the assay data will be represented based on the measurement 

types, by using the Assay Details Layout definition page. 
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To open the Assay Details Layout: 

In both Spotfire Analyst Client and Web Player: 

1. Open data in Spotfire. 

2. Select Tools > Signals Inventa > Manage Measurement Types from the main menu to add the Manage 

Measurement Types page. Alternatively, you can open the Visualization types flyout and click the 

item to add a Manage Measurement Types page.  

3. From the Information Design navigation menu, click the Assay Details Layout item to open the Edit Assay 

Details Layout page. 

 

In the Edit Assay Details Layout page: 

1. Measurement Type: The drop-down box which allows you to choose which measurement type you want to 

define the layout for. 

2. Assay Details Layout: The drop-down box which shows all the available layouts for the currently selected 

measurement type. A measurement type may have multiple layouts; each would have different layout type 

and settings. 

3. Assay Details Layout Type: The type of the layout, can be either Table or Form. 
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a) Table: This layout type will display the assay data in a table grid with multiple records per page, similar to the 

example shown below: 

 

b) Form: This layout type will display the assay data in a form with a single record for each page, similar to the 

example shown below: 

 

4. Available Attributes: This lists all the attributes from the measurement type 

a) Visible Attributes: Lists the attributes that will be included in the assay details layout 

b) Hidden Attributes: Lists the attributes that will not be included in the assay details layout 

You can use drag-and-drop to move the attributes between Visible Attributes list and Hidden Attributes list. You can 

also hold the CTRL or SHIFT key to make multiple choices.  
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Note: Curve images are supported in Assay Details Form View and the Assay Details visualization.   

5. Preview: Gives you a preview of how the layout will look like in the assay details page. 

6. Settings: Layout type specific settings. For example, you will be able to choose the column width for a Form 

layout, or you will be able to define the line styles for a Table layout. 

3.6.1 Creating a New Layout for a Measurement Type 

Follow the steps below to create a new layout for a measurement type. 

1. From the Information Design navigation menu, click the Assay Details Layout item to open the Edit Assay 

Details Layout page. 

2. Select a measurement type for which you want to define the layout from the Measurement Type drop-down. 

3. By default, the system will create a layout automatically when you switch to a measurement type that does not 

have a layout defined. This auto-generated layout will have the name <measurement_type> - Layout, and 

the layout type is Table. 

4. You can click on the Assay Details Layout drop-down box; this will list the layouts for the selected 

measurement type, with a type-ahead text box within it. 

 

5. Type the name of the layout you wish to create in the Switch or create layout text box, and then press 

ENTER or click the Create new Layout menu item to create a new layout for the selected measurement type. 

 

6. After the layout has been created, you can change the type of the layout by using the Assay Details Layout 

Type drop-down. You can also specify the attributes to display in the assay details by dragging them from the 

Hidden Attributes list and dropping them in the Visible Attributes list. 
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7. You can also create a layout by duplicating an existing one. To do that, simply click the  icon at the right 

side of the Assay Details Layout drop-down. This will create a new layout with the name of copy of 

<existing_layout_name>. You can rename and modify this new layout, according to the steps outlined in the 

Editing an Existing Layout section. 

3.6.2 Editing an Existing Layout 

Editing an existing layout is very simple. Choose the layout to edit from the Assay Details Layout drop-down box, and 

then make the necessary adjustments.  

To rename the layout: 

1. Click the  icon located to the right of the Assay Details Layout drop-down box. The  drop-down will 

change to a text box allowing you to modify the name of the layout. 

2. Rename your layout by typing the new name in the text box. 

3. Press ENTER or mouse click outside of the text box to save the changes. 

To make the layout as the default layout 

Each measurement type can have one default layout. This default layout will be selected automatically and will be 

shown in the configuration of the assay details page. For more information about the default layouts, please refer to 

the SAR Template User Guide. 

1. Click the  icon at the right side of the Assay Details Layout drop-down box, a  badge will display 

on the drop-down, and the  icon disappears. This implies that the current layout has already been set to 

default. 

2. The changes will be saved automatically. 

To change the type of the layout: 

1. Choose the type of the layout from the Assay Details Layout Type drop-down box; you will see the Preview 

area is updated accordingly. 

2. The changes will be saved automatically. 

To specify the attributes to be shown in the assay details page: 

1. Click the name of the attributes in the Hidden Attributes list that you want to show. Holding the CTRL or 

SHIFT keys will make the multiple selections. 

2. Drag the selected attributes and drop them into the Visible Attributes list. 

3. The changes will be saved automatically. 

4. Similarly, you can remove the attributes from the assay details page by moving them from Visible Attributes 

into Hidden Attributes. 
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To change the data format for numeric or date/time attributes: 

Users are able to change how the numeric or date/time attribute values will be represented in the assay details layout, 

by specifying the data format for those attributes. Follow the steps below to change the data format for either numeric 

or date/time attributes. 

1. In the Available Attributes area, select a numeric or date/time attribute for which you want to change the 

data format. 

2. Click the icon at the right side of the attribute to open the Edit Data Format dialog. 

 

3. In the Edit Data Format dialog, choose the preferred format; an example will be displayed at the top of the 

dialog. 

4. You can also input your own format string in the Format string text box. The specification of the format string 

is explained in a later section.  

5. Click OK button to save and close the dialog. Clicking Cancel button will discard your selection. 

6. The selected data format will be used in the assay details layout; you can see the results in the Preview area. 
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Specification of the Format Strings for Numeric Values 

The following table shows the detailed information about the elements that can be used to compose a valid numeric 

value format string. 

Format Specifier Name Description 

“0” Zero placeholder Replaces the zero with the 

corresponding digit if one is 

present; otherwise, zero appears 

in the result string. 

“#” Digit placeholder Replaces the "#" symbol with the 

corresponding digit if one is 

present; otherwise, no digit 

appears in the result string. 

“.” Decimal point Determines the location of the 

decimal separator in the result 

string. 

“,” Group separator and number 

scaling 

Serves as both a group 

separator and a number scaling 

specifier. As a group separator, 

it inserts a localized group 

separator character between 

each group. As a number scaling 

specifier, it divides a number by 

1000 for each comma specified. 

“%” Percentage placeholder Multiplies a number by 100 and 

inserts a localized percentage 

symbol in the result string. 

“E” Scientific E-notation sign For example, mEn indicates a 

value of m x 10n 

Other All other characters The character is copied to the 

result string unchanged. 

 

The following table shows some examples of the formatted numeric values based on the given format string: 

# Description Input Format Output 

Most common world wide 

1 Simple 123456.789 #,##0.00 123,456.79 

2 Random 20110628.15 #,##0.###0 20,110,628.15 
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3 Random 0 #,###.##0 0 

4 Long number 1234567890 #,###.##0 1,234,567,890.12 

5 Negative value -0.1 # 
 

6 Negative value -0.1 0 0 

7 Negative value -0.13 0.# -0.1 

8 Negative value -5000.123457 #,##0.###### -5,000.12 

Localization format 

9 US, UK and many 
more 

1234567.89 #,##0.00 1,234,567.89 

10 Estonia, France -128983833.5 ### ###,## -128 983 833,46 

11 Germany, Italy -1234560.1 ##.000,00 -1.234.560,10 

12 Japan 963852741 ###,####.00 963,852,741.00 

13 Switzerland 33445566.78 #'###'#00.00 33'445'566.78 

Any format 

14 
 

-1234.5678 ##.000,00 -1.234,57 

15 
 

4651321.841 ##^000*00 4^651^321*84 

16 
 

3411.498 -##¿000$00 -3¿411$50 

17 
 

465456456.9 00!00@00 4!65!45!64!56@88 

18 Force comma as 
separator 

1112341.435 ###,###. 1,112,341 

19 Force space as 
separator 

2344441.435 ### ###. 2 344 441 

20 Force dot as 
separator 

2345341.435 ###.### 2345341.435 

Prefix & Suffix 

21 No spaces 123456790 $#,##0.00USD $123,456,789.99USD 

22 Extra spaces 
(set white-space: 
pre; in cells) 

123456790 $ #,##0.00 USD $ 123,456,789.99 USD 

23 
 

123456790 ##.000,00 € 123.456.789,99 € 

24 
 

123456790 ###,####.00 ¥ 1,2345,6789.99 ¥ 

25 
 

123456790 ### ###,### ¢ and stuff 123 456 789,988 ¢ and stuff 

26 
 

123456790 #,##0.00 a b c 123,456,789.99 a b c 
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27 Spaces & 
parenthesis 
(indicates a negative 
value, but the input is 
positive) 

123456790 $ (#,###.00) Money $ (123,456,789.99) Money 

28 Spaces & 
parenthesis 
(negative) 

-123456790 $ (#,###.00) Money $ (-123,456,789.99) Money 

29 Prefix with comma 123456790 a, b c? #.00 yep! a, b c? 123456789.99 yep! 

30 Prefix with a period 123456790 cost... #,##0.00 yep! cost... 123,456,789.99 yep! 

31 Suffix with comma & 
period 

123456790 $# ###,00 USD, or euros. $123 456 789,99 USD, or 
euros. 

32 Suffix with period 123456790 It costs $# ###,00 euros. It costs $123 456 789,99 
euros. 

33 Hanging decimal 123456790 test:### ###. ing test:123 456 790 ing 

Scientific Notation 

34 Scientific Notation 123.456 0.00000E+00 1.23456E+2 

 

Specification of the Format Strings for date/time Values 

The following table shows the detailed information about the elements that can be used to compose a valid date/time 

value format string. 

Format Specifier Description 

fff milliseconds, 3-digits 

s seconds 

ss seconds, 2-digits 

m minutes 

mm minutes, 2-digits 

h hours, 12-hour clock 

hh hours, 12-hour clock, 2-digits 

H hours, 24-hour clock 

HH hours, 24-hour clock, 2-digits 

d date number 

dd date number, 2-digits 

ddd day name, 3-characters (like "Sun") 
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dddd day name, full (like "Sunday") 

M month number (Jan=1, Feb=2, etc) 

MM month number, 2-digits 

MMM month name, 3-characters (like "Jan") 

MMMM month name, full (like "January") 

yy year, 2-digits 

yyyy year, 4-digits 

t a/p 

tt am/pm 

T A/P 

TT AM/PM 

z timezone offset hour (like "-7") or "Z" 

zz timezone offset hour, 2-digits (like "-07") or "Z" 

zzz timezone offset hour, 2-digits, and minutes (like "-07:00") or "Z" 

w ISO week number 

ww ISO week number, 2 digits 

S day-of-week ordinal (like "st", "nd", "rd") 

i ISO8601 format, without a timezone indicator 

u ISO8601 format, with a timezone indicator 

 

The following table shows some examples of the formatted date/time values based on the given format string: 

# Input Format Output 

1 11/9/2017 11:02:13 M/d/yyyy 11/9/2017 

2 11/9/2017 11:02:13 d-MMM-yy 9-Nov-17 

3 11/9/2017 11:02:13 d-MMM 9-Nov 

4 11/9/2017 11:02:13 MMM-yy Nov-17 

5 11/9/2017 11:02:13 h:mm AM/PM 11:02 AM 

6 11/9/2017 11:02:13 h:mm:ss AM/PM 11:02:13 AM 

7 11/9/2017 11:02:13 H:mm 11:02 

8 11/9/2017 11:02:13 H:mm:ss 11:02:13 

9 11/9/2017 11:02:13 M/d/yyyy H:mm 11/9/2017 11:02:13 
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10 11/9/2017 11:02:13 HH:ss 11:13 

11 11/9/2017 11:02:13 HH:ss.0 11:13.0 

12 11/9/2017 11:02:13 dddd, MMMM dd, yyyy Thursday, November 09, 2017 

13 11/9/2017 11:02:13 dddd, MMMM dd, yyyy hh:mm tt Thursday, November 09, 2017 
11:02 am 

14 11/9/2017 11:02:13 dddd, MMMM dd, yyyy hh:mm:ss TT Thursday, November 09, 2017 
11:02:13 AM 

 

To change the sorting of the columns in the Table layout: 

For the layouts in the Table layout type, you can change the sorting of the columns by clicking the column header. A 

small arrow will appear when there is a sorting applied to the current column, for example: 

 

The column above has the ascending sorting applied. Clicking the column header with sorting will toggle the sorting 

order. This sorting will be persisted to the assay details layout definition. Note that in the assay details page, you will 

also be able to change the sorting of the columns, however, the changes will not be persisted. 

To change the width of the columns in the Table layout: 

For the layouts in the Table layout type, you can change the width of the columns by dragging the column splitters. 

When you hover the mouse over the splitters, it will turn into a splitter cursor. Drag the column splitter to a proper 

position and release the mouse. The width of the column will be adjusted and persisted to the assay details layout 

definition. Note that in the assay details page, you can also change the width of the columns, however, the changes 

will not be persisted. 

You can also restore the width settings by clicking the  button in the Table layout. 

3.6.3 Changing the Layout Settings 

Both Table and Form layout type have their own specific settings. For example, for the Table layout type, you can 

show or hide the header filters. For the Form layout type, you can choose the number of field columns. This section 

describes each setting option for the two layout types. 
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Layout Settings for Table Layout Type 

• Show Column Lines: If checked, will display the column splitter lines between two columns, unchecking this 

option will hide the splitter lines. 

• Show Row Lines: If checked, will display the row splitter lines between two rows, unchecking this option will 

hide the splitter lines. 

• Show Borders: If checked, the border line will display outside of the Table grid, unchecking this option will 

hide the table border. 

• Alternating Row Color: If checked, will show the alternating row color in the Table grid, unchecking this 

option will only use the single color to render the data rows. 

• Show Filter Row: Check this option to show the filter row below the column header. In the filter row, there will 

be a magnifier icon in each cell. Clicking the magnifier icon allows you to specify the filter criteria: 

 

You can choose a criteria and input the value in the text box to perform the filtering. Unchecking this option will 

hide this filter row. 

• Show Header Filter: Checking this option will display a filter icon at the left side of each column name. 

Clicking the filter icon will give you the filter options based on the row values. 
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• Show Search Panel: Checking this option will display a search text box at the upper-right corner of the table 

grid. You can input a value in the search box to search for a value in the current page of the grid. Unchecking 

this option will hide the search panel. 

• Show Export Button: Checking this option will display the export button on the top of the table grid. Clicking 

the export button allows you to  export the data of the current page in the table grid. Unchecking this option 

will hide the export button. 

• Layout Settings for Form Layout Type 

• Label Location: Specifies the location of a field label. There are two choices: left and top. 

• Minimum Column Width: Specifies the minimum width of the form columns. When the Columns count option 

has been specified to auto, the number of form columns will be determined by this minimum column width 

setting. 

• Columns count: Specifies the number of columns to display in the form layout. 

• Show Colon After Label: When checked, will display the colon right after the field label. Unchecking this 

option will hide the colon. 

3.6.4 Deleting a Layout 

To delete an existing layout: 

1. Select the layout that you want to delete from the Assay Details Layout drop-down box. 

2. Click the  icon at the right side of the drop-down box, a confirmation dialog will appear. 



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 81 of 366 

  

 

3. Click the Delete button to delete the selected layout. 

  



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 82 of 366 

  

4 Configuring Signals Data Factory  

Signals Data Factory (SDF) is an infrastructural component of Signals Inventa which provides data transforming, 

indexing and query capabilities. After the measurement metadata has been correctly defined and measurement data is 

in Spotfire, you are able to publish the measurements into the Signals Data Factory such that the measurement data 

can be transformed and indexed and then searched using complex queries in Signal Inventa’s  Global Search. 

4.1 Configuring Security Features 

Signals Data Factory (SDF) provides the security features with which administrator users can determine what kind of 

resources could be seen or be used by which user groups. For example, the System Administrator can set up the 

security on the projects, so that some of the projects can only be seen by users belonging to a specific group. 

To configure users, roles and groups, please refer to Manage Users section in this documentation. 

Signals Data Factory allows administrators to configure the permissions based on the following resources: 

• Projects 

• Measurement Types 

• Entity Rows 

To configure project permissions, please refer to Appendix B -  Projects section in this documentation. 

To configure measurement type permissions, please refer to Measurement Type - Security Settings section in this 

documentation. 

To configure the permission on entity rows, please refer to Advanced Security section in this documentation. 

4.2 Creating a Project 

In the Signals Data Factory, data is organized by project. Before you can publish measurement data into the Signals 

Data Factory, a project needs to be created. 

To create a project: 

1. Log in to Signals Data Factory with username and password. 

2. From Data menu, click Projects.  

3. New projects can be created from the Projects page.  

4. In the Projects page, in the upper-right corner of the project list, click Add Project button. 
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5. In the Add Project dialog, choose a name for your project. 

 

 

6. A ‘Use original project type’ toggle is available for you to choose the project type. By default, this toggle is 

disabled and will create a V2 project type (incremental project) which includes load-new and datasets 

functionality. You can create an original project type (V1) by clicking the slider bar which excludes load-new 

and dataset funtionalities. Use this toggle to define the project type.  

7. Click on the Add Project button to append the Project to the Projects list. The Project Type will be listed as v1 

(original) or v2 on the Projects page.  

 

To convert a v1 (original) project to v2 (incremental project):  

If you have an original project (v1) that you want to convert to an incremental project (v2), you have the option to do 

this from the original project.  

1. From the Projects details page, select the ‘Clone Working Copy to v2 project’ sub-menu item from the More 

drop-down menu.  
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2. Enter a name for the v2 version of the project.  

 

3. Click the Clone to v2 button.  

The v2 version of the product be appended to the Projects list page.  

Note: When installing Signals Inventa, there is an environment variable which determines the name of the SIA project. 

The name of the environment variable is ‘sdfProject’ in the Helm chart. It is strongly recommended to remain 

consistent with the project name you choose when deploying Signals Inventa and the project name you save here. 

Otherwise, you will not be able to see the preview data when you are creating layouts for your measurement types in 

Signals Inventa. 

4.3 Loading Batch Data 

You need to prepare the batch data via Signals Data Factory rather than the publishing features in Signals Inventa, 

before the measurements data published to the project is transformed and indexed. Batch data must be provided and 

mapped correctly. 

Signals Data Factory provides two methods for loading batch data: 

• using a tabular text file 

• importing from SQL relational databases 
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4.3.1 Loading Batch Data from Tabular Text File 

To load the batch data from a text file: 

1. Log in to Signals Data Factory with the username and password. 

2. From Data menu, click Projects. 

3. In the Projects page, click the name of the project to which you want to load batch data. 

4. On the project details page, click the Add Dataset button to add a new dataset: 

 

 
 

5. Drag ‘n’ drop files or click to select files.  

 
 

6. Once the file is ready to be added, the Dataset Name is populated with the name of the chosen file by default. 

You can also modify the Dataset Name before the dataset is created.  
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7. Click the Create dataset and upload files button to upload the file and create the dataset. 

 
 

Note: Ideally, a dataset is a group of files that can share the same mapping. In practice, files under the same dataset 

will have the same number of columns and column names. In Signals Inventa, usually a dataset will have only one file 

in it. 

Note: Only text files in tabular format, such as comma-separated values (CSV), tab-separated values (TSV) are 

supported 

Note: SDFiles are not directly supported by Signals Data Factory, however, the Signals Inventa Utilities command line 

tool included in the Signals Inventa release package can convert an SDFile into a CSV file, such that the compound 

information defined in the SDFile can also be loaded into Signals Data Factory. For more information, please refer to 

the “Converting SD file into CSV file” section below. 

After the file has been added to the project, it will be displayed under the Datasets tab. At the right side of the 

Datasets list, there is an area showing the status of the selected dataset and the files under it. You can click the ellipse 

icon at the upper-right corner to either rename or delete the dataset. 

 
You can also add additional files to the selected dataset by clicking the Add File button, or delete an existing file by 

clicking the trash icon. 
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4.3.2 Importing Batch Data from SQL 

Signals Data Factory supports connections to external data sources – currently SQL data sources are supported 

which can be used to connect to other databases.  

To load from an external connection, an administrator first configures the external connection.  

Connections are managed on the ‘External Connections’ page within the ‘Information Design’ main menu.  

To define the database connection: 

1. Log in to Signals Data Factory with username and password. 

2. From Administration menu, click External Connections. 

3. On the External Connections page, click Add External Connection button in the upper-right corner of the 

External Connections list. 

 

4. When adding a connection, the following information is required in the Add External Connection dialog:  

• Assign a name to the connection 
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• the connection type (currently only SQL is available) 

• the database type 

o Oracle 

o MySQL 

o MSSQL 

o Redshift (also supports Redshift Spectrum) 

o Impala 

o Postgres 

o Snowflake 

• the connection string 

• username and password credentials 

 

 

5. Click on the Add button.  

6. After the connection has been added successfully, you should be able to find it in the External Connections 

list: 
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Once configured, project administrators will be able to import using this connection on the project details page.  

To import data from SQL by using an existing database connection: 

1. Log in to Signals Data Factory with username and password 

2. From Data menu, click Projects. 

3. Click the name of the project to which you want to import data from SQL. 

4. On the project detail page, click on the Import from SQL menu from the Add Dataset drop-down button.  

 

The Import from SQL window is displayed.  
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5. Select the pre-configured connection, assign a name to the data being added, and enter the SQL to run: 

• Connection: Choose the database connection you wish to use 

• Name this import: Input the name of the import, this will be the name of the data set listed in the Files list. 

• Query: Input the SQL query for pulling in the data 

6. Click Save and materialize button to import the data. 

When the details for an SQL retrieval are saved, a new process is started to materialize the results of the query. 

Any modifications to the settings to the SQL retrieval will also begin a new materialization process. 

An active materialization will be indicated with a spinner alongside the file. 

Should there be any issues/errors in this process, the spinner will be replaced with a ! icon, which can be clicked to 
view the output log and diagnose the problem (there is also a shortcut to the log in the Actions column). 

If an import job is started before a materialization is complete, then a failed materialization will result in a failed import 
(and any dependent publish jobs). 
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Advanced Settings 

For larger datasets it is possible to tune the retrieval mechanism via the ‘Advanced Settings’ option. 

 

Here you can specify 

• Partition Settings (if used, all of the settings are required) When provided with a partition column along with 

an estimated lower and upper value, Signals Data Factory will split the data according to the number partitions 

requested and run these queries in parallel. This can result in significant performance improvements when 

materializing the data for large datasets. 

o Number of Partitions: The number of queries to run in parallel 

o Partition Column: A numeric or date column to use to split the query into multiple parts. 

o Estimated Lower Bound: An estimate of the lower bound of the partition column’s values 

o Estimated Upper Bound: An estimate of the upper bound of the partition column’s values 

4.4 Converting SDFile into CSV file 

SDFiles are not by default supported by Signals Data Factory. However, the Signals Inventa Command Line Utilities 

tool (siautils.exe) included in Signals Inventa distribution package can convert an SDFile into CSV file, which can then 

be supported in Signals Data Factory.  

Note: The Signals Inventa Command Line Utilities tool can only work under Microsoft Windows with .NET Framework 

version 6.0 installed. For more information about the tool, please refer to Revvity Signals Command Line Utilities 

User Guide. 

To convert an SDFile into CSV file with siautils.exe, please ensure that your machine is running Microsoft Windows 

and has the .NET Framework 6.0 installed, then follow the steps below: 



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 92 of 366 

  

1. Extract the siautils.exe from the distribution package. 

2. Under the path where the siautils.exe exists, execute the following command from a Windows shell: 

 
C:\> siautils.exe sdf2csv -i InputFile.sdf 

 

Where InputFile.sdf is the file name of the SDFile that you wish to convert. 

 

The generated CSV file will be named after the input file name by default, with the “.csv” as its extension. You 

may also specify the name of the generating CSV file explicitly by supplying -o (or --output) parameter.  

For other available parameters of the sdf2csv command, please refer to Revvity Signals SIA Utilities 

Command Line User Guide 

Once complete, follow the steps described in “Loading Batch Data from Tabular Text File” section above to load the 

generated CSV file into Signals Data Factory.  

4.5 Uploading Batch Maps 

In Signals Data Factory, batch data will be transformed into two kinds of entities: Compound and Batch. Compound 

entity contains the compound ID, chemical structure data as well as its indexing fingerprint for searching purposes, 

whereas the Batch entity contains the compound ID and additional batch/chemical properties. The batch map is a type 

of metadata which maps the batch data into these two entities. Before the batch data can be processed by Signals 

Data Factory, the batch map should be correctly defined. 

There are two ways of defining the batch map for a batch data file, either by using the Signals Data Factory mapping 

user interface, or by providing a JSON mapping file which can be uploaded into Signals Data Factory. 

For more information about how to use the mapping user interface to define the maps, please refer to Appendix B - 

Signals Data Factory. 

If uploading a JSON mapping file, first, you need to compose a mapping file. A mapping file is usually a JSON file 

which has the schema similar to the following example: 

{ 

  "name": "BatchesMap", 

  "entities": [ 

    { 

      "entityType": "Compound", 

      "ID": "CompoundID", 

      "attributes": [ 

        { 
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          "attributeName": "Chemical Structure", 

          "valueLocator": { 

            "inputs": [ 

              "Structure" 

            ], 

            "function": { 

              "type": "chemicalStructureNormalization", 

              "chemicalStructureType": "chemical/x-cdx" 

            } 

          } 

        } 

      ], 

      "validated": true 

    }, 

    { 

      "entityType": "Batch", 

      "ID": "BatchID", 

      "validated": true, 

      "attributes": [ 

        { 

          "attributeName": "Batch Project ID", 

          "valueLocator": "batch_project_id" 

        }, 

        { 

          "attributeName": "BatchPropDate", 

          "valueLocator": { 

            "inputs": [ 

              "BatchPropDate_t" 

            ], 

            "function": { 
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              "type": "dateNormalization", 

              "dateStyle": "year" 

            } 

          } 

        }, 

        { 

          "attributeName": "BatchPropNumeric", 

          "valueLocator": "BatchPropNumeric_d" 

        }, 

        { 

          "attributeName": "BatchPropText", 

          "valueLocator": "BatchPropText_s" 

        }, 

        { 

          "attributeName": "Chemical Structure Format", 

          "valueLocator": { 

            "function": { 

              "type": "constant", 

              "value": "chemical/x-cdx" 

            } 

          } 

        } 

      ] 

    } 

  ] 

} 

 

 

In this example batch map, “name” is the name of the map, and there are two entity types defined in the “entities” 

array: Compound and Batch. 
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For the Compound entity: 

• entityType must be “Compound” 

• ID should be the name of the column in the uploaded batch data, which represents the identifier of the 

compound conceptually 

• attributes hold a list of compound attributes that will be added to the Compound entity. Specifically, the 

Chemical Structure attribute must be in place and mapped with a 

chemicalStructureNormalization custom function, with the name of the structure column as its input, 

and the chemicalStructureType as its parameter. The chemicalStructureType represents the MIME 

type of the chemical structure data which could have three options: chemical/x-cdx, chemical/smiles 

and chemical/x-mdl-molfile 

Note: The name of the Chemical Structure attribute must match the name of the Compound entity attribute 

defined in the Signals Data Factory whose Data Type is Chemical Structure: 

 

 

For the Batch entity: 

• entityType must be “Batch” 

• ID should be the name of the column in the uploaded batch data, which represents the identifier of the batch 

conceptually 

• attributes hold a list of batch attributes that will be added to the Batch entity. For most of the batch 

attribute mappings, they are a simple name-to-name mapping between the column in the batch data and the 

attribute in the batch entity. For a date type attribute, it uses the dateNormalization function to convert the 

format of the value.  

Once the mapping file is ready, you can upload it to the Signals Data Factory by following the steps below: 

1. Log in to the Signals Data Factory with username and password. 

2. From Data, click Maps. 

3. On the Maps page, click Upload tab. 

4. Click Choose Files button, which will open a file selection dialog. 
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5. In the popup dialog, choose the mapping file.  

6. Click the Upload Map button. A message will appear indicating that the map loaded successfully.  

7. Click the Download tab on the Maps page, make sure that you can see the map that you have just uploaded: 

 

 

4.6 Associating Batch Data with the Batch Map 

By associating the batch data with the batch map, Signals Data Factory can transform and index the batch data. 

To associate the batch data with the batch map: 

1. Log to Signals Data Factory with username and password. 

2. From Data menu, click Projects. 

3. Click on the project of interest. 

4. From the Datasets list, locate the uploaded batch data file. Click on the map hyperlink to edit.  
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5. On the Map Details page, you can either create a new map by using the interface or you can upload an 

existing mapping file. To upload an existing mapping file, click Load Map button.  

The Load Previously Used Map dialog box is displayed. By default, only maps that are compatible with the current file 

and its available source columns will be displayed. To view all available maps, de-select the ‘Only Compatible Maps’. 

6. On the Load Previously Used Map dialog box, click on the name of the map you want to use, then in the 

Preview Map Load dialog, review the map option and the mappings. You can either click the Load in 

Advanced Mode to review the mapping in JSON format or click the Apply Preview button directly.  
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Note: If your batch data file contains columns that have multi-line values (e.g., in a CSV file converted from an SDFile, 

the chemical structure column will be in MolFile format which is represented by a multi-line text), please remember to 

check the Does this file have multiline values checkbox on the File Settings dialog, similar to the example shown 

below.  
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Note: You may also need to specify the delimiter used in your batch data file, by choosing the setting in the Enter the 

delimiter that separates columns in the file drop down box on the Import Settings dialog shown above. 

7. On the Map Details page, click Update Working Copy button to apply the map. 

 

 

Once the batch data is uploaded and mapped, you can continue with the measurement data publishing workflow from 

within Signals Inventa. 

4.7 Creating a Query Template for use in Assay Results Review 

(ARR) App  

The Assay Results Review app is designed to compare the historical Data of a measurement type with the current 

data for the same measurement type.  

Using the Advanced Search feature in Signals Data Factory, you can create a query template to search the historical 

data of a measurement type by inputting parameters in an advanced search definition.  

To create a query template: 

1. From the main Search page, click on the Advanced Search button located beneath the search facets in the 

left pane.  

 

  



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 100 of 366 

  

 

 

2. Input the following locators:  

• The type of entity is “BatchRow” or “CompoundRow” depending on if the Measurement Type is associated 

with Batch or Compound.  

• The name of the SDF Project 

• The name of the Measurement Type 

• Pre-defined parameters based on any attribute of the measurement type. For example, you can define the 

Assay Date attribute (from the a42 Whole Blood IC50 measurement type) as a parameter, such that when 
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Assay Results Review app generates the UI, it will create a date/time picker UI component from which the 

user can specify the criteria of the Assay Date to query for the historical assays.   

The advanced search criteria are entered by means of a JSON document defining all of the search criteria. 

 

The advanced search is periodically validated as it is modified. Invalid JSON, or an invalid search structure will display 

an error beneath the criteria preventing the search from being saved. A valid search will result in the hit count for that 

search. 

For the Assay Results Review app to work correctly, it is imperative that the query template follows a similar structure 

to that shown above. The execution of the query MUST return the data for a particular measurement type.  

Note: The parameters in the SDF query must be named identically to the column name in the Current Data workflow 

in Spotfire. For example, you must name your Assay Date parameter as MeasurementDate if the column that 

contains the current assay data in the Spotfire table is named “MeasurementDate”.  

3. After entering the search criteria, click Update Search and Close. 

 

4. Click Save Search button.  

 

 
 

The current Search narrative is displayed.  

 

5. Enter a name for the saved search.  

 

6. You can choose to share the search. If you want to share this search, select ‘Yes, with everyone’.  ‘No’ is 

selected by default.  

 

7. Click Save button.   

 

The Assay Results Review app will retrieve all visible saved queries from the Signals Data Factory and only make 

available the query templates (saved searches with ‘@parameter’ contained in the definition) in the app.  

Refer to Assay Results Review App section for more detailed information on this app.  
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4.8 Signals Inventa Configuration 

Signals Data Factory also provides the features and user interface components for managing measurement types, 

attributes and maps. However, these are general features that support common scientific data transformation use 

cases. With the exception of Compound/Batch attribute management, it is strongly recommended you use the 

measurement type, attributes and maps management features in Signals Inventa to accomplish information design, as 

the features in Signals Inventa may provide you advanced capabilities such as assay endpoint mapping definition, 

guided measurement type creation, etc. Refer to Appendix B – Signals Data Factory for more information. 

To access the Signals Inventa configuration for measurement types, attributes and maps, select the Inventa 

Configuration sub-menu from Information Design in Signals Data Factory. Once you have been redirected to the 

Signals Inventa configuration page, you can navigate back to Signals Data Factory by selecting the SDF 

Configuration sub-menu from Information Design in Signals Inventa. 
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5 Publish Measurements Tool  

The Publish Measurements tool allows data producers to define table mapping, validate, and publish the data set to 

the Results index.  

5.1 Accessing the Publish Measurements tool 

The Publish Measurements tool is accessed through the main Spotfire Interface. You will be required to login to the 

Signals Data Factory using your SSO credentials before you can access the Publish Measurements tool if you have 

not already been authenticated or if your session has expired.  

Note: If the SDF ApiKey Spotfire preference has been set, you will not be required to logon. Refer to Setting the SDF 

APIKey section for further information.   

Note: If you are using Safari web browser, please make sure that it won’t block the pop-up dialog from Signals Data 

Factory domain. To enable the pop-up dialog from Signals Data Factory: 

1. In Safari, select Preferences menu. 

2. In the Preferences dialog, choose Websites tab. 

3. In the Configured Websites list, make sure that Signals Data Factory web page has been set to Allow. 

To access the Publish Measurements tool: 

 In both Spotfire Analyst Client and Web Player: 

1. Open data in Spotfire. 

2. Select Tools > Signals Inventa > Publish Measurements from the main menu to add the Publish 

Measurements page. Alternatively, you can open the Visualization types flyout and click the  Publish 

Measurements item to add a Publish Measurements page. 
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5.2 Understanding the Publish Measurements Page 

The Publish Measurements page allows you to define the mappings between a measurement type and a Spotfire data 

table and then publish the measurements. The following table describes the Publish Measurements page and the 

options available to you.  

Option Description 

“Publish 

Measurements” 

visualization 

The Publish Measurements visualization provides a user interface for you to 

define measurement type mappings and publish measurements. 

Project Selector A Project Selector drop down allows you to select the project to use for the 

Publish Meaurements tool. By default, the Publish Measurements tool opens with 

the project defined in the Spotfire preference. Refer to the Setting the Signals 

Data Factory Project Name preference for more information. You have the option 

to hide the Project Selector through a Spotfire preference. Refer to the Show SDF 

Project Selector preference section for information on setting this preference. 

“Measurements 

(TableName)” Table 

plot visualization 

The Table plot visualization allows you to preview the data of selected data table 

for publication. 

 

The logout button logs out the current user from the Publish Measurements Tool. 

  

The Refresh button reads measurement types and mappings from the Metastore 

service. Click this button to refresh the Select Measurement Type and Mapping 

name drop-down list box.  

Select Data Table to 

publish: 

A drop-down list box for selecting a data table from the current Spotfire document.  

 

The Show/Hide table details buttons are used to show/hide table detail for the 

“Measurements (TableName)” Table plot visualization. 

Mapping name: A drop-down list box for selecting an existing measurement type mapping. The 

Mapping name list is retrieved from the Metastore service. 

<New Mapping> is selected if the current mapping definition is not saved in the 

Metastore service. 

Note: Only maps generated via Signals Inventa through the Publish 

Measurements Tool or through the Guided Measurement type creation workflow 

are available for selection here. Maps generated via Signals Data Factory are not 

available for selection.  

 
A drop-down button to create, overwrite or save the current mapping. Refer to the 

Saving Mapping section.  

Select Measurement 

Type: 

A drop-down list for selecting the measurement type for defining table mapping. 

The measurement type list is retrieved from the Metastore service. 

 

Note: Only the measurement types which have a defined Endpoint Publication 

Map are displayed in the drop-down list box. Refer to the section Managing 

Publish Endpoints. 

 

Click the Automap button to automatically map the Measurement Type Attribute 

to the Spotfire Data Table Column. Refer to the Automapping section.  
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Clicking on the Show All button gives you the option to Show Mapped or Show 

Unmapped measurement type attributes. You can also select to Show All 

(mapped and unmapped). 

 

A drop-down button to clear or reset a measurement type map.  

<Mapping> table 

control 

The table control allows you to define the mapping for each measurement type 

identifiers (Compound entity and Batch entity) and attributes. This table is 

comprised of 3 columns: Identifiers and Attributes, Marked Example Values 

and Data Table. Identifiers and Attributes column contains the attribute names 

for the selected measurement type, Data Table Column provides a list box for 

each line allowing the user to choose an expression or a column from the 

selected Spotfire data table to be mapped to the current measurement type 

attribute. The Example Values column displays the exemplary mapping result 

depicting how the data will look when it is transformed by Signals Data Factory. 

 

If the Measurement Type is associated with a Compound Batch, only an ID 

column from your measurement data to be mapped to Compound Batch ID is 

required. In this case, the Compound ID is not displayed as an identifier column.  

 

If the Measurement type is associated with a Compound, only an ID column from 

your measurement data to be mapped to the Compound ID is required. In this 

case, the Compound Batch ID is not displayed as identifier column.  

 

Publish data from 

Data Table “Table 

Name” 

A radio group control for choosing the rows for publication from the selected data 

table.  

 

Map saving status bar A status bar to indicate if the current measurement type map has been saved to 

the metastore service.  

 

Click the Validate to validate the mapping for the selected published data. Refer 

to the Validating Data section.  

 

 

Click the Publish button to begin the publish process. Refer to the Publishing 

Data section.  

5.3  Defining Table Mapping 

From the Publish Measurements page, you can define the mappings between a measurement type and a Spotfire 

data table.  
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5.3.1 Selecting Measurement Type 

During the initialization of the Publish Measurements visualization, all existing measurement types will be retrieved 

from the metastore service and displayed in the Select Measurement Type drop-down list box. By default, the first 

measurement type is selected. You can change the measurement type at any time.  

To select a measurement type:  

1. From the Select Measurement Type drop-down list box, select the measurement type.   

Note: Selecting a different measurement type will cause the current mapping data to be overwritten without prompting 

you for confirmation. You can click the Undo button to revert your changes.  

Note: If the selected measurement type has a details measurement type, and you have two or more data tables in 

your current analysis with table relationships being defined in Data Table Properties dialog, an option to publish the 

detailed measurement type of the current measurement type becomes available.  

 

Using the ‘To parent measurement type’ and ‘To child measurement type’ toggles, you can toggle between the parent 

measurement type and child measurement type to define mapping for both. You are able to validate the mappings for 

each of the measurement types. You can publish both the details results to the details Measurement Type (e.g. Well-

level % inhibition assay) as well as the main result assay (e.g. IC50 assay).  Refer to the sections below for more 

information.  

Note: When selecting data table for both parent and detail measurement types, you should choose the data tables that 

have data table relations defined. In most cases, such data table relations represent which table is the parent and 

which table is the child. During the data publishing, the publish tool will generate unique identifiers for the rows in both 

parent and child table according to the table relations. These unique identifiers act as the primary keys in the parent 

table and foreign keys in the child table so that when importing, the data transformer can understand the relations 

between the two. After Global Search has downloaded both parent and detail measurement data, the data table 

relation are rebuilt based on this unique identifier column. 
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5.3.2 Setting Data Table to Publish 

The first (default) data table in the current Spotfire document is selected in the Select Data Table to publish drop-

down list box by default. You can change the value at any time. Changing the data table will clear the map definition.   

To select a data table to publish:  

1. From the Select Data Table to publish drop-down list box, select the data table.   

Note: Changing the data table will clear the current map definition without prompting you for confirmation. You can 

click the Undo button in toolbar to revert your changes.  

5.3.3 Loading an Existing Measurement Type Map 

Existing measurement type maps are retrieved from the metastore service and displayed in the Mapping name drop-

down list box. By default, <New Mapping> is selected. You can select an existing map in the drop-down list at any 

time. After selecting a different map, Signals Inventa will apply the map definition in the current page.  

To select a measurement type map:  

1. From the Mapping Name drop-down list box, select the mapping name.  

Note: Selecting a different map will cause the current mapping data to be overwritten without prompting you for 

confirmation. You can click the Undo button in toolbar to revert your changes. The measurement type will be updated 

to reflect the selected measurement type map.  

To filter the mappings: 

The Mapping name drop-down list box also provides a text box where you can input a filter string. Using this feature, 

you can quickly navigate to the map of interest. 

1. Select the drop-down icon in the Mapping Name drop-down list box.   

2. In the search text box, type to search for a mapping name.   

 

To view the map description: 

1. Click the  icon to the right of the Mapping name label to show/hide the Mapping description text box. 
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5.3.4 Automapping 

You can click the Automap button at any time to reset the mapping between the measurement type attributes and the 

Spotfire data table columns automatically. This feature will automatically find the best matching Spotfire data table 

column for each measurement type attribute by using a string comparison algorithm.  

The algorithm used in Auto Mapping feature of the Publish Measurements tool is dependent on a threshold value to 

adjust the accuracy of the mapping result. The default value for Auto Mapping is 0.4.  If you find that the automapping 

behavior is too fuzzy or not fuzzy enough, you can modify the threshold for the comparison algorithm in the Spotfire 

preferences. 

Refer to the section Setting the Auto Mapping Threshold for more information.  

5.3.5 Defining the Mapping Manually 

The table in the Publish Measurements visualization allows you to manually define the mapping for the identifiers 

and measurement type attributes. You have the option to select a Spotfire data table column or create an expression.   

 

The table consists of three columns. Each is described below.  

Identifiers and Attributes 

The identifiers and attributes for the selected measurement type are listed. The icon displayed to the left of the 

attribute represents the data type. There are four data types: 

Icon Data Type 

 
Unique Value 

 Text 
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 Number 

 Date 

 Image 

 

Identifier and attribute names with an asterisk (*) suffix indicate that the identifier/attribute is mandatory and must have 

a mapping defined for it.   

Note: In measurement types that are ONLY mapped to a Batch, the “Compound ID” key is not available in the 

‘Identifiers and Attributes’ column during mapping. 

 Marked Example Values 

This column displays the marked example values for a mapping definition.  

• For <Undefined> mapping, it is blank 

• For <Expression…> mapping, it displays the result of the expression. 

• For Spotfire data table column mapping, it displays the mapped column value in the first selected row. 

Data Table Column 

From here, you can specify the mapping for each measurement type identifier and attribute.  

The drop-down list box contains three mapping options: 

• <Undefined>: is the default value which indicates that nothing will be mapped to the measurement type 

attribute. The publication will ignore any <Undefined> columns in the CSV output. Setting a measurement type 

identifier/attribute to <Undefined> for a mandatory measurement type identifier/attribute will result in a 

violation. Refer to the section “Validating Data”.  

• <Expression…>: indicates that the publication will use the result of an expression in the output column for the 

measurement type identifier/attribute. Refer to the section “Creating an Expression”. 

• Spotfire data table column: indicates that the publication will use the data of the selected Spotfire table column 

in the output column for the measurement type identifier/attribute. 

Mapping Status 

The drop-down list box controls in the Data Table Column use color to indicate the status of the mapping. Border color 

is used to represent violation information.  

• A red border indicates that the measurement type identifier/attribute is mandatory, and you must define a valid 

mapping for it before publishing. 

• A yellow border indicates that the measurement type identifier/attribute is optional, and you can publish 

without defining a mapping for it. 

• A black border indicates that mapping has been defined for the measurement type identifier/attribute.  
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5.3.6 Creating an Expression 

In the case where there is not a proper data table column to map to the measurement type identifier/attribute, you can 

add a Spotfire calculated column. The data in the calculated column is the result of a Spotfire expression which you 

defined in the Spotfire Expression Editor. The Spotfire expression is stored in the current Spotfire document. For other 

documents which use the same measurement type map, you will be required to add the calculated column again. 

The <Expression…> option in the Data Table Column drop-down allows you to create an expression and store the 

definition with the mapping. 

The Publish Measurements visualization supports two types of expression: 

• Use this user-provided value for all published results 

• Pull a value from this input filename for all published measurements 

5.3.6.1 About the Expression Editor dialog 
Selecting the <Expression…> option from the Data Table Column drop-down list box will open the Expression Editor 

dialog, similar to the example shown below.  

 

Option Description 

Use this user-provided 

value for all published 

measurements 

Selecting this option will result in the publication using a user-provided value 

in the output column for the measurement type attribute.  

    <Input your value here> To input the user-provided value. 
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Pull a value from this input 

filename for all published 

measurements 

Using this option, you can select a file name from all the source files in the 

current Spotfire document and specify a JavaScript expression to extract a 

string value from the file name. 

    <File Name> drop-down The drop-down list which contains all the source files in the current Spotfire 

document. You can select a file name as the value of the filename variable 

in the JavaScript expression. 

    <Expression> text box Text box to input the JavaScript expression. 

         Clicking this icon will launch the Help of Expression dialog. 

    <Result> text box A read-only text box to show the result of the expression. 

5.3.6.2 Using the User-provided value 
By selecting “Use this user-provided value for all published measurements” option in Expression Editor and entering 

a constant string in the text box, you can define a constant expression.  

The expression editor respects the data type of the attribute. For example, if the attribute (e.g. Assay Date) is a Date 

data type, the expression editor provides a date/time picker for you to select the  .  

 

This expression will be stored as part of the map definition when you save the mapping. The publication will use the 

user-provided value in the output column for the measurement type attribute. Note: The user-provided value is 

validated during the validation process. If a violation is found, you will have to modify the expression or select another 

mapping option. You are not permitted to set replace value for an expression column mapping. 

5.3.6.3 Pull a value from input filename 
The “Pull a value from this input filename for all published measurements” option is designed to generate the 

expression value based on a Spotfire source file name and a JavaScript expression. 
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<File Name> Drop-down 

The Publish Measurements tool displays all source file names in the current Spotfire document in this drop-down list 

box. You can select a file name as the value of filename variable in the JavaScript expression. 

Note: When you open an Expression Editor for a filename expression map, if the source file name does not exist in 

the current document, the first file name in the drop-down list box is automatically selected.  

<Expression> Text Box 

The file name selected in <File Name> drop-down is assigned to a string variable “filename”. Here you can write a 

JavaScript expression and use the variable in the expression.  

The usage of the expression is described in a help page. You can open the Help dialog it by clicking the  icon. 
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<Result> text box 

The result of your expression will be displayed in the last text box. You cannot directly edit in this text box. It will be 

updated automatically each time you modify the expression and file name.  

Note: When you open the Expression Editor for a filename expression map, if the source file name does not exist in 

the current document, the first file name in the <File Name> drop-down will be selected and the <Result> will be 

updated to the new expression result automatically. 

To edit an expression:  

1. Select the  icon to open the Expression Editor dialog. 

2. Edit the expression 

3. Click OK to save the expression.  

5.3.7 Saving Mapping 

When you click the Save Mapping button located to the right of the Mapping Name drop-down list, the Publish 

Measurements tool will save the current mapping definition to the metastore service. 

5.3.7.1 Saving a New Mapping 
 

To save a new mapping: 

1. Click Save Mapping button. The Save Mapping dialog appears.  
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2. Specify a Mapping Name and a description (optional) for the new mapping.  

3. Click Save. A new mapping is created in the metastore service, and a message is displayed indicating that the 

mapping is saved successfully.  

 

5.3.7.2 Saving an Existing Mapping 
 

If the current mapping is an existing mapping, clicking the Save Mapping button will update mapping in the metastore 

service with the current mapping definition.  

Saving as a New Mapping 

If the current mapping is an existing mapping, you can click the Save As button to create a new mapping.  

To save as a new mapping:  

1. Click the Save As button.  

 

The Save Mapping As dialog appears. 
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2. Specify a Mapping Name and a description (optional) for the new mapping.  

3. Click Save. A new mapping is created in the metastore service and a message is displayed indicating that the 

mapping is saved successfully.  

5.3.7.3 Mapping Save Status Bar 
The information bar located above the Validate and Publish buttons displays the saving status for the current map.  

Note: Mapping must be saved before publishing. The Publish button is disabled until the current mapping is 

successfully saved.  

5.3.8 Delete a Mapping 

To delete the selected mapping: 

If the current mapping is not <New Mapping>, when hovering mouse on the Mapping name drop-down, the  icon is 

displayed.  

 

1. Click the  icon to delete the selected mapping. A message will appear prompting you to confirm the 

deletion.  
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2. Click OK to delete the mapping.  

The mapping is deleted from the metastore service and no longer appears in the Mapping name drop-down list box.  

To delete other mappings from Mapping Name drop-down list box: 

1. Click the Mapping name drop-down list box to expand the existing map list.  

2. Hover the mouse on an existing mapping to be deleted. The   icon is displayed.  

 

3. Click the   icon to delete the selected mapping. A message will appear prompting you to confirm the 

deletion. 

 

4. Click OK to delete the mapping.   

The mapping is deleted from the metastore service and no longer appears in the Mapping name drop-down list box.  

5.3.9 Viewing the Table Mapping 

Clicking on the Show All button gives you the option to Show Mapped or Show Unmapped measurement type 

attributes. You can also select to Show All (mapped and unmapped attributes).  



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 117 of 366 

  

 

Option Description 

Show Mapped Only the measurement type attributes with a mapped data table column or 

expression are visible. The measurement type attributes set to <Undefined> value 

are filtered out. 

Show Unmapped Only the measurement type attributes set to <Undefined> value are displayed. 

Show All Both mapped and unmapped measurement type attributes are displayed.  

5.3.10 Clearing Mapping 

Clicking the Clear button will set the mapping for all measurement type attributes to <Undefined>. 

 

5.3.11 Resetting Mapping 

If the current mapping is from the metastore service, clicking the Reset button will reset the map definition to the 

definition currently stored in the metastore service. For a <New Mapping>, the Reset button works in the same 

manner as the Clear button. 

 

5.4 Validating Data 

Before publication, it is necessary to validate the selected publishing data based on the measurement type attribute 

data type.   

5.4.1 Mapping Rules 

There are four rules defined for the measurement type attribute mappings.  
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Rule Message Measurement Type Attribute Data 

Type 

Missing required 

value 

A value is required. A measurement type attribute without 

a  null constraint 

String in a Number A number is required. A measurement type attribute requiring 

a number value 

Invalid date value A date value is required. A measurement type attribute requiring 

a date value 

Duplicated values for 

unique 

A Spotfire data table column with 

unique values is required. 

A measurement type attribute with a 

unique constraint 

5.4.2 Validation Results 

To validate the mapping for the selected published data: 

1. Click the Validate button to validate the selected publishing data. 

If there are no violations, you will be notified that validation finished successfully.   

 

If the validation process finds violations, you will be presented with a Validation Failed dialog, outlining the violations, 

similar to the example shown below.  

  

The following table describes the Validation results table.  

Option Description 

Mapping Index The index of the data table that is validated. 0 indicates that the 

current validation result is for the parent table, whereas 1 indicates 

that the current validation result is for the details table. 

Measurement Type Attribute The measurement type attribute displaying a violation.  

Column The name of the Spotfire data table column. 
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Error Type The error type is displayed.   

Rows Found The number of rows found with the violation.  

Replace Value Input a replace value for the violation rows in the measurement type 

attribute. 

Details Show/hide violation details. 

To show/hide violation details: 

1. Click the Details button to expand the page to display the violation details. Click the Details button to collapse the 

details information. 

5.4.3 Resolving Violations 

You can choose to ignore the rows with errors at this time, or you can resolve the violations using the Replace Value 

field.  

When you leave the Replace Value text box, the new replace value is immediately validated. An error message will 

appear in red text if there is still a violation with the replace value.  

Note: Should you choose to ignore the rows with errors at this time, you will be prompted again to resolve any 

violations when publishing measurements.   

5.5 Publishing Data 

The Publish Measurements tool allows you to select the rows in the selected data table and publish measurements 

using the specified measurement type map to a file share location. 

5.5.1 Selecting Rows for Publishing 

The Publish Measurements tool provides three different options for selecting rows in the selected data table for 

publication. 

 

The descriptions for option are listed in below table: 
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Option Description 

All Rows All the rows in the selected data table will be published. 

Filtered Rows Only the result rows of the active filter will be published.  

Marked Rows Only the rows which are marked in the selected marking will be published. 

Selecting Marking for Publish 

If you choose the “Marked Rows” option, the Marking drop-down will be enabled. You can choose a marking among all 

the markings in the document. 

By marking rows in the “Measurements (TableName)” Table plot, you can select rows for publication. 

5.5.2 Error Handling 

If violations are identified in the selected publish rows, the Validation Failed dialog will appear listing the validation 

results, similar to the example shown below.  

 

A row indicator identifies the number of rows to be published. Note that the number of rows to be published will be 

listed for both parent and child tables if applicable.  

From here, you can select how to handle the identified violations.  

Option Description 

Ignore (don’t publish) rows 

with errors 

The publication job will ignore all rows with errors. 

Use the replacement values 

provided above on errors 

rows 

The specified replacement values will be used when publishing.  

 

Note: If you define one data table column to map to multiple measurement type attributes, the publication job will only 

output one column in the CSV table and all violations in the column will be populated with the replacement value. 
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If the total number of rows to be published is 0, and you click the Continue button, you will be prompted to confirm if 

you want to continue with the publication.   

 

5.5.3 Publishing 

If there are not any violations, clicking the Publish button will open the Publish Data dialog directly. However, if there 

are violations, you need to handle the errors in Validation Failed dialog and then click Continue to proceed with the 

publication process.   

 

From the Publish Data dialog, you can create a new dataset for the publication or modify an existing dataset. By 

default, creating a new dataset is selected.  

Refer to Appendix D for information on importing images into Spotfire.  

5.5.3.1 Publishing to a New Dataset 
 

To publish data to a new dataset:  

1. Select the “This is a New dataset” option.  

2. Provide information to identity this publication of data by entering a Dataset Name. .  

3. Click the Publish button.  

A message is displayed indicating that the table has been successfully published to the dataset.    
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5.5.3.2 Publishing to an Existing Dataset 
 

To publish to an existing dataset: 

Note: This option will be greyed out if there are no existing datasets under the selected SDF project.  

1. Select the “This publication modifies an existing dataset.”  

Existing datasets under the selected SDF project are displayed in a table with the Dataset Name and Dataset Date.  

2. Select the dataset to publish to. 

 

3. Select the method to publish to an existing dataset. The following options are available.  

Option Description 

Add to dataset Appends the publishing measurement data to an existing dataset. 

Important Note: If the mapping used for the publication differs from 

the mapping that was used by the selected dataset, all files in the 

selected dataset will be reinterpreted with the new mapping. 

Overwrite entire dataset The existing dataset will be overwritten by this publication. This is 

the default selection.  

 

Note: To preserve dataset consolidation between Signals Inventa and Signals Data Factory, the dataset name 

assigned here will be the dataset name that is displayed in the Signals Data Factory allowing for quicker identification 

and retrieval of datasets in the Signals Data Factory.  

Note: If “Also publish detailed measurement type of current measurement type” check box is checked, this means that 

both the parent and detail measurement types are going to be published. In such case: 
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If “This is a new dataset” option is chosen, the data of these two measurement types will be published into two 

different datasets in Signals Data Factory. Users can enter a DataSet Name for the parent measurement type. By 

default, the child Dataset name will autopopulate with the “parent Dataset Name” plus the suffix “_details”. Users have 

the option to rename the child Dataset Name.  

 

If “This publication modifies an existing dataset” is chosen, the user can choose the parent and child dataset from the 

list to modify.  The ‘Add to dataset’ and ‘Overwrite an existing dataset’ options are applied to BOTH the parent and 

child measurement type.  

4. Click the Publish button. 

A message is displayed indicating that the table has been successfully published to the dataset.    

  



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 124 of 366 

  

6 Global Search 

After data is published to the Signals Data Factory through Signals Inventa, the Global Search interfaces allows you 

to: 

• Create complex nested queries and interrogate any subset of the stored data of interest. 

• Explicitly set the scope of a query to be Compound, Batch, or Measurements, which results in much more 

precise control over the results set returned 

• Query for Structure, any compound attribute, and any assay or measurement, and query over an expanded 

set of comparison operators. 

• Include multiple chemistry search criteria to more precisely find the subset of compounds, batches or 

measurements of interest. 

• Control system performance directly by choosing estimated vs. precise query result counts at   different levels 

of precision. 

• Save queries for easy re-use. Saved searches can be public or private 

• Run the SAR Analysis App directly from the Global Search page   

 

Global Search uses the Compounds, Batches and Assay Endpoint Results tables from Signals Data Factory to 

provide the search capabilities.  

6.1 Accessing the Global Search tool 

The Global Search is accessed through the main Spotfire Interface. You will be required to login to the Signals Data 

Factory using your SSO credentials before you can access Global Search if you have not already been authenticated 

or if your session has expired.  

Note: If the SDF ApiKey Spotfire preference has been set, you will not be required to logon. Refer to Setting the SDF 

ApiKey section for further information.   

Note: If you are using Safari web browser, please make sure that it won’t block the pop-up dialog from Signals Data 

Factory domain. To enable the pop-up dialog from Signals Data Factory: 

1. In Safari, select Preferences menu. 

2. In the Preferences dialog, choose Websites tab. 

3. In the Configured Websites list, make sure that Signals Data Factory web page has been set to Allow. 

To access the Global Search tool:  

In Spotfire Analyst Client: 

1. Select from the main menu to open the Global Search page. Alternatively, you can open the Visualization 

types flyout and click the  Global Search item to open the Global Search page. 

In Web Player: 

1. Open data in Spotfire. 



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 125 of 366 

  

2. Select Tools > Signals Inventa > Global Search from the main menu to open the Global Search page. 

Alternatively, you can open the Visualization types flyout and click the  Global Search item to add a Global 

Search page. 

A Global Search page is displayed, similar to the example shown below.  

 

The top right corner of the displays the name of the logged in user. A Project Selector drop down allows you to select 

the project to use for the Global Search. By default, the Global Search opens with the project defined in the Spotfire 

preference. Refer to the Setting the Signals Data Factory Project Name preference for more information. You have the 

option to hide the Project Selector through a Spotfire preference. Refer to the Show SDF Project Selector preference 

section for information on setting this preference.  

The re-sizable left side panel lists all previously saved searches.  

The center panel allows you to define the Compounds/Batches/Measurements and Assay/Measurement Types and 

Annotations of interest. Each of these elements contributes to an intersection that yields a unique list of 

compounds/batches/measurements and assays results to be included in the resulting SAR analysis.  

Note: Global Search uses the Signals Data Factory custom security, so you will only be able to select the compounds 

that you have permission to see. Administrative users can limit the visibility of compounds to specific user groups by 

using the Advanced Security feature provided by Signals Data Factory. For more information about how to setup the 

Advanced Security, please refer to Advanced Security section in this documentation. 

Note: Global Search uses the Signals Data Factory custom security, so you may not be able to view all measurement 

types in the hierarchy tree if you do not belong to a group that has  View/Search permission to a measurement type. 

For more information about how to setup the measurement type permissions, please refer to Measurement Type - 

Security Settings section in this documentation. 
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Note: Global Search uses the Signals Data Factory custom security, so you may not be able to view all of the assays 

or annotations in the hierarchy tree or in the query builder. . For more information about how to setup the Advanced 

Security, please refer to Advanced Security section in this documentation. 

The right hand side of the panel presents the user with feedback about the search criteria and the set of compounds 

and results that will be returned by the search according to the user’s permissions. 

6.2 Previous Searches 

From the Previous Searches panel, you can initiate a new global search, as well as see a list of your saved searches.   

Saved searches can be selected and re-used. The search criteria and results will load once selected.  

A Search field allows you to type ahead to search for the name of a previous search.    

 

To expand/collapse Saved Searches list:  

Above, the expanded view is shown. To collapse the Saved Searches, click the  button. Alternatively,click on the  

button to expand the list.  

To expand/collapse Previous Searches panel: 

1. To increase the size of the query and result panel, you can choose to collapse the Previous Searches sidebar 

by clicking on the  button.  

2. Click on the  button to expand the Previous Searches panel.  

To delete a saved search:  

1. Hover the cursor over the Saved Search name and click the  Delete button that appears. You will be 

prompted to confirm the deletion.  
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6.3 Performing a New Global Search 

To initiate a new global search: 

 Click on the +New Global Search button to clear the previous search (if applicable).  

  

A blank panel is now available for you to define a new search. By default, the search will be named ‘New Global 

Search’.  

6.3.1 Reload 

The Reload button is located in the right hand top corner of the page.  

Clicking the Reload button will reload the data in the: 

• Saved Searches list 

• Chemical Compound Properties list 

• Assay Hierarchy tree   

6.4 Search for Compounds, Batches or Measurements of Interest 

The ‘Find one or more <drop-down list> where Compound or Batch attributes are’ allows you to explicitly set the scope 

of a query to be Compound, Batch, or Measurements resulting in more precise control over the results set returned.  
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The default selection in the ‘Find one or more <drop-down list> where Compound or Batch attributes are’ can be set 

as a Spotfire preference via the Administration Manager. Refer to the section Setting the Default Search Scope in 

Global Search.  

Using the filter builder widget, you can draw a query structure for the compound and/or define conditions for both 

compound and batch. The chemical structure and conditions will be used to perform a search on the compounds or 

batches.  

The filter expressions are displayed as a tree structure where nodes represent simple filter conditions. Each condition 

consists of a data field, a comparison operation and a value. A logical operation combines conditions into groups.  

The data field is a list of attribute names from the Compounds and Batchestables in Signals Data Factory.  Compound 

attributes will be listed ahead of Batch attributes in the list. If applicable related entity tables are listed as well. Refer to 

the Search by Related Entity section for more information on related entities.   

There is a structure field name allowing you to search by structure. Refer to the Search by Structure section for more 

information.  

Note: This list is not fixed; it varies in different user scenarios, depending on what attributes have been defined for 

both Compound and Batch entities in the Signals Data Factory. 

Note: The source entity name (e.g. Compound, Batch) to which the attribute is associated, is displayed in brackets as 

a prefix to the attribute name. This allows for you to easily identify which entity an attribute describes.   

Note: Some attribute names may be followed by an asterisk (*). This indicates that a related entity table is linked to 

this field an additional information related to the attribute is available. Refer to the section Viewing Entity Relationships 

section for more information.   

 

To add a condition:  

1. Select And, Or, Not And or Not Or logical operator 

2. Click on the  icon and select Add Condition. 
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A condition is added to the filter builder.  

 

Clicking on the Data Field and Operation allows you to select the data field name and comparison operation from a 

list. Depending on the data field name selected, the comparison operators may vary.  

A Search field allows you to type ahead to search for the data field name.  A value can be entered in the Value field or 

you can use the type ahead to search for the value.  

 

In the case where you want to input a list of values (e.g. list of compounds IDs), you will need to either select the ‘Is 

any of’ which is equivalent to an IN operation, or ‘Is all of’ which represents the operation that matches the field with all 

of the values specified 
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You can enter the values in the Type to input box. Accepted deliminators include comma, vertical bar, space or line 

break.  

Note: For the ‘Is any of’ operator, you are limited to input no larger than 2.3MB text data (around 25,000 items 

approximately) in the input box. If the text data exceeds this limit, a warning message will appear and the operation will 

be cancelled. You will need to shorten the text in the input box 

Note: For the ‘Is all of’ operator, a maximum of 100 items can be entered in the input box. As the ‘Is all of’ operation 

requires increased server resources, the amount of time it takes to provide the summary result or download data is 

increased. In certain cases, a failure may occur due to a time-out errorIf such an error occurs, reduce the number of 

items entered in the value input box 

  

Once the values are entered, these will be displayed in the Values field, similar to the example shown below.   
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To add a group to the filter:  

1. Select And, Or, Not And or Not Or logical operator.   

2. Click on the  icon and select Add Group. 

 

A Grouping query is added allowing you to group conditions.  

 

To remove a condition:  

1. Click on the icon preceeding the condition to remove it from the filter.  
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6.4.1  Search by Structure 

Using the Structure data field, you can query a chemical structure.  

Note: You can add multiple ‘Structure’ conditions using the filter builder widget.  

To define a structure query:  

1. Select And, Or, Not And or Not Or logical operator 

2. Click on the  icon and select Add Condition. 

 

A condition is added to the filter builder.  

3. Click on the Structure data field.   

 

When the Structure column is selected, the operation field has the following options: 

Contains – substructure search 

Equals – full structure search 

Similar to – similarity search  

To perform a Substructure Search:  

A Substructure search finds structures containing a common structural component, plus any additional attachments at 

the open positions. Substructure searches are useful if you have a general idea of the types of compounds you are 

looking for, but do not have an accurate description of the target compound.  

1. Select the operation ‘Contains’,   
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2. Click on the <enter a value> parameter. The ChemDraw JS Structure Editor opens.  

 

Note: The Structure condition supports the ChemDraw JS Editor. Signals Inventa will locate this application via a URL 

which is defined as a preference in Spotfire. Please refer to the ‘Setting the ChemDraw JS URL Preference’ section of 

Lead Discovery User Guide for more details. 

3. Draw the query structure in the Structure Editor window using appropriate tools. 

Tautomers are isomers of a compound which differ only in the position of the protons and electrons. The carbon 

skeleton of the compound is unchanged. Substructure search types allow you to optionally filter for tautomers of the 

query structure. 

4. To filter for tautomers, enable the Tautomeric checkbox.  

5. Click Apply.  

The SMILES representation of the structure is displayed in the Condition value. If you hover over the condition value, a 

thumbnail of the structure is displayed, similar to the example shown below.  
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Clicking Apply initiates the search against  Signals Data Factory. 

To perform a Full Structure Search:  

A Full structure search finds a particular structure.  

1. Select the operation ‘Equals’,   

 

2. Click on the <enter a value> parameter. The ChemDraw JS Structure Editor opens.  
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Note: The Structure condition supports the ChemDraw JS Editor. Signals Inventa will locate this application via a URL 

which is defined as a preference in Spotfire. Please refer to the ‘Setting the ChemDraw JS URL Preference’ section of 

Lead Discovery User Guide for more details. 

3. Draw the query structure in the Structure Editor window using appropriate tools. 

Tautomers are isomers of a compound which differ only in the position of the protons and electrons. The carbon 

skeleton of the compound is unchanged. Substructure search types allow you to optionally filter for tautomers of the 

query structure. 

4. To filter for tautomers, enable the Tautomeric checkbox.  

5. Click Apply.  

The SMILES representation of the structure is displayed in the Condition value. If you hover over the condition value, a 

thumbnail of the structure is displayed, similar to the example shown below.  
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Clicking Apply initiates the search against  Signals Data Factory. 

To perform a Similar Structure Search:  

Similarity searches find structures having features similar to the query structure.  

1. Select the operation ‘Similar To’.   

 

2. Click on the <enter a value> parameter. The ChemDraw JS Structure Editor opens.  
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Note: The Structure condition supports the ChemDraw JS Editor. Signals Inventa will locate this application via a URL 

which is defined as a preference in Spotfire. Please refer to the ‘Setting the ChemDraw JS URL Preference’ section of 

Lead Discovery User Guide for more details. 

3. Draw the query structure in the Structure Editor window using appropriate tools. 

By default, a similarity search is performed based on a 75% - 100% range of similarity. You can adjust the range of 

similarity (from 60 to 100%) using the slider.  

4. Click Apply.  

The SMILES representation of the structure is displayed in the Condition value. If you hover over the condition value, a 

thumbnail of the structure is displayed, similar to the example shown below.  
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Clicking Apply initiates the search against  Signals Data Factory. 

To edit a structure:  

1. Click on the SMILES representation of the structure to open the Structure Editor.  

2. Make the necessary modifications to the structure 

3. Click on the Apply button. A new search is initiated.  

6.4.2  Search by Related Entity 

Signals Data Factory supports the addition of custom entities (or related entities). They allow you to associate entity 
tables to your core entity (e.g. Compound, Batch) tables and then leverage those relationships while querying data. 
For example, a compound entity could have a related entity associated with it which describes more details about the 
compounds. You can specify a search condition based on the associated entities.  

 
Note:  Refer to the Entities and Attributes section in Appendix B: Signals Data Factory for information on defining 

custom entities and relationships.  

Using an Entity Condition, you can include related entity tables in your search. 

To add an entity condition:  

1. Select Entity Condition from the logical operator drop down list.  

2. Click on the  icon and select Add Condition. 
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A condition is added to the filter builder. In the case of an Entry Condition, the operator ‘Relates to’ is static.  

 

A Search field allows you to type ahead to search for the relationship.  A value can be entered in the Value field or you 

can use the type ahead to search for the relationship.  

3. Select the relationship.  

 

Using the filter builder widget, you can stack other And/Or conditions similar to the example shown below.    

 

In the ‘And’ condition shown above, all columns from the related entity table (e.g. Molecular Target) are available for 

selection. Here, Target Classification is a column in the Molecular Target related entity table. The related entity name 

(e.g. Molecular Target) to which the attribute is associated, is displayed in brackets as a prefix to the attribute name 

(e.g. Target Classification). This allows for you to easily identify which entity an attribute describes.   

In the example shown above, the search will query for batches that were tested in Enzymology assays where their 

target is an STE protein kinase.  

Global search queries can also contain multiple conditions across multiple related entities similar to the example 

shown below.  
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6.4.3 Viewing Entity Relationships 

When adding conditions, using the filter builder widget, you will note that some attribute names may be followed by an 

asterisk (*). This indicates that a related entity table is linked to this field and additional information related to the 

attribute is available.  
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For example, a relationship exists where [Compound] Primary Target Focus is mapped to a related entity table. To 

gain insight into this relationship and see which table it is linked to, you can click on the icon next to the Related 

Entities in the Search Summary gird.   

 

This will open the Relationships window.   

 

From here, you can search for the relationship and discover that in this example, Compound is linked to the Primary 

Target table. The Relationships window is a means for you to find out more information about the data field in 

question. This window can be pinned for your reference.   
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6.5 Search for Assays and Annotations of Interest 

In this section (…and whose Measurements are…), you can search for assays, annotations, and result types of 

interest.  These are organized into a hierarchy defined by the metadata of the underlying Signals Data Factory that 

stores these results and is managed by your data administrator. 

 

The levels of the hierarchy are: 

• Assay General Type - this is a general organization column, but most commonly is used to organize the 

assays into general classes to make them easier to find. 

• Biology Project - this is a general organization column, but most commonly is used to group assays into the 

project that they primarily support. 

• Assay – this is the name under which the assay results were published. 
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• Measurement Type – this is a category of measurements that are similar.   

• Result Name – this is the name of assay result (e.g. Assay 1 IC50 (nM)) belonging to the measurement type 

• Measurement Type Attribute – this is the name of the attribute belonging to the measurement type 

Note:  The hierarchal tree displays measurement types that are linked to both Compounds and Batches.       

Note: In the case where data is loaded directly into the Assay Endpoints Results table and measurement types are not 

defined, the resulting node in the assay hierachal tree is  labelled ‘Endpoints’ by default. The Undefined 

Measurement Type Display Name Spotfire preference allows you to specify a display name if you choose not to use 

the default name.   

In the case, where there is a mix of some and no measurement types, the resulting node in the assay hierarchal tree is 

labelled ‘Other Endpoints’ by default. The Undefined Measurement Type Display Name preference allows you to 

specify a display name if you choose not to use the default name. For example, the node will be labelled “Other 

{preference value}”.   

Refer to the section Setting the Undefined Measurement Type Display Name for more information.  

Displaying Hierarchies 

To aid in the selection of assays, you can choose to display ‘All’ hierarchies, only those hierarchies that have been 

‘Selected’, or those that have are currently ‘Not Selected’.   

 

Exclude Attributes 

An Exclude attributes toggle is available for you to exclude measurement attributes from being downloaded when the 

global search results are downloaded into Spotfire. 
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Depending on how the Spotfire preference is set, the attributes may be included in the download by default. Using this 

toggle, you can override this preference. Refer to the section Setting the Include Attributes by Default in Global Search 

for further information.  

Search  

Here, you can perform a type-ahead search to look for results of interest. As you type, the hierarchy will be 

dynamically filtered, and the hierarchy sections opened to display results that match the input text. 

Note: When expanding a parent node, a maximum of 100 child nodes will be shown with accompanying text to 
indicate ‘Some nodes are not shown’, similar to the example shown below. It is recommended that you enter a query 
string for searching to help you find the precise target nodes for selection. 

 

Split query strings separated by whitespaces can also be used to search for results as illustrated in the example 

below.   
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From the hierarchy tree, you can check the checkbox next to any item of interest. Checking the box next to an item 

automatically selects the boxes for all subordinate items.  

Any leaf node that is checked in the hierarchy tree automatically becomes available to be set as an 

assay/measurement criterion in the Conditions panel (…and achieved a result of:) 

Note: Checking the ‘All’ checkbox will select all nodes in the assay hierarchy.  

6.6 Adding Conditions to an Assay or Measurement Query 

Here you can limit the returned compounds/batches/measurements with their assay results by assay and assay result 

conditions and/or measurement type results by assay and attribute conditions.  

Similar to the Compound Search, described previously, using a filter builder, conditions can be added to the assay 

and/or measurement query for further definition. Refer to Search for Compounds/Batches/Measurements of Interest 

for details on using the filter builder.  

 

Clicking on the Data Field and Operation allows you to select the data field name and comparison operation from a 

list.  

The “Is any of” and “Is all of” conditions are useful for the following cases:   

For example, when a user specifies "IS ANY OF" -> "Batch Project 1, Batch Project 2", this means that the compounds 
that are in Batch Project 1 OR Batch Project 2 will be returned. 

In the case where some compounds belong to multiple batch projects, the “Is all of” operator returns the compounds 
that belong to both Batch Project 1 AND Batch Project 2. 

 

A Search field allows you to type ahead to search for the data field name.  A value can be entered in the Value field, 

you can also use the type ahead to search for the value.  
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In addition to the logical operators in the filter builder, there are two additional group operators available for the assay 

query called the “Assay Condition” group operator and the “Measurement Condition” group operator.  

Assay Condition 

An “Assay Condition” group operator can contain multiple annotative attribute criterias but only one result criteria. All of 

the conditions specified under the “Assay Condition” group are concatenated by AND operator logically. 

For the And, Or, Not And and Not Or operators, they can only hold one type of criteria, either annotative attribute 

criteria or result criteria. This means that if you choose an annotative attribute for the first criteria, you will not be able 

to choose a result criteria for the other operators.  

Once the logical/group operator has been determined, you can create the criteria starting from the data field. The data 

field is a list of annotative attributes from the measurement types or results that are currently selected in the hierachy 

tree.  Any deselection of the annotative attribute or the result will trigger removal from the data field list.  

Note: The prefix for each field name is the first two letters of the parents for the result name (i.e. the path)  

Note: Annotative attributes in the data field list won’t have a prefix on their names 

Note: When expanding the drop-down, a maximum of 100 child nodes will be shown. It is recommended that you 
enter a query string for searching to help you find the precise target result names. 

Result conditions will be dynamically updated according to the hierarchy. For example, any condition with a field 

selected in the hierarchy tree will be removed once the associated result name is deselected in the tree.  
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Measurement Condition 

A “Measurement Condition” group operator can contain multiple measurement attribute criterias All of the conditions 

specified under the “Measurement Condition” group are concatenated by AND operator logically. 

Once the logical/group operator has been determined, you can create the criteria starting from the data field. The first 

data field in the condition is always Measurement Type. The value field will list the available measurement types that 

are selected in the assay tree. If no Measurement Type is selected, the “Measurement Type” operator will be disabled. 

 

Once the measurement type has been defined in the first condition, additional conditions can be added. The data field 

is a list of measurement type attributes that are currently selected in the hierachy tree for the measurement type 

specified in the first condition.  Any deselection of the measurment attribute will trigger removal from the data field list.  

 

Note: You can search for the dataset that you used for publishing the measurement data in the measurement 

condition by specifying the Set ID (dataset ID) as a condition in the Measurement Condition filter.  
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If you select a second measurement type from the value drop down list, the current conditions will be cleared, and the 

data field will now contain the measurement type attributes for the newly selected measurement types.   

Note: When expanding the drop-down, a maximum of 2,000 child nodes will be shown. It is recommended that you 
enter a query string for searching to help you find the precise target measurement attribute.  

Result conditions will be dynamically updated according to the hierarchy. For example, any condition with a field 
selected in the hierarchy tree will be removed once the associated measurement attribute is deselected in the tree. 

Technical Note: It is possible build advanced queries that define criteria for both the Assay Endpoint Results (AER) 
table and individual Measurement Tables. Criteria is applied to the AER table when an Endpoint is selected from the 
Global Search tree, when a results criteria for an Endpoint is specified, or when an “Assay Condition” is defined. 
Criteria is applied to individual Measurement Tables when an Attribute is selected from the Global Search tree or when 
a results criteria for a “Measurement Condition” is set. Global Search will always attempt to perform a join query, 
whereby Measurement Table results will be filtered based on corresponding records in the AER table. In this scenario, 
every row in a Measurement Table will have a corresponding record in the AER table. When queries are sufficiently 
broad with large numbers of Measurement Results, they join limit may be exceeded. Global Search will perform a non-
join query instead and notify the user. In this case, it is possible to return Measurement Table rows that do not have a 
corresponding record in the AER table. The specified AER criteria is still applied to the AER table, and the specified 
measurement criteria is applied to the appropriate Measurement Tables, but the Measurement rows are not then 
filtered by corresponding AER rows. If this occurs, users will receive a notification upon data download. 

6.7 Get the Summaries of the Query to be performed 

In the sections on the right-side of the page, you can access feedback about the search criteria and the set of 

compounds/batches/measurements and results that will be returned by the search. This panel is resizable.  
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Search Summary  

 

Click on the Show me the summary button to see the data. You have the option hide the Show me the summary 

button and automatically load the Search summary results right after you have modified the compound or assay 

criterias. Refer to the section Setting the Turn Off Summary Button in Global Search.  

This section provides a succinct summation of the search criteria outlining the numbers of selected compounds 

batches, projects, measurement types, endpoints as well as result counts returned by the search. 

 

Note: The Select Measurement Types, Selected Endpoints and Result count values are the sum of the respective 

Batch and Compound values.  

Note: The Summary does not include the Result Counts for Details Measurement Types.  

There may be instances where the Result Count value is highlighted in a yellow badge. In this case, the search 

conditions return a large number of measurements as a result of joining data. To generate the count summaries 

quickly, the joins have been removed, and therefore the Result Count is an estimate. The actual Result Count number 

will be equal or less than the number displayed in the Search Summary. You can hover the mouse over the yellow 

badge  to display an information message with more detail about the Result Count. There is a ‘Search Maximum Join’ 

adminstrative system configuration setting in Signals Data Factory.  
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Global Search Found 

The Global Search grid displays all result names meeting the search criteria including the # Results and over # 

Compounds/Batches/Measurements for each.  

From the Global search found drop down list, you can select the hierarchy level (Assay Type, Project, Assay, 

Measurement Type, Result/Attribute name) to group the values displayed in the grid. At least one hierarchy level 

should be selected in this drop down, such that the Global search found table could display the aggregated numbers 

under that selected level. You can also choose multiple hierarchy levels by clicking on the check boxes for each item 

in this drop down. 
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When applicable, you can specify the maximum number of rows (e.g. 10, 25, 50, 100) to be displayed on one page in 

the grid, as well as page through the grid to see results.   

Search 

You have the option to only retrieve compounds and batches that have assay results.  

In the case where the ‘Only retrieve compounds and batches that have assay results’ checkbox is not enabled, the 

number of Compounds and Batches with no results is displayed directly below the grid.                                                                                                                                            

If replicate assay data exists  

You have the option to retrieve all replicates or only retrieve replicates that match conditions, plus other selected 

assays.   

 

For example, an assay condition has been defined as ‘[A-S-S] Solubility at pH 1.2 Solubility (um/ml) > 5’.  

If ‘Retrieve all replicates’ is selected, all compounds which have the assay results ‘[A-S-S] Solubility at pH 1.2 

Solubility (um/ml) > 5’ will be selected, and all assay result for these compounds will be returned, however, all 

compounds which contain the assay results ‘[A-S-S] Solubility at pH 1.2 Solubility (um/ml) <= 5 will also be returned.  

If “Only retrieve replicates that match conditions, plus other selected assays’ is selected, only the assay results 

‘[A-S-S] Solubility at pH 1.2 Solubility (um/ml) > 5’ will be returned. 

6.8 Saving a Global Search 

Global Searches can be saved as private or public and shared with specified groups.  

Administrative users can save a search as public and can also limit who can see the search by sharing the search only 

with specific groups. A user will only see that search if he/she is a member of that group.  

Non-administrative users cannot save a search as public. They can only save as a private search or share with a 

group that he/she is a member of.   
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To save a new global search:  

1. Single click on the name field to place the field in edit mode. Alternatively, you can click on the Save button to 

open the Save Current Search dialog.  

 

2. Enter a unique name for the search.  

You will be notified if the name already exists.  

3. Click Save. The ‘Save current search’ dialog opens.  

 

4. If not already done so, enter a unique name for the current search.  

5. Specify the Share level for the search.  

You can choose to make the search private, public or define which groups can see the saved search.  A non-

administrative user cannot save a search as public and this option will not be available.  

Private – the saved search will only be visible to the current logged in user.  

Group – the saved search will only be visible to users who belong to the selected group(s). Only groups that you are a 

member of will be available for selection.   
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Public – This option is only available for administrative users. The shared search will be visible to all users/groups.  

6. Click on the Save button.  

 

To re-name and save a global search:  

1. Single click on the name field to place the field in edit mode.  

 

2. Enter a unique name for the search.  

3. You will be notified if the name already exists.  

4. Click Save..  

OR 

1. From the Save drop-down list, click Save As. The Save current search as dialog opens.  
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2. You will be notified that the name has been used. Enter a new unique name for the global search.  

3. Specify the Share level for the search.  

You can choose to make the search private, public or define which groups can see the saved search.  A non-

administrative user cannot save a search as public and this option will not be available.  

4. Click on the Save  button.  

Editing a Saved Query 

Public queries are read-only and can only be edited by the administrative user who saved the search.  

A read-only search is identified by hovering the cursor over the Saved Search name. The locked  indicator 

identifies the public search as read-only.  

. 
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To edit a saved query:  

1. Make the updates to the saved search.  

2. From the Save drop-down list, click Save As. The Save current search as dialog opens. 

  

3. If applicable, make modications to the Share level.  

4. Enable the Override existing saved search checkbox.  

5. Click on the Save button.  

Note: If modifications are made to a locked search, the search will be saved as a new search and the previous search 

will not be overwritten.   

6.9 Downloading Assay Results into Spotfire 

Once the Search criteria has been defined, the assay results can be downloaded into Spotfire. Clicking the Download 

these results button will download the data from Signals Data Factory and generate three Spotfire data tables; a 

‘Compounds’ table if you have any compounds data, ‘Batch’ table if you have any batch data, a ‘Compound Assay 

Endpoint Results’ table that contains assay data for compounds and a ‘Batch Assay Endpoint Results’ table that 

contains assay data for batches. If applicable, related entity table(s) are also downloaded.  In addition, one data table 

per measurement type (if at least one attribute is selected in the hierarchy tree) is also generated. Only the selected 

measurement type attributes are downloaded.  

Selecting entity attributes for download 

By default, all projects share a single attribute list and all entity attributes are retrieved for all queries. You can specify 

the entity attributes for retrieval. 

From the Download these results drop-down button, selecting ‘Select attributes for download’ will open a ‘Select 

attributes for download’ window.  
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Choose from the hierarchy which attributes you wish to download for each selected Entity and Measurement Type. 

You can choose the Compound/Batch/Compound Assay Endpoint Results/Batch Assay Endpoint Results to 

download.  

Related entities are also available for selection. Note that is you choose to ‘Download all related entities’ (see below) 

only the entities specified here will be downloaded into Spotfire.   
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The selected entities will be saved as part of the Saved Search when the current search is saved.  

Selecting detail measurements for download 

If applicable, you can download detail measurement types for the measurement types selected in the hierarchy tree.  

Details measurements store the inputs that make up a final result (e.g. the wells of an IC50).  

From the Download these results drop-down button, selecting ‘Select details measurements for download’ will open 

a ‘Select details measurements for download’ window.  
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Select which details Measurement types you wish to download - only details of selected Measurement Types are 

shown. 

Note: If you have selected a measurement type on the hierarchy tree which is associated with “details” 

measurements, and you want a Spotfire table relation to be established between the two measurement types, make 

sure the “details” measurement type is not selected in the hierarchy tree. If you select both parent and details 

measurements on the hierarchy tree, then you cannot change selections in the Select details measurements for 

download dialog, and there will be no table relationship established between the two downloaded tables. 

Related Entities: 

Only Download Related Entities that match conditions 

If the ‘Only download related entities that match conditions’ option is selected then only those rows from the related 

entities table that meet the attribute conditions defined in the search criteria are downloaded. This means that all 

related entities that are either called by the Entity Condition statement or those that are implied using a hierarchal 

entity attribute are returned AND their rows are filtered based on conditions specified in the Global Search.  

 

Download all related entities 

If the "Retrieve all related entities " option is selected, then all rows for all related entity tables are downloaded into 

Spotfire This allows you to do your own Spotfire joins and linkages (transformations).  
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Clean-up Measurement tables 

In the case where the hierarchy selection state changes, you can remove measurement tables that are no longer 

required in the Spotfire document.  

From the Download these results drop-down button, enable the Clean-up Measurement tables checkbox.   

 

When this option is checked, the existing measurement type tables in Spotfire that are not selected as part of the 

current download will be removed from the Spotfire document.  

For example, you have chosen and downloaded the assay data for measurement type A, and then you deselected 

measurement type A in the hierarchy tree, but selected measurement type B for download. If you checked “Clean-up 

measurement tables” option before clicking the Download these results button, then after download, the Spotfire 

data table that holds the data for measurement type A will be deleted from the Spotfire document. 
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Clean-up related entity tables   

From the Download these results drop-down button, enable the Clean-up related entity tables checkbox.   

 

When this option is checked, the existing related entity tables in Spotfire that are not selected as part of the current 

download will be removed from the Spotfire document.   

Downloading these results 

Once the download is complete, a message will appear indicating that the global search results have been 

downloaded into a Spotfire data table(s).  

 

Note: The Download these results button will be disabled if no results are returned from the search.  

Note: The “Measurement Type” column of the downloaded Assay Endpoint Results table is now renamed to “Assay 

Type”, and a new “Measurement Type” column is added to the table but has a different meaning. If you open an 

existing Spotfire document that was saved in previous version of Signals Inventa, you may have to do the column 

mapping manually when you refresh or download the Assay Endpoint Results table. 

Note: The dataset ID column (Set ID) column is included in the downloaded Measurement Type table to easily identify 

the dataset from which the measurement data came from.   
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6.10 Run SAR Analysis App 

You can run the SAR Analysis App directly from the Global Search page by clicking the Run SAR Analysis App 

button. This option only becomes available after the global search results have been downloaded into a Spotfire data 

table(s).  

If the SAR Analysis App already exists in the current document, the first occurrence of the app will be activated.  

Refer to SAR Analysis App for detailed information.  

6.11 Signals Notebook Integration 

To the left of the Project selector in the upper right corner of the Global Search panel, a status cue of the Signals 

Notebook material synchronization is displayed indicating the status of the Signals Notebook data stream to confirm 

that data is being properly ingested into Signals Inventa.   

 

By hovering over the visual cue, additional details on the Signals Notebook materials synchronization (last update, 

update frequency) is displayed so you can confirm that the data in Signals Inventa is current.  

 

Refer to Appendix E: Signals Notebook Integration.  

Note: Currently Signals Notebook material synchronization is specifically available for Compound/Batch configured 

systems and is not available for other entity models.   

Note: If your company is not integrated with Revvity Signals Notebook, the streaming visual status icons are not 

visible on the Global Search panel.  

6.12 Theme Support 

The Global Search panel supports themes in Spotfire. You can either select the light or dark visual themes that are 

predefined or customize your own theme.   
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7 Assay Details 

The Assay Details visualization displays the assay details data from different measurement types for a particular 

candidate (usually chemical compound). You are able to define how the assay data will be represented based on the 

measurement types, by using the Assay Details Layout definition page. Refer to Managing Assay Details Layout 

section for more information.  

 

 

To view the Assay Details visualization: 

1. Select Tools > Signals Inventa > Open Assay Details from the main menu to open the Assay Details page. 

Refer to the Assay Details Properties section below for information in configuring the data to be dispayed on this page.  

In the figure above: 

1. ID Column: The column which represents the value from the Compound ID or Compound Batch ID column. 

This value will be used as the key value to retrieve the assay data for each measurement type. You can 

choose whether it is the Compound ID or Compound Batch ID that will be used as the ID column by changing 

the corresponding settings in the Assay Details Properties dialog.   

2. Box Column: The column which contains the compound information. This information can be in a chemical 

structure format, for example, MOLFILE or SMILES, can be a BLOB which contains the image data, or a 

hyperlink which links to an image online. You can select the renderer for this Box Column to render the 

content and display in this square area. 
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3. Simple Value Columns: The columns from the data table which contains the ID Column and Box Column can 

be shown in this area, depending on the user selection. The data table that contains the ID Column and Box 

Column is called the Main Table, which is also the data source for the Assay Details visualization. 

4. Signals Inventa Project: The currently selected project is displayed.  

5. Navigation Panel: With this panel, you can navigate between each compound back and forth, or go to the 

first or last record in the Main Table. You can also navigate to a specific compound directly by typing the 

compound ID or compound batch ID value in the text box. The Navigation Panel will list the IDs that match the 

value in the text box as you type to assist in easily locating the compound you are interested in. 

6. Tool Buttons: Assay details visualization has two tool buttons: 

a) Refresh Button: Each time the assay details layout is modified, Spotfire users can refresh the visualization 

by clicking this button, so that the latest layout will be displayed. 

b) Properties Button: Clicking this button will display the Assay Details Properties dialog. From here, you can 

perform additional configuration for the current assay details visualization. 

7. Collapse/Expand Buttons: Use these buttons to collapse or expand all the assay details shown on the page. 

8. Assay Details Area: Assay data for the selected measurement type is displayed here with the specified 

order, layout and format dependent on the properties defined in the Assay Details Properties window. 

Note: Initially when the Assay Details visualization is opened, it will automatically choose the first table in the 

document as the Main Table. By default, the marking of the Main Table will be set to (All), indicating that you are able 

to navigate each of the rows in the Main Table by using the Navigation Panel. You can also limit the navigation to only 

the rows that are selected by a specific marking. In addition, if no result measurement type has been chosen, or no 

layout has been defined for the chosen measurement type in the Assay Details Properties dialog, the following 

warning message will be shown. In this case, you need to define at least one layout for the measurement type in the 

Assay Details Layout configuration and make sure the measurement type is chosen in the Result tab under the Assay 

Details Properties dialog. 

 

Assay Details Visualization Properties 

To configure the Assay Details Visualization, click the cog icon ( ) at the upper-right side of the page. This will open 

the Assay Details Properties dialog similar to the example shown below: 
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This dialog is very similar to the standard Spotfire visualization properties dialog in terms of the look-and-feel making it 

easy for you to change the settings for the current Assay Details visualization. 

General Tab 

This tab is very simple; it contains the basic settings for the current Assay details visualization, which includes the title 

of the visualization and whether the title bar should be displayed. Note that when you toggle the Show Title Bar 

checkbox, the visualization will refresh immediately without having to click the Data Tab. 
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Within the Data Tab, you can choose which data table in the currently opened Spotfire document should be used as 

the Main Table to provide the ID Column, compound data as well as the compound properties information.  

You can also choose the preferred marking to be used by the Assay Details visualization. Marked rows that belong to 

the selected marking will be displayed in the Assay Details visualization. 

If the ‘Show all rows if marking is empty’ option is checked, and there is no row being selected under the specified 

marking (marking is empty), all rows will be bound to the Assay Details visualization.  

 

If the ‘All’ option is selected, all rows will be bound to the Assay Details visualization, regardless whether or not there is 

any marking applied on the selected table.  
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Appearance Tab 

 

In the Appearance tab, you can choose the overall layout of the assay details visualization. There are four choices in 

the drop-down box: 

1. auto – The number of columns shown in the assay details visualization will be adjusted automatically, depending 

on the screen resolution. A maximum of three columns will be displayed depending on resolution.  

2. 1-column – Assay Details visualization will only show one column, with the ID Column and Box Column be stacked 

on to the assay details area. 

3. 2-columns – Assay Details visualization will show two columns, with the ID/Box Column and assay details area 

showing side-by-side. 

4. 3-columns – There will be one column for the ID/Box Column and two columns displaying assay details. 

When switching between the options, the preview picture is updated according to the selection and the selection will 

take effect immediately. 
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Columns Tab 

 

Settings under the Columns tab determine how the columns from the Main Table will be used in the Assay Details 

visualization. For example, you can choose a particular column as the Box Column, and specify a renderer for that 

column, so that it can be shown with a correct representation in the Box Column square area in the Assay Details 

visualization. More configuration options are available under this tab to control the display of the data columns from 

the main table. 

1. ID Column: The column which represents the value from the Compound ID or Compound Batch ID column. 

This value will be used as the key value to retrieve the assay data for each measurement type. When defining 

the measurement mappings for measurement types, there are Compound ID and Compound Batch ID 

mapping fields that cannot be set as an empty value at the same time. You must specify the mapping between 

the measurement type and the assay endpoint results table for either Compound ID column or Compound 

Batch ID column, or both. Based on this mapping setting in the measurement type maps, you can select either 

the Compound ID or Compound Batch ID radio button here, to decide whether it is the Compound ID column 

or Compound Batch ID column from the measurement type that is going to be compared with the selected ID 

Column. This defines the key column to be used for retrieving the assay details from the backend services.  

2. Box Column: The column whose content will be shown in the large square box in the Assay Details 

visualization. Typically, this column contains the chemical structure data, or it can be a column that holds the 

BLOB data which represents an image, or a hyperlink which links to an image online. Different content can be 

rendered into a human-readable representation via selected renderer at the right-hand side 

3. Renderer: This drop-down box lists all the available renderers that can be used for rendering the Box Column. 

The available renderers are retrieved from Lead Discovery Premium which is installed alongside Signals 

Inventa. Note that in the Assay Details Properties window, you are not able to configure the renderer settings. 

Those settings are configured and managed by Lead Discovery Premium. Assay details page will only use the 

default renderer settings, if there is any renderer setting options for the selected renderer. 
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4. Available Columns: All the columns in the selected table under the Data tab will be listed here as a 

candidate to be added into the Simple Value Columns area of the Assay Details visualization. You can add 

the columns to or remove them from the Simple Value Columns area by using the Add, Remove and 

Remove All buttons, to move the columns between Available Columns list and Selected Columns list. 

5. Selected Columns: The columns listed in the Selected Columns list are placed into the Simple Value 

Columns area of the Assay Details visualization. You can adjust the order of the columns by clicking the 

Move Up and Move Down buttons. 

Results Tab 

Users can define the measurement types that contain the assay data to be shown on the Assay Details visualization. 

You can choose the measurements that you are interested in from within the Results tab of the Assay Details 

Properties window. 

 

In the screen above, the Available Tables list will show all the measurement types which already have a layout 

defined. Users can choose the measurements that should be shown in the Assay Details visualization by moving them 

from the Available Tables list into Selected Tables list. You can also define the order of the measurements by 

clicking the Move Up and Move Down buttons. 

Note that only the measurement types that have the assay details layout defined will be shown in the Available Tables 

list.  
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Layout Tab 

With the Layout tab, you can choose the layout that is used for presenting the assay data for each selected 

measurement type. For each measurement type (also known as the assay), you can choose one layout from all 

available layouts; you can also define whether the content of the assay should be expanded or collapsed when it is 

first added to the Assay Details visualization. 

 

1. Assay Name: This column shows the name of the assay (measurement type) that has been selected in the 

Results tab 

2. Layout: For each assay (measurement type), there will be one or multiple pre-defined layout that will be listed in 

the Layout column here. You can choose the layout for the Assay Details visualization to present the assay details. 

For example, in the assay details layout definition, if you have defined a layout with the Table type, and you have 

selected that layout for the current assay, the data for that particular assay will be presented in the Table layout in 

the Assay Details visualization. The  icon at the right side represents that the current layout is the default layout 

3. Expand: The check box determines if the display of the result data should be expanded when it is first added to the 

Assay Details visualization. Uncheck this check box to collapse the result data area. You can still expand/collapse 

the results in the Assay Details visualization by clicking the small triangle icon in front of each assay name, or 

expand/collapse all the results by clicking the Expand All/Collapse All buttons 

In the Layout tab, you can also adjust the order of the assays to be shown by using drag-and-drop. The changes will 

take effect immediately. 
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8 Publish Measurements App 

8.1  Accessing the Publish Measurements App 

The Publish Measurements App is available in the Signals Apps store which is accessed through the main Spotfire 

Interface. You will be required to login to the Signals Data Factory using your SSO credentials before you can access 

this app if you have not been authenticated or if your session has expired.  

Note: If the SDF ApiKey Spotfire preference has been set, you will not be required to logon. Refer to Setting the SDF 

ApiKey section for further information.   

Note: If you are using Safari web browser, please make sure that it won’t block the pop-up dialog from Signals Data 

Factory domain. To enable the pop-up dialog from Signals Data Factory: 

1. In Safari, select Preferences menu. 

2. In the Preferences dialog, choose Websites tab. 

3. In the Configured Websites list, make sure that Signals Data Factory web page has been set to Allow. 

To access the Publish Measurements App:  

In Spotfire Analyst Client: 

1. Select Tools > Signals Apps.   

 

To launch the app, click anywhere on the Publish Measurements App card and it will be added to the document 

using the default app settings. 

In Spotfire Web Player: 

1. Open data in Spotfire. 
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2. Select Tools > Signals Apps.   

3. To launch the app, click anywhere on the Publish Measurements App card and it will be added to the 

document using the default app settings. 

A Publish Measurements page is displayed, similar to the example shown below.  

 

Please refer to the Publish Measurements Tool section of the main Signals Inventa User Guide for information on 

using Publish Measurements tool.  

Note: You can change the name of the app by modifying the default settings. Click on the Configure button that will 

appear when you hover the mouse over the app card. The name of the added app page can be changed in the ‘Page 

Name’ field. It is recommended that you assign a unique name to the app page for clarity while working with the 

resulting Spotfire dashboard.  Alternatively, you can change the page title by right clicking on the Publish 

Measurements page tab and selecting Rename Page from the pop-up menu.  

Note: The Publish Measurements App supports Signals Apps workflows. Workflows is a feature that allows you to 

streamline the workflows by creating a document where you can string several Apps together, run different types of 

analysis with the same app, etc. If the Publish Measurements App has been added to a workflow, the “Select 

Measurement Type”, “Select Data Table to publish” and the “Mapping name” values will be kept when you reinitiate a 

document with the saved workflow. For more information about workflows, please refer to the Appendix A. 

  



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 172 of 366 

  

9 Global Search App 

After data is published to Signals Data Factory through Signals Inventa, the Global Search app allows you to: 

• Create complex nested queries and interrogate any subset of the stored data of interest. 

• Explicitly set the scope of a query to be Compound, Batch, or Measurements, which results in much more 

precise control over the results set returned. 

• Query for Structure, any compound attribute, and any assay or measurement, and query over an expanded 

set of comparison operators. 

• Include multiple chemistry search criteria to more precisely find the subset of compounds of interest. Control 

system performance directly by choosing estimated vs. precise query result counts at different levels of 

precision. 

• Save queries for easy re-use. Saved searches can be public or private.  

 

Global Search uses the Batches, Compounds and Assay Endpoint Results tables from Signals Data Factory to 

provide the search capabilities.  

9.1 Accessing the Global Search App 

The Global Search App is available in the Signals Apps store which is accessed through the main Spotfire Interface. 

You will be required to login to the Signals Data Factory using your SSO credentials before you can access Global 

Search if you have not been authenticated or if your session has expired.  

Note: If the SDF ApiKey Spotfire preference has been set, you will not be required to logon. Refer to Setting the SDF 

ApiKey section for further information.   

Note: If you are using Safari web browser, please make sure that it won’t block the pop-up dialog from Signals Data 

Factory domain. To enable the pop-up dialog from Signals Data Factory: 

1. In Safari, select Preferences menu. 

2. In the Preferences dialog, choose Websites tab. 

3. In the Configured Websites list, make sure that Signals Data Factory web page has been set to Allow. 

To   access the Global Search App:  

In Spotfire Analyst Client: 

1. Select Tools > Signals Apps.   
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2. To launch the app, click anywhere on the Global Search App card and it will be added to the document using 

the default app settings. 

In Spotfire Web Player: 

1. Open data in Spotfire. 

2. Select Tools > Signals Apps.   

3. To launch the app, click anywhere on the Global Search App card and it will be added to the document using 

the default app settings. 

A Global Search page is displayed, similar to the example shown below. 
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Please refer to the Global Search section of the main Signals Inventa User Guide for information on using Global 

Search.  

Note: You can change the name of the app by modifying the default settings. Click on the Configure button that will 

appear when you hover the mouse over the app card. The name of the added app page can be changed in the ‘Page 

Name’ field. It is recommended that you assign a unique name to the app page for clarity while working with the 

resulting Spotfire dashboard.  Alternatively, you can change the page title by right clicking on the Global Search page 

tab and selecting Rename Page from the pop-up menu.  
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10 SAR Analysis App 

The SAR Analysis App greatly simplifies the process of assembling and interpreting the Structure - Activity 

Relationship data that has been pulled into Spotfire from the Global Search App.  With the SAR Analysis App, it is 

easy for a regular drug discovery scientist to: 

• Define how the Compound and Assay data should be organized (e.g. by Compound or Compound Batch) and 

summarized (by mean, median, count, standard deviation, etc.). 

• Customize long assay names into more meaningful, human-readable abbreviations. 

• Configure intuitive tabular and graphical representations of the data through a point-and-click interface. 

• Toggle between saved views of the data to easily navigate SAR analyses including many assays. 

• Generate and compare compound lists with an interactive Venn diagram. 

 

The SAR Analysis App makes use of the Compound, Batch and Assay Endpoint Results tables that are loaded into 

Spotfire from the Global Search App. 

10.1 Accessing the SAR Analysis App 

The SAR Analysis App is available in the Signals Apps store which is accessed through the main Spotfire Interface. 

You will be required to login to the Signals Data Factory using your SSO credentials before you can access this app if 

you have not been authenticated or if your session has expired.  

Note: If the SDF ApiKey Spotfire preference has been set, you will not be required to logon. Refer to Setting the SDF 

ApiKey section for further information.   

The SAR Analysis App is available in the Signals Apps store which is accessed through the main Spotfire Interface. 

To access the SAR Analysis App:  

In Spotfire Analyst Client: 

1. Select Tools > Signals Apps.   
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2. To launch the app, click anywhere on the SAR Analysis App card and it will be added to the document using 

the default app settings. 

In Spotfire Web Player: 

1. Open data in Spotfire. 

2. Select Tools > Signals Apps.   

3. To launch the app, click anywhere on the SAR Analysis App card and it will be added to the document using 

the default app settings. 

A SAR Analysis page is displayed, similar to the example shown below.  
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Note: You can change the name of the app by modifying the default settings. Click on the Configure button that will 

appear when you hover the mouse over the app card. The name of the added app page can be changed in the ‘Page 

Name’ field. It is recommended that you assign a unique name to the app page for clarity while working with the 

resulting Spotfire dashboard.  Alternatively, you can change the page title by right clicking on the SAR Analysis page 

tab and selecting Rename Page from the pop-up menu.  

After defining the search criteria and clicking the Download these results button in Global Search, data from Signals 

Data Factory is downloaded, and two Spotfire data tables are generated; a ‘Compounds’ table and an ‘Assay Endpoint 

Results’ table.  As the SAR Analysis app is loading, it is generating the SAR table for this data. When the app is first 

opened, the Analysis tab displays, by default, the generated SAR table in the Lead Discovery ChemCharts table in 

Spotfire.   

10.2 Analysis tab 

Here you can filter for compounds of interest by Compound ID or Compound Batch ID. The option available to you in 

the Analysis tab is based on the SAR table configuration. Refer to the Configuration section for more information.  
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The visualization displayed in the right panel is determined by the selected visualization in the Visualizations tab. Refer 

to the Visualizations section for more information.  

The Compound IDs (or Batch Compound IDs) can be sorted in ascending or descending order using the and  

buttons respectively.  
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Filter the rows to one or more compounds. This is a standard Spotfire filter – typing a compound identifier in the type-

ahead box will bring that compound to the top of the list. Query operators are also available to help you find the 

compounds of interest.  

 

Left-Click to select a compound from the list and Control-Click to single-select one or more individual compounds. To 

select a range of compounds, you will need to  individually click the desired checkboxes, or use the Control-Click 

functionality. The Shift-Click operation does not work in this grid.  

You can also choose to display All results, Selected results and Not Selected results based on the search criteria.   

 

Changes made here are reflected in the visualization in the right panel.  

10.2.1 Groups 

To make it easier to get an overview of the filters in the filter panel, you can create filter groups. Groups can be 

assigned a name and saved, and shared between multiple instances of the app.    

Note: A default filter scheme “SAR Analysis Filter” is added to the document when the first SAR Analysis page is 

added. This default filter scheme is shared between all SAR Analysis pages in the document. This filter scheme 

cannot be renamed or deleted. The Group view only displays the values in the default “SAR Analysis Filter” and if you 

select a different filtering scheme in the SAR Analysis page, the selection binding between group and the visualization 

in the right panel will not work properly.  
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10.2.1.1 Working with Groups                              

To create a new group:  

1. Filter the results to include in the group by checking/unchecking items in the list or by using the search filter.  

 

2. Click on the Create new group based on current selection   icon to save group. The Save Group dialog 

opens.  

 

3. Enter a unique Group Name.   

4. Click Save.  

The Group Name displays the number of Compound IDs (or Batch Compound IDs) (in parenthesis) in the group 

following the Group Name.  
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Using the Group drop-down list, you can switch between different groups. Changes made to the groups will be 

displayed in the visualization in the panel on the right.  

To search and select a group: 

1. From the Select a group drop-down list, input the group name in the Search or create edit box to search for 

the group. Alternatively, using the up and down arrow keys, you can search for the Group name in the list.  

2. Select the Group name.  

The newly selected group is reflected in the visualization in the right panel.  

To search and create a new group: 

In the case where a search does not locate the group, you can create an empty group using this group name.  

1. From the Select a group drop-down list, input the group name in the Search or create edit box to search for 

the group. There is no data to display for the specified Group name.  

2. Click on the + Create Group: Group Name button.  
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By default, all items will be shown as unchecked.  
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3. Check or filter the items to include in the new group.  

 

3. Click on the Save group to database   icon to save the new group. 
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Alternatively, instead of clicking the + Create Group: Group Name button to create a new group, you can also hit the 

Enter key directly in the Search or create edit box to create the new group.  

Total Count and Dirty Flag  

A group is flagged as dirty when changes are made to the group, and it has not yet been saved again. In the example 

below, Group 2 had 0 items when first created. Ten items were added to Group 2.  

The Group is flagged as dirty (pink background) until the group is saved. 

   

Also, as changes are made to the current group, the current total number of items in the group is displayed, as well as 

the original total number of items in the group with a “->” sign between the two counts. For example, (0 -> 10) indicates 

that initially the group has 0 items, however now it has changed, and the current number of items in the group is 10.  

Once the Save group to database   icon is clicked, the group is no longer flagged as dirty. 
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To save as a new group: 

1. Filter the results to include in the group. 

2. From the Save group to database drop-down menu select Save As.  

 

The Save As Group dialog opens.  

 

3. By default, the group name will be a copy of the selected group name. You can enter a new unique name for 

the group.  

4. Click Save. The new group will be appended to the Group drop-down list.  

To rename a group: 

1. From the Save group to database drop-down menu, select Edit to open the Edit Group window.  

2. Enter a new name for the group.  

 

3. Click Save.   
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To reset a group: 

If a group is flagged as ‘’dirty”, you can reset the group to its original filter.  

1. From the Save group to database drop-down menu, select Reset. You will be prompted to confirm the Reset 

operation.  

To delete a group: 

1. From the Save group to database drop-down menu, select Delete. You will be prompted to confirm the Delete 

operation.  

You can also delete a group directly from the Select a group drop-down list, by selecting the  Delete icon next to 

the selected group name.  

 

To refresh the list of results:  

The Refresh  button will refresh the Group drop-down list. This is useful in the case where two users are working 

with the SAR app. For example, one user may have created a new group, however this new group will not be visible to 

the second user until the Refresh button is clicked.  

Selecting a Group 

When selecting a group from the drop-down list, you have the option to filter rows in the data table or mark rows in the 

data table. From the Selecting a Group drop-down list, you can choose to ‘Filter Rows in the Data Table’ or “Mark 

Rows in the Data Table’.  

i. Filter Rows in the Data Table  

If you choose ‘Filter Rows in the Data Table’, the visualization displayed in the right panel will only displays the rows in 

the selected group.  

ii. Mark Rows in the Data Table 

If you choose ‘Mark Rows in the Data Table’, the visualization displayed in the right panel will display all rows in the 

data table and mark the rows that are in the selected group similar to the example shown below.  
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This option allows you to see what compounds are in the selected group, and then by viewing all the data in the data 

table, you can determine what compounds you want to add to the group.  

In the example here, you may decide you want to include two additional compounds in Group 1. Once marked they will 

be added to Group 1 as shown below.   
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Group 1 will be tagged as dirty: 

  

You can choose to reset the group to its original filter or click on the Save group to database   icon to save Group 

1 with the additional compounds.  

Note: The Venn diagram in the lower section of the panel also has a similar drop-down list for Selecting a Venn 

diagram section. These two drop-down lists are synchronized, and changes to one are reflected in the other.   

Groups in Current Analysis 

There may be the case that a group is selected from the Select a group drop-down list, however not all the compounds 

in the group are in the current analysis.  

In the example shown below, the Compounds of Interest group is selected. This group has 18 compounds. However, 

in the current analysis, there is only one compound in the group. In this case, the compounds in the group that are not 

in the current analysis are greyed out.  

  

Groups will always include the compound in the group even if it is not in the current analysis unless you manually 

uncheck a greyed-out compound (compound is not in the current analysis) and then save the group. In the example 

above, REG00365522 is not in the current analysis. If you manually uncheck this compound, the group will be flagged 

as dirty. Clicking on the Save group to database   icon will save the group, and REG00365522 is deleted from the 

group.   
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10.2.2 Venn Diagram 

The Venn diagram allows you to graphically compare groups (of Compound IDs, Compound Batch IDs) such that you 

can arrive at a subset of compounds of value and interest more quickly.  

 

Working with groups in the Venn diagram is similar to working with groups in the Group panel. Using the Create new 

group based on current selection icon, and the Save group to database icon and drop-down menu, you can create a 

new group, save as a new group, rename, reset, and delete groups in the Venn diagram panel. Refer to Working with 

Groups section.  

 

Any changes made to the groups in the Venn diagram panel will also update the corresponding groups in the Groups 

panel. 
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 10.2.2.1 Working with the Venn Diagram 

The first step in creating a Venn diagram is to define the groups to be included in the diagram.  

To search and select a group to add to the Venn diagram: 

1. From the Select a group drop-down list, input the group name in the Search or create edit box to search for 

the group. Alternatively, using the up and down arrow keys, you can search for the Group name in the list.  

 

The group is added to the Venn diagram, and the number of items in the group is labelled. The groups are color 

indicated making it easier for you to identify the groupings in the Venn diagram.  

To search and create a new (empty) group to add to the Venn diagram:   

In the case where a search does not locate the group, you can create a new (empty) group for this group name.  

1. From the Select a group drop-down list, input the group name in the Search or create edit box to search for 

the group. There is no data to display for the specified Group name.  

2. Click on the + Create Group: Group Name button.  

An empty group will be created and added to the Venn diagram.  Alternatively, instead of clicking the + Create Group: 

Group Name button to create a new group, you can also hit the Enter key directly in the Search or create edit box to 

create the new (empty) group.  
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Once an empty group is created, you can mark rows in the visualization in the right-hand panel and using the drag-

and-drop green ball, add compounds IDs to the group. Refer to the Drag and Drop Marked Rows into a Venn Diagram 

section. 

Note: Before working with groups in the Venn Diagram, best practice is to clear any selected groups in the Groups 

section. A warning message, similar to the example shown below, will appear when you attempt to work with a group 

in the Venn Diagram that is currently selected in the Groups section above.  

 

You may continue with the selected group however you may experience some unexpected behavior with the groups.   

A similar message will appear when selecting a group from the Groups drop-down list if the group has already been 

selected for use in the Venn diagram.  

Adding multiple groups to the Venn Diagram  

1. Click on the  to add a new group select item.  

 

2. From the Select a group drop-down list for the new group select item, search and select another group to include in 

the Venn diagram.  

The Venn diagram will be updated with the new group. Note that the groups are proportionally represented in the Venn 

diagram.  
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Note: A maximum of 5 groups can be added to the Venn diagram.  

Understanding the Venn Diagram  

The groups are color indicated making it easier for you to identify the groupings in the Venn diagram.  

You can click different sections in the Venn diagram. The selected section will be indicated with slashes.  
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If you select a section in the diagram, and holding the <Ctrl> key, you can select multiple sections in the diagram, 

similar to the example shown below.                                                                                       
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Clicking the label with the total count will select all the sections for the related group, similar to the example shown 

below. Clicking outside of any of the circles will clear all selections.  
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Labelling of the Venn Diagram   

 

In the Venn diagram shown here, the Venn diagram labelling indicates the following: 

• 831 indicates that there are 831 items in Group 1 

• 825 indicates that there are 825 items which are only in Group 1 

• 10 indicates that there are 10 items in Group 2 

• 4 indicates that there are 4 items which are only in Group 2 

• 6 indicates that there are 6 items which are in both Group 1 and Group 2 

 

Tooltips 

Hovering the mouse over different sections in the Venn diagram will display a tooltip indicating the count of items in 

the section.  

In the example shown here, hover the mouse anywhere on the blue section except directly on the label. The selected 

section is items ONLY in Group 1. The count in the selected section is 825.   
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In the example shown here, hover directly over the blue label. The count in the selected section (Group 1) is 831 

items.  
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In the example shown here, hover the mouse over the intersection of the two groups. The selected section is the 

intersection of Group 1 and Group 2. The count in the selected section is 6 items.  

 

Similarly, in the example shown here, hover the mouse anywhere on the orange section except directly on the label. 

The selected section is items ONLY in Group 2. The count in the selected section is 4.   
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In the example shown here, hover directly over the orange label. The count in the selected section (Group 2) is 10 

items.  
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Zoom In/Zoom Out 

Hovering directly below the right corner of the last group select item will display the Zoom in and Zoom out buttons. 

Using these, you can zoom in to get a closer look at the groupings in the Venn diagram or zoom out to see more of the 

groupings in the Venn diagram at a reduced size.  

 

Selecting a Venn Diagram section 

i. Filter Rows in the Data Table  

If you choose ‘Filter Rows in the Data Table’, the visualization displayed in the right panel will only displays the rows in 

the selected section. In the example below, the user clicks on the intersection of Group 1 and 2 (6 Compounds IDs). In 

the visualization, the table is filtered to the 6 Compounds IDs in the selected section.   
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ii. Mark rows in the Data Table 

Mark rows in the Data Table allow you to see all the data in the current data set and easily identify which compound(s) 

to add to a given group, and then mark the compound(s) and drag and drop it (or use the right click menu) into the 

group of interest. Refer to Drag and Drop Marked Rows into a Venn Diagram section and Right Click Menu sections.  

Using the same example, if you choose “Mark rows in the data table” and select the intersection of Group 1 and 2 (6 

Compound IDs), the visualization displays all data in the current data set and marks the 6 Compounds IDs in the 

selected section.   
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Drag and Drop Marked Rows into a Venn Diagram section 

The green circle displayed in the lower left corner of the Venn diagram panel indicates the number of marked rows in 

the data table and the total count of all rows in the data table.  

 

You can drag the green circle and drop it into a section in the Venn diagram. This will add the marked rows to the 

section.  

If the drop is successful, a message will appear indicating that the # of marked rows has successfully been added to 

the section.  

In the case that the selected section is an intersection of multiple groups, the marked rows will be added to each of the 

groups.  

Right Click Menu  

When working with sections in the Venn diagram, a right click menu is available for you to add marked items into a 

selected section, removed marked items from a selected section and save marked items as a new group. In addition, 

you can save a selected section in the Venn diagram as a new group.  

 

When saving a selected section as a new group, you will be prompted to give the new group a unique name.  Click 

Save to save this new group.  
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When marked items are added to a section, a message will appear indicating that the # of marked rows has 

successfully been added to the section. You will also be notified if the marked items already exist in the selected 

section.   

When saving marked items as a new group, you will be prompted give the new group a unique name. Click Save to 

save this new group.  

 

Limit Groups to current analysis  

As noted in the Groups section, there may be the case that a group is selected from the Select a group drop-down list, 

however not all the compounds in the group are in the current analysis.  

In this situation, you have the option to include all items in the group (not dependent on the current data set) in the 

Venn diagram or limit the group membership in the Venn diagram to only the items in the current data set.  

 

Using the Limit groups to current analysis checkbox, you can set the behavior to suit your requirements.  

10.3 Visualizations 

From the Select Visualization drop-down list, you can select the Spotfire visualization to view your                                                                                                

results. Each visualization is configurable, so you can customize to suit your requirements.  
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To select a visualization: 

1. From the Select Visualization drop-down box, select the visualization that you want to work with. The SAR 

Table visualization is selected by default.  

 

The configuration parameters for each visualization is described in detail below.  

10.3.1 SAR Table 

Here you can create the SAR table for the ChemCharts table developed in Lead Discovery ChemCharts (Lead 

Discovery Premium) by selecting the columns to add to the table.  

The Column list contains all results (assays and annotations) that were selected in Global Search as well as some pre-
defined compound attributes. You can select columns and they will appear in the SAR table in the order selected.  
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You can filter the rows to one or more columns. Typing a data type or column in the type-ahead box will bring that data 

type/column to the top of the list. Query operators are also available to help you find the data types and/or columns of 

interest.  

 

 

Left-Click to select a column from the list and Control-Click to single-select one or more individual columns. To select a 

range of columns, you will need to individually select the desired checkboxes, or use the Control-Click functionality. 

The Shift-Click operation does not work in this grid.  

You can also choose to display All results, Selected results and Not Selected based on the search criteria.   

 

The SAR Table in the panel on the right will be updated as columns are selected/deselected.                                      

10.3.1.1  Layouts 

To make it easier to get an overview of the column filters in the SAR table, you can create filter layouts. Layouts can 

be assigned a name and saved, and shared between multiple instances of the app.   

Permissions can be assigned to a layout. They can be set to private or assigned to a group(s). Groups are retrieved 

from the Signals Data Factory.  
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To create a new layout:  

1. Filter the columns to include in the layout by checking/unchecking columns in the list of by using a search 

filter.  

 

2. Click on the Create new layout based on current selection  icon to save the layout. The Save Layout 

dialog opens.  
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3. Enter a unique Layout Name.  

4. Specify to Share This Layout to Private or Group. If Group is specified, you can select the group(s) to share 

with from the drop down list. The list of groups is retrieved from the Signals Data Factory.  

Note: Admin users can see all groups. Other users can only see groups they are currently a member of.  

 

You must select at least one group to share with.  

5. Click Save.  

The Layout Name displays the number of columns (in parenthesis) in the layout following the Layout Name.  
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For each layout, you can move columns up and down in the list by dragging and dropping the column using the   

When columns are re-ordered, this will be reflected in the pivot SAR Table on the right.   

 

Alternatively, you can access the Properties > Columns dialog, and move the columns using native Spotfire 

functionality. However, this will only affect the column order in the ‘Selected’ view. The ‘All’ and ‘NotSelected’ views 

will not be updated synchronously.  

Using the Layout drop-down list, you can switch between different layouts. Changes made to the layouts will be 

displayed in the visualization in the panel on the right.  

To search and select a layout: 

1. From the Select a layout drop-down list, input the layout name in the Search or create edit box to search for 

the layout. Alternatively, using the up and down arrow keys, you can search for the Layout name in the list.  

2. Select the Layout name.  
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The newly selected layout is reflected in the visualization in the right panel.  

To search and create a new layout: 

In the case where a search does not locate the layout, you can create an empty layout for this layout name.  

1. From the Select a layout drop-down list, input the layout name in the Search or create edit box to search for 

the layout. There is no data to display for the specified Layout name.  

2. Click on the + Create Layout: Layout Name button.  

 

By default, all columns will be selected.  
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3. Uncheck or filter the columns to include in the new layout.  
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4. Click on the Save Layout to database   icon to save the new  layout. 

Alternatively, instead of clicking the + Create Layout: Layout Name button to create a new group, you can also hit the 

Enter key directly in the Search or create edit box to create the new layout.  

Total Count and Dirty Flag  

A layout is flagged as dirty when changes are made to the layout, and it has not yet been saved again. In the example 

above, Group 2 had 66 columns when first created. Six columns were removed from Layout 2.  

The layout is flagged as dirty (pink background) until the layout is saved.   

 

Also, as changes are made to the current layout, the current total number of columns in the layout is displayed, as well 

as the original total number of columns in the layout with a “->” sign between the two counts. For example, (66 -> 60) 

indicates that initially the layout has 66 columns, however now it has changed, and the current number of columns in 

the layout is 60.   
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Once the Save layout to database  icon is clicked, the layout is no longer flagged as dirty.  

 

To save as a new layout: 

1. Filter the columns to include in the layout. 

2. From the Save Layout to database drop-down menu select Save As.  

 

The Save Layout As dialog opens.  

 

3. By default, the layout name will a copy of the selected layout name. You can enter a new unique name for the 

layout.  

4. Specify to Share This Layout to Private or Group. If Group is specified, you can select the group(s) to share 

with from the drop-down list. The list of groups is retrieved from the Signals Data Factory.  

Note: Admin users can see all groups. Other users can only see groups they are currently a member of.  
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You must select at least one group to share with.  

5. Click Save. The new layout will be appended to the Layout drop-down list.  

To rename a layout: 

1. From the Save Layout to database drop-down menu, select  Edit to open the Edit Layout window.  

2. Enter a new name for the layout.  

 

3. Click Save.   

 

Note: Only the administrator or the user who created the layout can rename the layout.  

To reset a layout: 

If a layout is flagged as ‘’dirty, you can reset the layout to its original filter.  

1. From the Save Layout to database drop-down menu, select Reset. You will be prompted to confirm the Reset 

operation.  
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To delete a layout: 

1. From the Save Layout to database drop-down menu, select Delete. You will be prompted to confirm the 

Delete operation.  

You can also delete a layout directly from the Select a layout drop-down list, by selecting the  Delete icon next to 

the selected layout name.  

 

Note: Only the administrator or the user who created the layout can delete the layout.  

To refresh the list of layouts:  

The Refresh  button will refresh the Layout drop-down list. This is useful in the case where two users are working 

with the SAR app. For example, one user may have created a new layout, however this new layout will not be visible 

to the second user until the Refresh button is clicked.  

Layouts in Current Analysis 

There may be the case that a layout is selected from the Select a layout drop-down list, however not all the columns in 

the layout are in the current analysis.  

In the example shown below, the Compound Details layout is selected. This layout has 72 columns. However, of the 

72 columns in the layout, there are only 15 columns in the current analysis. In this case, the columns in the layout that 

are not in the current analysis are greyed out.  
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Layouts will always include the column in the layout even if it is not in the current analysis unless you manually 

uncheck a greyed-out column (column that is not in the current analysis) and then save the layout.  

10.3.2 Scatter Plot 

Here you can configure an intuitive Scatter Plot used for correlating columns of data that have been downloaded.  

 

All the results (assays and annotations) that were selected in the Global Search tab will appear in this SAR Table 

column list as well as a few pre-defined compound attributes. Key features include selectable X, and Y Axes and Color 

By option. Using the Number of Bins slider, the X axis can be configured to use binned data.  
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Zoom Sliders can be used to focus in on regions of interest within a plot. Turning on the Zoom Sliders toggle will add a 

zoom slider along both the X and Y axis. You can now grab the slider and drag it to the left of right to pan horizontally 

along the X axis, top to bottom to pan vertically along the Y axis.  

 

Hovering the mouse cursor over a point in the scatter plot will display a tooltip showing the compound structure as well 

as any related data used to position that point in the plot. Left-clicking a point in the scatter plot will present a label with 

the image of that structure. Lassoing multiple points will display all the selected structures’ images and allow you to 

drag the structure label to different positions in the display. 

Note: Refer to the “Scatter Plot” topic of the Spotfire online help for additional information on this functionality. 

10.3.3 Bar Chart 

Here you can configure an intuitive Bar Chart (which acts as a histogram when numeric attributes are selected). This 

view is used for viewing the distribution of columns of data that have been downloaded.   
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All the results (assays and annotations) that were selected in the Global Search tab will appear in this SAR Table 

column list as well as a few pre-defined compound attributes. Key features include selectable Category, Value and 

Color Axis as well as Value Aggregation and Color Aggregation.       

Note: Refer to the “Bar Chart” topic of the Spotfire online help for additional information on this functionality.                                             

Zoom Sliders can be used to get a closer look at details in the bar chart. Turning on the Zoom Sliders toggle will add a 

zoom slider along both the X and Y axis. You can now grab the slider and drag it to the left of right to pan horizontally 

along the X axis, top to bottom to pan vertically along the Y axis.  
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10.3.4 Basic Table 

Here you can create the SAR table for the standard Spotfire data table by selecting the columns to add to the table.  

Refer to the SAR Table section for information on creating or selecting a layout for the Basic Table.     

10.4 Configuration 

The Configuration tab allows you to configure the default SAR Table Setup as well as column aliases. 
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10.4.1 SAR Table Setup 

Select Tables: 

The SAR table can be generated based on compound and batch results. Here you can define the Compound Table,  

Batch Table, Compound AER Table and Batch AER Table to be used to generate the SAR Table.  

Select Identifiers: 

Here you can specify which columns from Compound and Batch tables could be used as the identifiers (e.g. 

Compound ID, Compound Batch ID) to define the rows in the SAR table.  

SAR Table Rows by: 

The value of the “SAR Table Rows by” will identify the key column of the SAR Table. There are two selections 

available: 

• Compound Identifier – the Compound ID column will be used to distinguish the SAR table rows.  

• Batch Identifier – the Batch ID column will be used to distinguish the SAR table rows.  

 Validation errors are displayed to assist in proper selection of tables and identifiers.  

Experiment Factor Pivot Expressions 

Here you can include one or more Experiment Factors in the pivot of data from the Batch/Compound Assay Endpoint 

Results.  

In several cases, particularly in ADMET, one of the Experimental Factors will likely be a numeric value, most 

commonly Test Concentration, and because of experimental variability the determined Test Concentration will have 

experimental variability to it, resulting in small differences in the number from the target number (e.g. a concentration 

of 0.99nM when the target concentration is 1.0nM). 

In defining the pivot to the SAR table, by default those will be pivoted into different SAR Table columns (e.g. "Result 

for 0.99nM", "Result for 1.0nM", etc., but the desired outcome is that they be pivoted into a single column (e.g. "Result 

for ~1.0nM") 

Using the Experiment Factor Pivot Expressions, you can define binned ranges on numeric Experimental Factors (e.g. 

Concentration) such that small difference in the Experimental Factors  would be grouped together (e.g. 0.99 and 1.0 

could be grouped into “1”).  

The expression editor has two modes: View and Edit. Click on the ‘Enter expression’ text area of the control to enter 

edit mode.  
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The ‘Select’ a function to append’ dropdown lists the Spotfire functions for [Binning] and [Logical]. Refer to the Binning 

functions and Logical functions sections respectively in the Spotfire User’s Guide for more information.  

The ‘Select a column to insert’ drop-down lists the intersection columns of the Compound Assay Endpoint Results 

table and the Batch Assay Endpoint Results table. The internal reserved columns such as [Compound ID], [h1], [h2], 

[h3], [measurement type], [isnumeric] etc, have been removed.  

 

The ‘Enter Expression’ field allow you to edit an expression manually.  

To build Experimental Factors Pivot Expressions:  

1. Select a function and insert into the expression.  

2. Select a column and insert into the expression.  

3. Using the Expression editor, you can edit the expression manually.  

4. Once the expression is built, you can click on the  Validate and apply expression button.  

After clicking the Validate and apply expression button, the SAR Analysis app will validate the expression. If there are 

errors, the expression will remain in edit mode, and the errors will be displayed.  

The usage of the expression is described in a help page. You can open the Help dialog it by clicking the  icon. 
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To rename the experimental factors pivot:  

The Experimental Factor name can be added to the new column headers.  

By default, the name for the new column header is: [Endpoint name], Exp factor. Renaming the column to include the 

name of the experimental factor can be accomplished by using ‘concatenate’. For example, 

Concatenate('[Experimental Factor]: ', [Experimental Factor])  

Experimental Factors Delimiter 

Here you can specify the delimiter to separate the result name and the pivoted experimental factor values. 

Aggregations 

You can define how the assay endpoints should be pivoted and aggregated (e.g. Average, Min, Max, Median etc.). By 

default, one aggregation is assigned to each endpoint.  
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Note: The Concatenate and UniqueConcatenate aggregations will use the comma (,) as the separator when 

concatenating the values. If you prefer to use the New Line as the separator, you can choose the Concatenate 

(NewLine) and UniqueConcatenate(NewLine) aggregations. In certain cases, some performance degradation is to be 

expected. 

Using the drop-down control for each aggregation, you can add multiple aggregations by enabling the checkbox and 

clicking OK.  
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Custom Aggregations 

Custom aggregations allows users to customize how data is transformed and the SAR table is formed by using the 

standard Spotfire transformation steps. This allows the user to have more control over the data transformation.  

Each custom aggregation consists of one or more transformation steps. A transformation step is an operation applied 

on the SAR Table generated by the SAR Analysis App that performs a particular data transformation job. Some of 

these built-in transformation steps have the same name and functionality as those data transformations offered by 

Spotfire. Other transformation steps are actually pre-defined templates which by themselves consist of multiple 

transformation steps to perform more complex data transformation tasks. 

Manage Custom Aggregations 

Clicking on the Manage Custom Aggregations button will open the Advanced Aggregation Settings window similar to 

the example shown below. From here, you can edit previously defined custom aggregations or create new ones.  

 

The Name drop-down list contains the names of all previously saved custom aggregation methods. A name can be 

entered in the Name field or you can use the type ahead to search for the name.  

By default, the SAR Analysis app comes with four pre-defined templates to help you create your aggregations on the 

fly: 
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• Avg +- StdDev: Aggregate the result value by both Avg and StdDev methods and combine the aggregated 

result with +/- sign 

• Avg +- StdDev (Count): Aggregate the result value by both Avg and StdDev methods and combine the 

aggregated result with +/- sign, followed by the number of results being aggregated 

• Avg +- StdDev (Range, Count): Aggregate the result value by both Avg and StdDev methods and combine 

the aggregated result with +/- sign, followed by both the range and number of results being aggregated 

• All-In-One: Concatenate the result value with the endpoint qualifier and aggregates the concatenated strings 

with the new-line separator 

Creating a new custom aggregation:  

1. From the Advanced Aggregrations Settings window, click on the Create new button. Clicking the Create new 

button clears all fields including the JSON text editor.   

2. Enter a unique name for the aggregation. An optional description can be entered.  

3. Select Transformation Steps. 

The Transformation Steps drop-down list will list all the transformation steps that are implemented in Signals Inventa. 

Each corresponds to a data transformation in Spotfire but has the ability of being serialized to/deserialized from JSON 

strings.  

Selecting a Transformation Step and clicking the Add button will add the JSON template of the selected 

Transformation Step into the JSON editor. Next, you can edit the JSON manually to update the definition or adjust the 

order of the transformation. Via the JSON editor, you can edit the JSON to define the custom aggregration method.  

An error message will appear while you are typing if the content of the JSON editor is invalid. For example,  

 

In addition to creating a new custom aggregation method from scratch, you can edit or duplicate an existing 

aggregation method and modify as needed.  
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To edit an existing custom aggregation method: 

1. From the  Name dropdown list, select the aggregation method to rename.  

2. Click on the  Edit icon. This sets the dialog to editable mode.  

3. Update the aggregation as required.  

4. Click on the Update icon to save the changes.  

To duplicate an existing custom aggregration method 

1. From the  Name dropdown list, select the aggregation method to duplicate.  

2. Click on the   Duplicate icon. You will be prompted to confirm the duplication.   

3. The suffix _Copy will be appended to the aggregation method name (e.g. All-in-One_Copy)  

4. Click on the  Edit icon to edit the aggregation method. This sets the dialog to editable mode.  

5. Update the aggregation as required.  

6. Click on the Update icon to save the changes.  

The Name field becomes editable, enter a unique name for the aggregation method.  

To delete an existing custom aggregration method: 

1. From the  Name dropdown list, select the aggregation method to delete.  

2. Click on the   Delete icon. You will be prompted to confirm the deletion.   

After the custom aggregations are defined, users are able to apply the aggregations on the SAR table by using the 

drop-down control, after clicking OK, the selected aggregation(s) will be added to the box.  

 

Using the Refresh icon, you can refresh the Custom Aggregation(s) list 

Note: For detailed explanation about each transformation step, please refer to Appendix C.  
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Exclude Empty Columns 

Enabling the ‘Exclude Empty Columns’ checkbox will exclude any empty columns in the Compound/Batch tables from 

being generated in the SAR table.  

10.2.1 Column Alias 

Here you can change the column names in the SAR table by applying the column alias in a batch. You can define 

automated naming patterns for multiple aggregation columns and single aggregation columns.  

 

For example, a SAR table contains three columns (Text1, Number1, Date1). Two (or more) aggregation functions 

(e.g., Count and Max) are specified on Numeric columns. In this case, the ‘Multiple Aggregation’ rule will be applied to 

column ‘Number1’ when the SAR table is re-pivoted (e.g., Number1 Count, Number1 Max).  

The column alias helps you to identify the aggregation functions used, and easily change the column names.   

You can filter the columns in the grid based on data type, automated name or alias. Typing an identifier in the type-

ahead box will bring the column matches to the top of the list. Query operators are also available.  

If you change the alias, the font color changes to blue, similar to the example shown below.  
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Note: Changing the column name from the Spotfire Column Properties dialog will not affect the column alias since the 

original column name is by design the key to identify the associated column alias. Changing the column name will 

affect the layout.   

10.5 Multiple Apps 

The SAR Analysis app can be added multiple times to the same document. 

The app can be re-named through the Rename page menu item or directly on the tab.   

Configuration is shared between multiples instances of the app. 

Also, under the Analysis tab, filtering in the SAR Analysis panel is shared between app instances. However, Spotfire 

filter schemes are not shared between multiple instances of the app.  

Under the Visualizations tab, the settings for visualizations will differ on a page by page basis, and therefore are not 

shared between multiple instances of the app. For example, even though two scatter plot visualizations are added to 

the same document, each plot may have its own look and feel. Layout settings are saved across multiple instances of 

the apps meaning each app captures the same layout list, however not necessarily the same. 
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11 Assay Results Review App 

The Assay Results Review App loads historical assay results data and compares with the assay data in the current 

document. 

11.1  Accessing the Assay Results Review App 

The Assay Results Review App is available in the Signals Apps store which is accessed through the main Spotfire 

Interface. 

To access the Assay Results Review App:  

In Spotfire Analyst Client: 

1. Select Tools > Signals Apps.   

 

2. To launch the app, click anywhere on the Assay Review Results App card and it will be added to the 

document using the default app settings. 

In Spotfire Web Player: 

1. Open data in Spotfire. 

2. Select Tools > Signals Apps.   

3. To launch the app, click anywhere on the Assay Review Results App card and it will be added to the 

document using the default app settings. 

An Assay Review Results page is displayed, similar to the example shown below.  
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Note: When the app is opened within a workflow, the Analysis tab is the initial tab. However, when running outside of a 

workflow, the initial app is the Configuration tab.  

11.2  Configuration tab 

The Configuration tab allows you to select the query template and generate an Analysis UI (user interface).  

 

Once the app has been configured properly as part of a workflow, these settings will be prepopulated, and the user of 

the workflow typically will not need to change the settings. 

Current Data Table  

Here you can select a Current Data Table. All data tables currently downloaded into Spotfire are available for selection. 

Query template settings 

1. From the Query template settings drop-down list, select the Query template. The Assay Results Review app 

will retrieve all visible saved queries from the Signals Data Factory and only make available the query 

templates (saved searches with ‘@parameter’ contained in the definition) in the app. Refer to the section 
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Creating a Query Template for use in Assay Results Review (ARR) App for more information on the query 

template.  

The query template is used to search the historical data of a measurement type.  

2. Click Generate Analysis UI button.  

 

• Use values from Current Data: A toggle switch (default True) will appear per String type input parameter in 

the Query template. These toggles allow you to choose if the values from the current data should be used 

when provided the field values in the generated user interface. Based on the toggle statuses set here, UI 

controls for each of the query template parameters are generated (based on the parameter type) under the 

Analysis tab.  

• Match historical data with current data. When you click on the plus-sign icon, a Match Columns window 

opens allowing you to match columns from historical and current data. This matching is required for values to 
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appear in the column value selectors under Analysis tab and for any columns used in the Current vs Historical 

visualization.    

 

Any columns matched must have the same data type, otherwise a small warning triangle will appear in the overview 

after clicking the Add Items button.  

 

After clicking the Save button, the Configuration tab is updated with the matched columns.  
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11.3  Analysis tab 

The Assay Results Review app Analysis section contains a wizard like configuration panel where you can configure the 

settings for two different Analysis steps: 

1. Retrieval: This step contains controls that allow you to specify the input parameter values for querying the 

historical data. The controls displayed here are dependent on the toggle statuses for ‘Use values from Current 

Data’ set in the Configuration tab.  

 There are three types of inputs: 

• String inputs. These types of input parameters can be configured in the Configuration tab to use values from 

current data or free-entry data. 

Current data: If you want to use current data, the parameter must first be matched with a local column. After 

this is done, the unique values of the local column will be shown in a column value selector. 

Free entry: This mode allows you to specify any value (not just local values) as input to the query. You should 

specify one value per line. 

• Numeric inputs (optional): For this type of input parameter, you can specify a range (min/max): 

o Both empty => parameter is ignored 

o Min only => include values larger than min 

o Max only => include values less than max 

o Min and Max => include values larger than min and less than max 
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• Date inputs: Start and stop dates. Includes rows after start date and before stop date. You can select the 

dates in the calendar that pops up when clicking on either of the date fields. 

Note: A toggle to ‘Download details measurements’ is also displayed if the measurement type identified in the 

selected query template has a details measurement type.  Turning on this toggle will also download the data of the 

details measurement type and build the table relation between the current measurement data and its details 

Once the input parameter values are defined, clicking the Retrieve button will download the historical data from the 

Signals Data Factory that match the specified parameter values. If applicable, data from the details measurement type 

will also be downloaded.  

2. Comparison: This step allows you to create two sets of visualizations: 

• Current vs Historical. To configure this visualization, you need to select an endpoint column and a MarkerBy 

column. Because this visualization compares two sets of data (current and historical), both selections need to 

be of columns that have been previously matched (in Configuration tab). If not, a warning message will be 

shown, prompting you to match the columns. Once configured, this visualization shows the current endpoint 

values on the X-axis and the historical endpoint values on the Y axis, showing one marker per value in the 

MarkerBy column. 

After clicking ‘Compare’, the comparison is performed, and the scatter plot visualization is displayed.  

• Identify trends. To configure this visualization, you need to select the endpoint column, marker-by column 

and date column from the historical data. Those columns do not need to be mapped since this visualization 

involves only one set of data (historical). Once configured, this visualization shows the trend with the endpoint 

value on the Y axis and the date on the X axis, showing one marker per value in the MarkerBy column. 

After clicking ‘Compare’, the comparison is performed, and an Identity Trend is plotted.   

11.4  Visualizations tab 

This section contains settings that affect what is displayed in the visualization area. Using the toggles, you can turn off 

and on groups of visualizations: 

• Tables: This corresponds to the Historical Data and Current Data table plots. 

• Comparison: This corresponds to the currently selected comparison plot in the second step of the wizard in 

the Analysis tab, i.e. Current vs Historical or Identify Trends. 

• Show excluded points - This toggle allows the user to visualize where excluded points in the current analysis 

fall when compared to the historical data 
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11.5  Using the Assay Results Review App 

The following example outlines how the ARR app can be used to load historical assay results data and compare to the 

assay data in the current document. 

1. Create a query template in Signals Data Factory. Refer to the section Creating a Query Template for use in 

Assay Results Review App. In this example, the query template (ARR Search Template) has been set up with 

the parameters, Assay Date, Compound ID and Protocol Name.  

2. Using Global Search, create a search with measurements conditions similar to the following:  

 

This search will retrieve for the a42 Whold Blood IC50 Measurement Type with an Assay Date between 1/1/2006 and 

12/31/2006. This data will represent the ‘Current Data’ in the ARR app.  

Ensure ‘Only retrieve replicates that match conditions, plus other selected assays’ is enabled under Search Options if 

replicate assay data exists.  
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After downloading the data, all rows in the a42 Whole Blood IC50 table have assay data between 1/1/2006 and 

12/31/2006. 

 

 

3. From the Data menu item in the Spotfire client, select the Data table properties sub-menu item open the 

Data Table Properties window. Make sure that for table a42 Whole Blood IC50, there is a table property 

***.screening.is.active.sample defined and its value is True. If this property is not defined, please define it 

manually.  
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The Assay Results Review app uses this property to identify which table contains the ‘Current Data’. This table is then 

used when creating the mapping workflow in the app. In this example, the ‘Current Data’ is prepared using Global 

Search, however you can also import existing CSV files to represent the current data.  

4. From the Tools > Signals Apps menu item, open the Assay Results Review app. From the Configuration tab, 

select the current data table and query template (e.g. ARR Search Template).  
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5. Click on the Generate Analysis UI button. The app will infer the parameters from the selected query template 

and the panel will be updated similar to the example shown below.  

 

All text parameters (e.g, Compound ID, Protocol Name) are displayed with a toggle to indicate if the parameter values 

will be extracted from the ‘Current Data’ table, in this case, a42 Whole Blood IC50 data table.  

6. For this example, toggle off the Protocol Name parameter. Ensure the Compound ID toggle is turned on.  

Next we need to define the mapping between the query parameter(s) and the columns in the ‘Current Data’ table (i.e. 

a42 Whole Blood IC50 data table).  

7. Click on the plus icon to match historical data with current data. The Match Columns dialog is displayed, 

similar to the example shown below.  
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8. Match the columns from historical data to current data for Compound ID and Assay Date, similar to the 

example shown below. Click Add Items button.  Click Save.  

 

9. Navigate to the Analysis tab. As a result of the Compound ID toggle being enable in Step 6 above, the 

Compounds IDs are populated with the values from the ‘Current Data’ table (i.e. a42 Whole Blood IC50 data 

table).  

10. Specify an assay data to compare the historical with the current data. In this example, we will compare the 

data from 1/1/2002 to 12/31/2005, similar to the example shown below.  
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11. Click on the Retrieve button to download the historical data table.  
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12. Navigate to the Configuration tab. Click  the plus icon  on the Match Columns grid to open the Match Columns 

dialog.  For  this example, match the columns from historical data to current data for IC50. Click Add Items 

button. Click Save.  This endpoint mapping will be used for data comparisons in the following steps.  

 

13. Navigate to the Analysis tab. Click Next at the bottom of the app panel to move to the Comparison step. For 

this example, from the drop-down lists, set the Choose Comparison to Current vs Historical, Endpoint column 

to IC50 and MarkerBy column to Compound ID.  
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14. Click Compare. A scatter plot comparing IC50 (historical) vs IC50 (current), similar to the example shown 

below,  is displayed for you to analyze.  
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15. You can also view identity trends between the historical and current data. For this example, set the Choose 

Comparison to Identity Trends, Trend Endpoint column to IC50, Trend MarkerBy column to Compound ID and 

Trend Data column to Assay Date.   

 

16. Click Compare. A scatter plot comparing IC50 (historical) vs Assay Date, similar to the example shown below,  is 

displayed for you to analyze.  
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12 Target Engagement Profile App 

The Target Engagement Profile (TEP) app combines in vivo and in vitro data into a single, normalized graph 

corrected for plasma protein binding and calculates % inhibition over time.   

Note that the critical in vivo PK assays and the in vitro assays must be annotated in the Signals Data Factory (SDF) 

system as the TEP app will load this data to perform the analysis. There are three measurement type categories 

which should be defined in SDF as a prerequisite to running the TEP App. Refer to the section Defining a New 

Measurement Type.   

1. PKStudy: contains the in vivo PK parameters from the PK Parameters app, or another source 

2. PKDetail: contains the in vivo raw data (i.e. mass spec data) 

3. pb: contains the in vivo plasma protein binding data 

The in vitro and in vivo assays should be published to Signals Inventa. The in vitro assay Endpoint Unit is especially 

important to include when publishing. 

12.1  Accessing the Target Engagement Profile App 

The Target Engagement Profile App is available in the Signals Apps store which is accessed through the main Spotfire® 

Interface. 

To access the Target Engagement Profile App:  

In Spotfire Analyst Client: 

1. Select Tools > Signals Apps.   

2. The Workflows tab opens by default. Select the Apps tab. 
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To launch the app, click anywhere on the Target Engagement Profile App card and it will be added to the document 

using the default app settings. 

In Spotfire Web Player: 

1. Open data in Spotfire. 

2. Select Tools > Signals Apps.   

3. The Workflows tab opens by default. Select the Apps tab. 

4. To launch the app, click anywhere on the Target Engagement Profile App card and it will be added to the 

document using the default app settings. 

A Target Engagement Profile page is displayed, similar to the example shown below. By default, the app opens to the 

Configuration tab. 
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12.2  Configuration Tab 

In the Configuration tab the user can configure the source for the data types listed below. Mandatory fields contain an 

 or  icon until an entry is selected or matched, respectively. 

• Guided Mode – Enabled by default.  

• Project Name – A dropdown to select the project to be used by the Target Engagement Profile app. By 

default, the app opens with the project defined in the Spotfire® preference (if applicable). Refer to Setting the 

Signals Data Factory Project Name preference for more information. 

o Reload Data – this icon refreshes the project data and will pull updates from SDF, if applicable.  

• Compound Molecular Weight Attribute – A dropdown to select the compound/batch entity attribute that 

represents the molecular weight. This mapping is critical for unit conversion. 

Note: Both in vitro and in vivo measurement types must be associated with the same entity (either compound 

or batch, but not both compound and batches). 

• PK Parameters measurement type – A dropdown to select the PK parameters measurement type. All 

measurement types (compound and batch) that have been tagged with the measurement type category 

PKStudy will be displayed. If none have been tagged, no entries will be listed.  

o Select the plus-sign Add icon to open the Match Columns UI. Match columns from the Required 

attributes and  Available attributes lists then select Add items to match the two elements from both 

lists.  
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Note: The Available attributes displayed are the attributes associated with the selected PK Parameters 

measurement type. The Required attributes list contains the set of details that will be leveraged in the TEP 

App.  

Matched items can be removed by selecting the entry in the Matched items list, then Remove items. The 

following elements must be matched prior to selecting Save: 

▪ Animal ID 

▪ Cohort ID 

▪ Dose 

▪ Formulation 

▪ Route 

▪ Species 

▪ Study ID 

Strain may be optionally mapped. 

 

After selecting the Save button, the Configuration tab is updated with the matched columns. 
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• PK Details measurement type – A dropdown to select the PK details measurement type. All measurement 

types (compound and batch) that have been tagged with the measurement type category PKDetail will be 

displayed. If the PK Detail measurement type has already been configured as a detail measurement of the 

selected PK Parameters measurement type, the dropdown will automatically be set to the correct 

measurement type (recommended).  If none have been tagged, then no entries will be listed. Refer to the 

section Configuring a Measurement Type as Details of another Measurement Type.  

o Select the plus-sign Add icon to open the Match Columns UI. Match columns from the Required 

attributes and Available attributes lists then select Add items to match the two elements from both 

lists. Matched items can be removed by selecting the entry in the Matched items list, then Remove 

items. Note that the following elements must be matched prior to selecting Save: 

▪ Time 

▪ Concentration Value 

The attribute Concentration Unit may be optionally mapped. 

 

After selecting the Save button, the Configuration tab is updated with the matched columns. 
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o The checkbox Replace all empty or invalid values for ‘Concentration Unit’ with this user-provided value 

should be used in cases where an unsupported or no concentration unit has been specified and the user 

wishes to assign one of the supported units. These include g/L, mg/L, mg/mL, ug/mL, ng/mL, M, mM, uM, 

nM, pM, fM. 

Note: It is recommended that the user add a concentration unit column to their data and manually convert 

it to a supported concentration unit if one does not already exist. 

• Plasma Protein Binding measurement type (Optional) – A dropdown to select the Plasma Protein Binding 

measurement type to perform normalization. All measurement types (compound and batch) that have been 

tagged with the measurement type category Ppb will be displayed. If none have been tagged, then no entries 

will be listed. 

o Select the plus-sign Add icon to open the Match Columns UI. Match columns from the Required 

attributes and Available attributes lists and select Add items to match the two elements from both 

lists. Matched items can be removed by selecting the entry in the Matched items list, then Remove 

items. Note that the following elements must be matched prior to selecting Save: 

▪ % Bound 

▪ Species 
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After selecting the Save button, the Configuration tab is updated with the matched columns. 

 

• Limit the Plasma Protein Binding by this query (Optional) – A dropdown to select a saved Global Search 

query to limit the returned assays by a pre-defined criterion. Refer to the Saving a Global Search section for 

more information. Select the X icon to remove the selection, if desired. 

• Limit the Assay Endpoint Results based on this query (Optional) – A dropdown to select a saved Global 

Search query to limit the returned assays by a pre-defined criterion. Refer to the Saving a Global Search 

section for more information. Select the X icon to remove the selection, if desired. 

12.3  Analysis Tab 

Once the user has completed the settings in the Configuration tab, select the Analysis tab to complete the Compounds, 

PK Studies, and Assay Result steps. 

12.3.1 Compounds 

In the Compounds step the user can specify one or more Compound IDs and/or Compound Batch IDs using the following 

methods to filter the PK Parameters measurement type to include only the desired IDs: 
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• Select a SAR Compound Group – This dropdown menu contains previously defined SAR Compound 

Groups. Refer to the Groups section under the SAR Analysis App for more information. Select the + Add 

button to append the Compound IDs to a list in the textbox.  

o Refresh – This icon is available via the dropdown menu next to the + Add button and will refresh the 

selected SAR Compound Group from the Signals Data Factory. 

• Input Compound IDs or Batch IDs – This textbox allows users to manually input or copy/paste up to 2000 

IDs. 

 

 

Select Next to move on the PK Studies step. 

12.3.2 PK Studies 

In the PK Studies step the user can specify one or more PK studies to include for downstream analysis via a summary 

table displaying the critical factors mapped in the Configuration tab. To remove a PK Study from the analysis, uncheck 

the box corresponding to the desired entry. Use the Search box to filter on any table value or click the column header 

to sort by a column. 

Note: Only those PK studies with PK Detail level data and that are associated with the list of Compounds/Batches noted 

in the previous “Compounds” section will be displayed. 
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Select Next to move on the Assay Result step. 

12.3.3 Assay Result 

In the Assay Result step, the user can select the in vitro assays of interest. The displayed table consists of a list of 

endpoints that have been filtered by the previous two steps. Therefore, only those assay endpoints which have been 

tested with the compounds previously selected will be shown.  

Note: All assays associated with any batch of a previously selected compound will be displayed. 

Note: Endpoint units marked in red contain invalid units and will not be downloaded in the Assay Endpoint Results table. 

As such, the row containing the invalid endpoint unit is greyed out and cannot be included via the checkbox. To use this 

entry for downstream analysis, the user must manually convert the endpoint unit to one of the accepted units and then 

define the endpoint unit using the Managing Measurement Types Tool. 
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Note: In the above example, 4 of the 8 items will be downloaded to the Assay Endpoint Results table, as noted by the 

checkmark and black text. The remaining 4 items contain invalid endpoint units (highlighted in red text), the row has 

been greyed out and the checkbox cannot be enabled. 

Select Next to move to the Visualization tab. 

12.4  Visualizations Tab 

Once the user has completed the Analysis tab settings, the Visualization tab can be used to view and customize the 

Concentration – Time plot. The first time a user opens this tab no data will be loaded. To do so, select the Download 

or Refresh Data Tables button. This button may be used at any time to refresh the data tables from Signals Data 

Factory.  

Note: The tables must be refreshed any time criteria set in the Analysis tab has been changed. 

 

This tab contains the following options to customize the visualizations: 

• Select the In Vivo PK studies to visualize – This section is used to control the PK studies displayed on the 

Concentration – Time plot by selecting the corresponding checkbox next to the PK Study of interest. By 

default, all entries in the table are selected. 
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o Display individual animals – By default the results for multiple animals are averaged (box unchecked). 

By selecting this checkbox, the table and plot in the right-hand panel will update to include details at the 

animal level. 

o Search – This textbox is used to filter PK studies for easier selection / deselection based on any table 

value. Selecting the checkbox next to the header ‘Compound ID’ will select/deselect only those rows 

displayed in the current view. 

• Select the In Vitro Endpoints to visualize – This section is used to control the in vitro endpoints displayed 

on the Concentration – Time plot as a labelled horizontal line. Select the corresponding checkbox next to the 

endpoint of interest to add it to the plot. By default, no entries in the table are selected. If required, backend 

calculations are made such that the y-axis unit accurately represents the data. 

 

o Aggregate results across Compound Batches – By default different compound batches are displayed 

as individual endpoints (box unchecked). By selecting this checkbox, the table and plot in the right-hand 

panel will update to average endpoints using the same compound from different batches into a single 

endpoint.  

o Search – This textbox is used to filter in vitro endpoints for easier selection / deselection based on any 

table value. 

• Calculation options – This section provides options for instantly normalizing the data by including the 

selection of one of three radio buttons below, thus adjusting the Concentration – Time plot. Note that options 2 
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and 3 are only available if the Plasma Protein Binding measurement type was provided previously in the 

Configuration tab: 

1 Display raw PK Concentration values and raw Endpoint Results values (Default on) 

2 Adjust the Endpoint Results based on the Plasma Protein Binding  

3 Adjust the PK Concentration values based on the Plasma Protein Binding 

o Calculate additional ICxx values based on the Hill slope of 1 – This textbox can be used to enter a 

desired IC value (1-99) to extrapolate and display as a horizontal line on the Concentration – Time plot. 

Note that multiple IC values can be added and should be separated by a comma or a space. 

• Display options – The toggle can be used to adjust the axis of the plot to one of two options: 

o Display PK Concentration and IC50 cut lines (Default on) 

o Integrate IC50 and PK Concentration into % inhibition using the equation: 

% Inhibition = 100 / (1 + (10 ^ (Log10(Endpoint Result (ng/mL)) - Log10(Concentration (ng/mL))))) 

Note: The selected in vitro endpoints are not visible on the %Inhibition – Time plot, however by default 

a dotted line representing the IC50 is displayed, along with any ICxx values entered by the user. See 

example below where the IC20, IC50, and IC80 are displayed. 

 

 

o Error bars (Standard Deviation) – By default this setting is checked and displays the error bars for 

each data point in the Concentration – Time and %Inhibition – Time visualizations. 

 

o Individual data point labels – By default this setting is unchecked. When checked data points are 

added to the Concentration – Time and %Inhibition – Time visualizations. 

 

o Log Scale – By default this setting is unchecked. When checked the Concentration – Time 

visualization will be displayed in log scale for the y-axis. 
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13 Appendix A: Workflows 

A workflow is a formalization of both a set of Apps, their order of execution and their configuration. This concept allows 

the users to string several Apps together, run different types of analysis with the same app, create and maintain different 

variants of the same study, etc. 

This feature allows to easily share ideas and collaborate to improve them. To achieve it, a workflow can have a private 

visibility (when set to Draft) or public (when set to Published). Draft workflows can only be seen by their creator (and 

thus only them can edit or publish them), whereas Published workflows are visible and editable by all members of the 

group.  

Note: Only the original creator can set a workflow back to draft. 

Workflows are a key concept within Signals Apps and thus can be accessed directly from the Signals Apps homepage. 

Note: Certain apps may not support the use of multiple instances within the same document. 

The Workflows storage must be configured by a Spotfire administrator. 

13.1 Role Based Permissions 

Workflow management can be limited to specific users or groups of users by setting up roles using the Signals Apps 

Workflows Role - Admin and Signals Apps Workflows Role - Author licenses. By default, everyone has a consumer role, 

unless any of the aforementioned licenses are granted, in which case, the least restrictive of the granted licenses will 

apply (thus setting the role). 

When the user role does not allow a certain interaction, then the controls in the system will not be present. 

Action Roles 
 

Consumer Author Admin 

See and execute published owned Workflows ✓ ✓ ✓ 

See and execute draft owned Workflows ✓ ✓ ✓ 

See and execute published unowned Workflows ✓ ✓ ✓ 

See and execute draft unowned Workflows   ✓ 

See and execute Out-of-the-Box Workflows ✓ ✓ ✓ 

Add a new Workflow  ✓ ✓ 

Add a new Out-of-the-Box Workflow    

Delete an owned Workflow  ✓ ✓ 

Delete an Out-of-the-Box Workflow    

Edit an owned Workflow  ✓ ✓ 

Edit an Out-of-the-Box Workflow    

Clone an owned Workflow  ✓ ✓ 

Clone an Out-of-the-Box Workflow  ✓ ✓ 

Delete an unowned Workflow   ✓ 

Edit an unowned Workflow   ✓ 
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Clone an unowned Workflow  ✓ ✓ 

 

The optimal way of distributing licenses to a large number of users is to create groups and assign the users to the 

groups. That ensures that all users in a group are granted the same license.  

Signals Inventa provides a framework in which to create analysis Workflows that can be easily applied to different 

datasets provided these datasets follow the same structure as the ones used to design the Workflow. 

This framework can be used in three different manners that differentiate three clear user roles: 

• Consumer Role: A user that is not necessarily an expert in the use of Spotfire® and will typically be an expert 

in the field that will execute the analysis Workflow created by the author and interpret the results. They will not 

modify the Workflow although they may add additional downstream analysis steps using either Spotfire®, or 

other analysis Apps. Consumers have access to all published (non-draft) Workflows, but cannot add new 

Workflows or delete, edit, or clone existing Workflows. 

• Author Role: An expert Spotfire® user that understands the context of the analysis that needs to be performed 

and will create the standard analysis Workflows to be used by the Consumers. Authors have access to all 

published Workflows and their owned draft Workflows. Workflow authors can add new Workflows and are also 

able to delete and edit their owned Workflows. Lastly, they can clone any Workflow they have access to. 

• Admin Role: Admins have full access to draft or published Workflows and can create, delete, edit (except Out-

of-the-Box Workflows), or clone Workflows regardless of whether they own them. 

13.2 Creating a workflow 

This process will be performed by the author or admin roles.  

A Signals Inventa Workflow consists of a series of Apps that are executed consecutively to produce the desired 

analysis. Standard apps can be added one after another in the document by simply clicking on them in the Signals 

Apps page and following the steps required in the App to perform the corresponding analysis. In most cases, Aps are 

restricted to one instance per document. 

A workflow can be created using the + Create new workflow button on the top right area of the Signals Apps 

homepage within the Workflows tab. Also, when there are no available workflows, another Create a workflow button 

will appear in the center of the page. 
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When clicking on any of these buttons the user will be presented with an overlay to choose the workflow creation 

method. If the user wishes to cancel the creation, there’s an “x” button on the top right corner. 

This will display two different options for creating the workflow: 

• From Scratch: Select this if you would like to create a workflow in an empty document. 

• From Existing Document:  Select this option if you have a set of apps already present in the document that 

you would like to save as a workflow. 

 

13.2.1  Creating a workflow from scratch 

After choosing to create a workflow from scratch, an App selection screen will appear.  
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Apps can be filtered using the “Search” filter and added to the workflow simply by clicking on them. All added Apps will 

be shown on the panel available on the right side, which also provides controls to reorder or remove them from the 

workflow.  

The Discard button available at the top right corner of the app selection area cancels the creation process and returns 

the user to the homepage. Finally, at the bottom of the right panel there are two buttons: the Clear button removes all 

apps from the workflow and the Configuration button guides the user to the next step. 

After clicking on the Configuration button, the user will be able to navigate the workflow configuring each App in the 

process. At the end of the navigation and configuration process, clicking on the Summary & Save button of the workflow 

navigator will lead you to the last stage. 

In the last stage the user will have to provide a unique name, choose a (new or existing) category, write a description 

(optional) and choose whether the workflow will be saved as draft or be published. Once the user is ready, the blue 

Save button will save the workflow and the system will return to the homepage. Hitting the Cancel button will return the 

user to the homepage, discarding the workflow (a confirmation dialog will be shown to ensure nothing is accidentally 

lost). 

13.2.2  Creating a workflow from an existing document 

If the user has created an analysis workflow in the document using the different Apps, it can be saved in the App store 

by selecting the workflows tab and clicking on Save as workflow. 

After choosing to create a workflow from existing document, the last stage of the workflow creation process will be 

shown. 

Just like creating a workflow from scratch, the user will have to provide a unique name, choose a (new or existing) 

category, write a description (optional) and choose whether the workflow will be saved as draft or be published. Once 

the user is ready, the blue Save button will save the workflow and the system will return to the homepage. Hitting the 

Cancel button will return the user to the homepage, discarding the workflow (a confirmation dialog will be shown to 

ensure nothing is accidentally lost). 

It is important to understand that when creating a workflow from existing document, it is not necessary to navigate the 

workflow. This occurs because the apps from the document, their configuration and their order are used to create and 

configure the workflow. 

13.3 Workflow Navigation 

When navigating a workflow, the workflow navigator panel will be embedded in the app and will allow the user to 

navigate (forwards and backwards) the workflow while configuring and executing the apps. Since a workflow can be 

executed in edition mode (creating from scratch, editing, cloning), in those cases the last app will include a Summary 

& Save button that records the changes made through the execution of the workflow. During normal executions, for 

the first and last app, the Previous and Next buttons will be disabled accordingly. 

When moving forwards, the new apps’ pages will be added with all the settings configured to the same values as were 

used when initially saving the workflow. This allows the user to easily repeat the same type of analysis on different 

datasets with a minimum number of clicks. 
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Note: If a workflow contains one or more apps that do not support Web Player execution, then the workflow will not be 

supported in Web Player. 

If during an execution in edition mode the user attempts to return to the homepage, an overlay will be shown to ensure 

the user continues the execution or correctly cancel the process (acknowledging the loss of changes). 

 

13.4 Editing a Workflow 

The Workflow edition screen can be accessed through the More actions ‘…’ icon on the Workflow card controls, or 

from the Edit button at the bottom of the Workflow’s details panel. Note that this option is not available for Out-of-the-

Box Workflows. 

After choosing to edit a workflow, the system will navigate to the workflow edition screen. 

Similarly to creating a workflow from scratch, the user will be able to edit the unique name, choose a (new or existing) 

category, edit the description and choose whether the workflow will be saved as draft or be Published.  

The user can expand the Instructions area in the ‘Save Workflow’ area to add App specific instructions for each App 

in the Workflow. Once the user is ready, the blue save button will save the Workflow and the system will return to the 

homepage. Selecting Cancel will return the user to the homepage, discarding the changes made to the Workflow (a 

confirmation dialog will be shown to ensure nothing is accidentally lost). 

Also, the user can click the Configure Parameters button (located at the bottom of the right side panel) to execute the 

workflow in edition mode and reconfigure the App’s parameters. The right-hand side panel also contains other controls 

that allow the user to further customize the workflow. 

13.4.1  Parameter Locking 

Parameters can be locked to edition (this prevents modification of their configured values during later executions) by 

clicking the App, hovering over the desired parameter and clicking on the corresponding Lock icon. Note that the 

parameter locking is only supported for SDK based Apps. The Global Search App does not support parameter locking.  
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Signals Inventa App Support 
Parameters 

Support 
Parameter 
Locking 

Global Search   

SAR Analysis ✓ ✓ 

Publish Measurements  ✓ ✓ 

Assay Results Review ✓ ✓ 

Target Engagement Profile ✓ ✓ 

 

Note: Parameter Locking in Publish Measurements Apps  

1. When the "Mapping name" is locked, the data grid UI for editing the map content is also locked. 

2. Locking is done by disabling the UI components for the parameter, and the data model for the parameter is 

not locked. This means that a locked parameter may still be changed by other unlocked parameters 

depending on their relationship. For example, if the user locks "Mapping name", but does not lock the "Select 

Measurement Type", the "Mapping name" will be reset once the user changes "Select Measurement Type". In 

this case, user may need to also lock the "Select Measurement Type".  

13.5 Cloning a workflow 

The workflow cloning screen can be accessed through the workflow card controls or using the split button found at the 

bottom of the workflow’s details panel.  

After choosing to clone a workflow, the system will navigate to the workflow cloning screen. 

Just like creating a workflow from scratch, the user will have to provide a unique name, choose a (new or existing) 

category, write a description (optional) and choose whether the workflow will be saved as draft or be published. Of 

course, since the workflow is being cloned, these values will be provided by default using the original workflow as 

template. Once the user is ready, the blue Save button will save the workflow and the system will return to the 

homepage. Hitting the Cancel button will return the user to the homepage, discarding the workflow (a confirmation 

dialog will be shown to ensure nothing is accidentally lost). 

Also, the user can click the Configure Parameters button (located at the bottom of the right side panel) to execute the 

workflow in edition mode and reconfigure the App’s parameters. Refer to Workflow Navigation section. As expected, 

once the workflow is saved, a new cloned workflow will be available in the homepage. 

13.6 Deleting a workflow 

The Workflow deletion button can be accessed through the workflow card controls and will ask for confirmation to ensure 

the workflow is not accidentally deleted. Note that this option is not available for Out-of-the-Box Workflows. 
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13.7 Running a workflow 

Consumers can access those app workflows that have been created and stored in the app store by the authors and use 

them to perform complex analysis with a few simple clicks. 

To use an Apps workflow the consumer should follow these steps: 

• Have a dataset supported by the workflow available. This would be a dataset that has the equivalent 

columns/parameters to those that are needed in the workflow. 

• Choose the desired workflow. A workflow can be executed using the Execute workflow button (that has a 

“play” icon) available in the workflow card controls or using the Run button found at the bottom of the 

workflow’s details panel. 

• After clicking on either button, the workflow will be executed in normal mode (see Workflow navigation) and 

any changes made to the app’s configuration will only be present in the App’s pages corresponding to this 

specific workflow execution. 

• In the first step of the workflow the user will need to either input the data in one of the data entry apps, which 

will automatically match the required data fields to the workflow requirements or match the data explicitly with 

the required fields if the first step of the workflow is a Calculations Explorer App (Signals VitroVivo)  . 

• After the initial data is matched, navigation through the workflow can be easily done by clicking on the forward 

and back arrows to move through the different steps. Adding when needed any extra input from the user 

required for the analysis. 

13.7.1 Workflow Panel 

The Workflow panel allows the user to review all the Workflow’s details and perform certain actions. 

The Workflow panel can be accessed via the Show/hide workflow panel button located on the right-hand side of the 

Workflow navigator. The Workflow panel will appear on the right-hand side of the screen and its upper part will show the 

main information of the Workflow and its lower part will contain a list of the Apps that compose the workflow. Please 

note that: 

• The active App is highlighted in blue. 

• If any of the Apps’ parameters has been locked, the App will indicate it contains locked parameters by also 

displaying a lock next to it. 

The upper part of the Workflow panel will include an ellipsis (…) button with some available actions: 

• Generate report, which allows you to generate a pdf report of the Workflow execution. 

• Cancel Workflow, which allows the user to cancel the Workflow execution and close all its Apps’ tabs. 
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13.8 Workflow Reports 

The user can configure the report that the Workflow will generate and will be able to choose which Apps and data to 

include. This can be accessed by clicking on the Open Report Setup button found on the top right of the right-hand 

side panel, located next to Save workflow available during Workflow edition. Refer to Editing a Workflow. Any user can 

check the report settings in read only mode by opening a Workflow and selecting the      icon, followed by Report 

settings.  

The report can be generated using the “Generate report” button from the Workflow panel available during the execution 

of the Workflow. 

13.9 Workflow Instructions 

The user can work with the Workflow panel during the Workflow creation or edition phase to configure the instructions 

to be displayed in the Workflow panel (during use phase) and in the Workflow details sidebar (in the main Workflows 

page). 

 

A Workflow developer may edit the Workflow instructions by simply opening the Workflow panel, then navigating to the 

relevant App and finally opening the Workflow panel and expanding the Instructions section. Please note that the 

format entered for the instructions will be used to display them later. 
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13.10 Exporting Workflows 

To export Workflows, select the Settings dropdown (Cog Wheel icon) and Export workflows. The user may also hover 

over the lower right-hand corner of a Workflow card to reveal a white circle which will activate selection mode when 

selected. Note the user can expect the same behavior with the “List mode” view active. 

With the selection mode active, the user can select the Workflow(s) which they would like to export by selecting the 

corresponding Workflow card. Note the button with the text ‘2 SELECTED WORKFLOWS’, which displays the number 

of currently selected Workflow. Select the X next to the button to close the selection mode. 

Additionally, note the checkbox in the lower right-hand corner of the Workflow card which indicates the Workflow has 

been selected for exporting, and is shown in full color so that it can be easily differentiated from the unselected 

Workflows. 

If the user wants to see the Workflow details, select the information icon when hovering over a Workflow.  

When the user is ready to export the selected Workflow(s), select Export and a popup appears to save the Workflow(s) 

as a local .zip file with the generic file name “exported-worflows.zip”, by default. 

13.11 Importing Workflows 

To import Workflows, select the Settings dropdown (Cog Wheel icon) and Import workflows. 

An Open File dialog will appear, prompting users to navigate to and select a .json file with the Workflow definition or a 

.zip file containing one or more .json files with the Workflow definitions. Refer to Exporting Workflows for details on how 

to export Workflows. 

Select Open to import the Workflow(s). When the process is complete, the imported Workflows will appear in the 

Workflows page. 
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13.12 Synchronizing Workflows for Offline Usage 

If the user often works offline, it is in their best interest to keep the offline cache of Workflows synchronized. To do so, 

the user will have to select the Settings dropdown (Cog Wheel icon) located on the top right-hand corner of the Signals 

Apps page and select Sync workflows for offline usage. The system will then connect to the Spotfire® Library and 

synchronize all available Workflows.  

Note: This process might take a while and may be canceled in the displayed progress dialog. 

It is important to understand that the system will update the offline version of any Workflow interacted with, but there are 

certain cases (such as when configuring a system for the first time) that it will be useful to perform a full synchronization. 
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14 Appendix B: Signals Data Factory 

Signals Data Factory (SDF) is an infrastructural component which provides data transforming, indexing and query 

capabilities for Signals Inventa. After the measurement metadata has been correctly defined and measurement data is 

in Spotfire, you are able to publish the measurements into the Signals Data Factory  such that the measurement data 

can be transformed and indexed and then searched using complex queries in Signals Inventa’s  Global Search. 

The Signals Data Factory version can be identified from Help > About.  

14.1 Projects 

In the Signals Data Factory, data is organized by project. Before you can publish measurement data into the Signals 

Data Factory, a project needs to be created. 

To create a project: 

1. Log in to Signals Data Factory with username and password. 

2. From Data menu, click Projects. 

3. In the Projects page, in the upper-right corner of the project list, click Add Project button. 

 

4. In the Add Project dialog, choose a name for your project.  

 

5. A ‘Use original project type’ toggle is available for you to choose the project type. By default, this toggle is 

disabled and will create a V2 project type (incremental project) which includes load-new and datasets 
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functionality. You can create an original project type (V1) by clicking the slider bar which excludes load-new 

and dataset functionalities. Use this toggle to define the project type.  

6. Click on the Add Project button to append the Project to the Projects list. The Project Type will be listed as v1 

(original) or v2 on the Projects page.  

 

To convert a v1 (original) project to v2 (incremental project):  

If you have an original project (v1) that you want to convert to an incremental project (v2), you have the option to do 

this from the original project.  

1. From the Projects details page, select the ‘Clone Working Copy to v2 project’ sub-menu item  from the More 

drop-down menu.  

 

2. Enter a name for the v2 version of the project.  

 

3. Click the Clone to v2 button.  

The v2 version of the product be appended to the Projects list page.  
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14.2 V1 Projects 

14.2.1  Configuring Project Permissions  

Signals Data Factory also allows administrators to configure the permissions on projects, such that the projects can 

only be seen or be used by users belonging to specific groups. 

To configure the project permission for V1 project: 

1. Login Signals Data Factory with an administrator account. 

2. From Data menu, click Projects. 

3. In the project list, choose a project for which you want to configure the permission. This will open the project 

page. 

4. From the upper-right corner of the page, click Settings button. 

 

5. In the Project Settings pop-up dialog, specify the groups in the Groups with Write Access and Groups 

with Read Access text boxes. This grants the users under the specified group to have read or write 

permission on the current project. 

 

6. Click Save button to save the changes and close the dialog. 

Note: By default, only administrative users (i.e. users who have ROLE_ADMIN or ROLE_SUPERADMIN) can see all 

the projects in Signals Data Factory. Non-administrative users will not be able to see any of the projects unless they 

have been granted permissions for the projects. 
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14.2.2  Adding a File  

To add a new File to the project:  

1. Click Data > Projects. 

 

 

 

2. In the Projects page, click the name of the project to which you want to add a file.  

3. In the Project Details page, click the Add File button in the upper-right corner of the Files list. 

 

4. In the Upload Files to Project dialog, either drag-and-drop the file into the dashed rectangle or click on the 

rectangle to choose the file to be uploaded 

 

 
 

Note: Only text files in tabular format, such as comma-separated values (CSV), tab-separated values (TSV) are 

supported in Signals Inventa.  

5. After the file has been added to the project, it will be displayed in the Files grid. 
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For information on adding attachments to projects, refer to Attachments section.  

 

If viewing a published version of a project, you will note that two additional tables are available: Concepts and Import 

Errors.  

 

The Concepts tab allows you to verify the name of the source ontology file and the concept version being used. For 

further information on concepts, refer to the Ontologies section.  

The errors which occur while importing file(s) can be tracked within the Import Errors tab. These errors may be file(s) 

specific. 

6. To map the source details with the target entities, click the Not Mapped link.  

7. The Map Details page is displayed.  
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Note: To map source columns with the target entities, and for mapping details, refer to Mapping section.  

14.2.3 Import from SQL 

It is also possible to add files to a project using an External Connection rather than uploading files themselves.  

Note: For more information on external connections, refer to the Connections – External Connection section.  

1. In the Project’s page, choose Import from SQL.  

 

2. In the Import from SQL Data Source window, select the pre-configured connection and assign  a name to 

the data being added. 
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3. In the Query box, enter the SQL to run. 

Note: To see advanced settings, refer to the Advanced Settings topic.  

4. Once the settings are defined, click Materialize and it will materialize the results of the query and stage them 

as a file, which can then be mapped in the normal way.  

 
Note: For more information on mapping, refer to the Mapping section.  

 14.2.3.1  Materialization Process  

When the details for SQL retrieval are saved, a new process is started to materialize the results of the query.  

Any modifications to the settings to the SQL retrieval will also begin a new materialization process. 

An active materialization will be indicated with a spinner alongside the file.  

If there be any issues/errors in this process, the spinner will be replaced with a ! Icon, which can be clicked to view the 

output log and diagnose the problem (there is also a shortcut to the log in the Actions column). 

If an import job is started before materialization is complete, then a failed materialization will result in a failed import 

(and any dependent publish jobs). 

 14.2.3.2  Advanced Settings 

For larger datasets it is possible to tune the retrieval mechanism via the ‘Advanced Settings’ option.  
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Here you can specify 

• Custom Schema: can be used to override column types when Spark misinterprets the connected data. A 

comma separated list of column names (from the SQL definition) and desired data type, e.g.  

             ‘Sample ID’ LONG, Age INTEGER  

Common target data types are  

o INTEGER  

o LONG  

o DOUBLE  

o STRING  

Note: The datatype must be in CAPS. 

• Partition Settings (if used, all of the settings are required) 

 

When provided with a partition column along with an estimated lower and upper value, Signals Data Factory 

will split the data according to the number partitions requested and run these queries in parallel. This can 

result in significant performance improvements when materializing the data for large datasets. 

 

o Number of Partitions:  The number of queries to run in parallel 

o Partition Column: A numeric or date column to use to split the query into multiple parts. 

o Estimated Lower Bound:  An estimate of the lower bound of the partition columns’ values 

o Estimated Upper Bound: An estimate of the upper bound of the partition columns’ values 
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14.2.4 Attachments 

Using attachments, you can attach various file formats to the working copy of a project without any mapping 

requirements. Attachments can be in any file format (PDF, DOC, XLS, JPG, etc.) and behave as part of the project.  

After publishing a project, an attachment must be downloaded to make an update; the attachments are not manageable 

from within the Signals Data Factory interface.  

To add attachments: 

1. In the Project’s page, select a working copy of the project.  

2. From the Attachments tab, select the + Add Attachments button. 

 

 
 

3. In the Upload Attachments to Project dialog, either drag-and-drop the file into the dashed rectangle or click 

on the rectangle to choose the attachment to be uploaded.  

 

4. Click Done.  
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5. The attachment is appended to the Attachments grid.  

6. If you want to edit label of an attachment, select the attachment file and click the Set Label button.    

 

7. Edit the label that you want to give to the selected files and click Save Label.  

14.3 V2 Projects 

14.3.1  Configuring Project Permissions 

Signals Data Factory also allows administrators to configure the permissions on projects, such that the projects can 

only be seen or be used by users belonging to specific groups. 

To configure the project permission for V2 project: 

1. Login Signals Data Factory with an administrator account. 

2. From Data menu, click Projects. 

3. In the project list, choose a project for which you want to configure the permission. This will open the project 

page. 

4. From the upper-right corner of the project summary panel, click the ellipse icon, then in the drop-down menu, 

click Permissions 
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5. In the Project Permissions pop-up dialog, specify the groups in the Groups with Write Access and Groups 

with Read Access text boxes. This grants the users under the specified group to have read or write 

permission on the current project. 

 

6. Click Save Changes button to save the changes and close the dialog. 

Note: By default, only administrative users (i.e. users who have ROLE_ADMIN or ROLE_SUPERADMIN) can see all 

the projects in Signals Data Factory. Non-administrative users will not be able to see any of the projects unless they 

have been granted permissions for the projects. 

14.3.2  Adding Datasets, Files and SQL Files 

On the Project details page for an incremental project (v2), there is the option to Add Dataset, Add File and Add SQL 

File from the Add Dataset drop-down button.  
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To create a dataset:  

1. Click on the Add Dataset button.  

 

2. Enter a Dataset Name.  

3. Drag ‘n’ drop files or click to select files.  

4. Click on the Create dataset and upload files button.  

To add files to a dataset:  

1. Select the data from the Dataset list to which you want to add file(s).  

2. Click on the Add File menu from the Add Dataset drop-down button to open the Add file window.   

3. Drag ‘n’ drop files or click to select files.  

4. Click Close.   
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To import from SQL to dataset: 

1. Select the data from the Dataset list to which you want to import SQL file(s).  

2. Click on the Import from SQL menu from the Add Dataset drop-down button to open the  Import from SQL 

window.  

 

Refer to the section ‘Import from SQL’ for v1 projects for information on defining the primary optins and advanced 

settings as well as materialization.  

14.3.3  Attachments 

Using attachments, you can attach various file formats to the working copy of a project without any mapping 

requirements. Attachments can be in any file format (PDF, DOC, XLS, JPG, etc.) and behave as part of the project.  

After publishing a project, an attachment must be downloaded to make an update; the attachments are not manageable 

from within the Signals Data Factory interface.  

Refer to the section ‘Attachments’ for v1 projects for more information. 
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14.3.4  Mapping Incremental Projects 

  

The <click to map> link exists in several places on the Project details page. Clicking on any of these links will display 

the mapping page. The mapping workflow is the same for v1 and v2 (incremental) projects. Refer to the Mapping 

section for further information.  

14.3.5  Details of a Dataset 

Selecting a dataset displays the details of the dataset in a separate panel. From here, you can add new files to a 

dataset, delete files from a dataset, modify file properties, apply file properties to all files in a dataset at once, 

download a file from a dataset, navigate to the warnings page if applicable, and navigate to the dataset mapping page.  
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14.3.6  Loading a Dataset 

When mapping is complete, you have the option to Load, Load All or Load New (depending on the state of the 

project).  

Loading will automatically Load New if it can and  Load All if it can’t.  

Clicking Load All will re-process all data in the project. Clicking Load New will only re-process those datasets that are 

new, modified or deleted. If the project does not contain new, modified or deleted datasets, the Load New option is not 

available. You can override the system by clicking Load All.  

If applicable, hovering over the icon will display load notifications. For example, Load New is not available for the 

following reasons: 

• The project contains no new, modified or deleted datasets 

• The Information design has changed (e.g an attribute has changed, and therefore you will be forced to Load 

All) 

• The project has datasets that are not replacable   

• You cannot load an empty dataset  

 

 

14.3.7  Replaceable Datasets 

It is possible to replace most loaded datasets after modifying data and/or maps without reloading the entire project. 

This is automatic when loading or via Load New. This allows an individual dataset (set of files) to be modified and 

reprocessed as a distinct set of data.  

A dataset is replaceable if it does not map any entity (batch, compound) attributes. This is because the same batch 

attributes may be updated earlier or later in the list and therefore you cannot guarantee the results if they are loaded 

out of order.  

The Replaceable Status for the selected dataset is indicated in the details section for the dataset.  Also, the 

Compound and Batch are entities in brackets (Entities column)  if there are no entity attributes mapped indicating that 

the dataset is replaceable. The brackets mean you are referencing the entity but not updating it.  
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If brackets are not present, then that means compound and/or  batch attributes are mapped and the dataset is not 

replaceable.   

 

   

14.3.8  Project Details 

The Project Details displays the Project Revision and the Load Status. If there is an error when loading, a link is 

available for you to click on to see the job log.  

The Project Details page includes a quick filter/status for datasets that are ‘Loaded’, ‘Not Loaded’, ‘Not Mapped’, 

‘Empty’, ‘With Warnings’ or ‘Deleted’. This allows you to quickly locate datasets of interest (for example, datasets with 

warnings) without having to page through all datasets.  

 

 

The Project Details page displays the sizes of datasets and individual file.   
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Note: You can define the columns visible in the Datasets list by clicking on the  View Columns icon. From here, 

you can specify the columns to display.  

 

If you choose to show the Filenames column, only the first three files will be displayed along with an indicator of the 

total number of total files.  

Note: The ‘Publish’ option does not exist for incremental projects as both Load options will also push the data to 

Search.  
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14.4 Mapping 

14.4.1 Manual Mapping 

After batch data has been uploaded to the project either by adding a tabular text file or importing from SQL, it is necessary 

to map the source details with the target entities.  

To map columns manually: 

1. In the Project’s page, click the click to map link.  

 

 

2. The Map Details page is displayed.  

 

 

Note: It is mandatory to select the measurement type before initiating manual mapping of Measurement related columns 

(attributes). 
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3. Enter name and description for the map. A name must be supplied to save the map.  

4. Select the Measurement Type. The Measurement Set field is enabled with the relevant measurement set 

details. For example, in the Target Entities area, the Set and Row data fields are enabled. 

   

5. Select a file column heading on the left-hand pane and click on the target column heading to map.  

6. The columns appear selected with a green checkmark indicating that the source and target columns are 

mapped.   
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Note:  The Target Entities displayed here are created from within Information Design > Entities and Attributes. 

These attributes work differently based on the data type.  

Note: For more information about adding Entity Attributes, refer the Entities and Attributes topic of the document.   

7. Click Save In Progress Map to save the mapping details. 

8. After mapping, click Add File to Project.  The mapped file is be added to the project’s list.  

 

14.4.1.1 Create Columns  

Using the ‘Create Columns’ feature, it is possible to create different column types for use when mapping source columns 

to target entities.  

 

Note: If a selected column is already created, you will not be permitted to re-create the same column. 

Create Template Column 

Using ‘Create Template Column’, you can build a column value which includes one or more columns (irrespective of the 

order) of the source columns into a single column. This column can be used to map to a target entity. 
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 To create a Template column: 

1. Select Create Column > Create Template Column.  

2. Select columns to combine from the drop-down list. 

 
 

3. Click Create. The Template column is created in the source columns list as follows. 

For example, 

 

Note: These columns are separated as per the character set in the Data Handling Settings. For more information, refer 

to the Data Handling Settings section.  

Create Duplicate Column 

Using the ‘Duplicate Columns’ feature, it is possible to duplicate source columns. 

To create a duplicate column: 

1. Select Create Column > Create Duplicate Column.  

2. Select a column from the drop-down list. 

 

3. Click Create. The duplicated column is created in the Source columns list.  



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 289 of 366 

  

 

Create Fixed Value Column 

Using ‘Create Fixed Value Column’, you can create a column with a fixed value to be used when mapping a source 

column that is missing from the project. If mapped to a target entity, each value of the target column is replaced with the 

fixed value column. 

To create a fixed value column: 

1. Select +Create Column > Create Fixed Value Column.  

2. Enter value for fixed column.   

3. Click Create. A Fixed Value Column is appended to the Source Column list and can be mapped to a target 

entity. 

 

Create Split Column 

You can build a new column by splitting an existing column using a user specified delimiter or multiple characters of that 

column.  

To create split column: 

1. Select +Create Column > Create Split Column.  
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2. Select the column to split (e.g. 1-23-2018). The column preview is displayed.  

3. Enter delimiter to separate selected column  

4. Enter part (integer value) to split the column,  

5. Click Create to create new column.  

 

Create Regular Expression Column 

You can build a new column by executing a regular expression replace from a user defined regular expression.  

Regular Expression Column allows the user to input a search and replace pattern that will be executed on the string 

value of a field to produce a new column.   

To create regular expression column:  

1. Click the +Create Column > Create Regular Expression Column. 
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2. Select a column to use as the input for the regular expression.  

3. Enter a Regular Expression.   

 

Note: More information on the format of Regular Expressions search patterns is available here: 
https://docs.oracle.com/javase/8/docs/api/java/util/regex/Pattern.html 
 

4. You can optionally choose to ‘Replace First’, or ‘Replace All’ matching patterns. You can choose to Ignore 

Case when matching the pattern.  
5. In the Replace with… field, you can enter a numeric or string value that will replace the first value of the 

matching (or all values if selected) pattern. 

  
Note: Leaving the Replace with field blank will result in the match(es) being deleted from the source value. 

 
6. Click Create to create new column.   

 

Create Data Location Column 

You can build a new column from the location of the data being read.  

To create Data Location Column: 

1. Click the +Create Column button and choose Create Data Location Column.    

https://docs.oracle.com/javase/8/docs/api/java/util/regex/Pattern.html
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2. Select the elements to be included in this column.  

This locator can be used to generate unique values relating to the source location of the data (e.g. for use when 

generating a unique identifier). 

• File and Row Index will generate unique values according to which file in the project and/or which row in the 

file the data came from. 

• Pivot index will always be ‘0’, unless the depivot option is used in the mapping, in which case the index of the 

depivoted item will be used (starting at 1). 

• The filename of the source data can be included. 

One or more of these values can be added, and a separator can be specified to be used when concatenating multiple 

values. 

Create Depivot Columns 

To create Depivot Columns: 

1. Select +Create Column > Create Depivot Column.  

2. Select the source columns to pivot. The columns will be collapsed into ‘Pivot Header’ and ‘Pivot Data’ columns 

on the source columns table which you can then map to a target entity.  
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3. Select a measurement attribute from the dropdown list to store the pivoted headers. 

4. Select a measurement attribute from the dropdown list to store the pivoted data. 

 

You much select at least one source column. In addition, the pivot header and pivot target attributes must be selected 

and cannot be the same atttribute.  

5. Click Apply.   

Using the Modify Depivot Columns menu item, you can modify the Pivot Source Data.  
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14.4.2 Auto Mapping 

Automapping allows you to automatically map source and target columns with the same name.  

To auto map column headers: 

1. From the Map Details page for a project, click Auto-Map to map source columns with target columns.   

 

2. Click Filter to filter the mapped or unmapped columns.  

 

3. Click Save In Progress Map to save the auto mapped entities. 

14.4.3 Load Map 

The Load Map feature loads a previously configured used map to create mappings between source and target columns.  

To load a map: 

1. From the Map Details page for a project, click Load Map to load a previously created and saved map to the 

project.    

 

By default, ony maps that are compatible with the current file and its available source columns will be displayed. To view 

all available maps, de-select the ‘Only Compatible Maps’ checkbox.  

For a map to be compatible with a file: 
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• Any columns mapped to an ID in the map must be found in the source file currently being mapped.  

• All de-pivot columns referenced by the map must be found. 

• If a measurment type is referenced, at least one column mapped to a measurement attribute must be found.  

A Preview Map Load indicates the options and mapping that will be applied if the selected map is applied.  

 

2. To load a different map, click on the Select Different Map button.  

3. Once satisfied with the map selection, click Apply Preview, to load the selected map details to the project.  

4. Click Save in Progress Map to save the mapping updates. 

In certain cases, the selected map cannot be precisely applied to the project. This can occur if the project is missing 

columns referred to by the map, or the map is using advanced mapping features.   
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If this situation, you can choose to apply this map using the previewed interpretation, select a different map or load the 

map in advanced mode.  

If you choose to apply the selected map, you may lose some advanced mapping options if applicable.  

Note: For more details on the Advanced Mapping feature, refer to the Advanced Mode topic of the document. 

14.4.4 File  Settings 

The Signals Data Factory supports UTF-8 encoding format therefore imported data formats or symbols must be 

converted to UTF-8 format using an external program.  

To configure file settings: 

1. From the Map Details page for a project, click on the File Settings link.  

The File Settings dialog allows you to define the data source type and, file parse settings and immediately preview the 

changes.  



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 297 of 366 

  

 

2. For Excel files, you can specify the Worksheet to load and, if required, a range offset for the data location.  

 

 

• Worksheet Name (optional) – by default the first Worksheet is loaded. 

• Worksheet Range (optional) - it can be used to offset the start position by specifying the start cell of the 

header row. Note that a cell specification is the required input for this field (e.g., D6). 

3. Click Save.  
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14.4.5 Data Handling Settings 

1. From the Map Details page for a project, click Data Handling Settings link to verify the data settings. 

 

 

2. The Data Handling Settings screen allows you to specify values in the file to be ignored and therefore to be 

interpreted as a null value.    

 

 

3. Click Apply. You can choose to use default values by clicking Use Default Values.  

14.4.6 Advanced Mode 

Some mapping features cannot be displayed or configured using the standard mapping interface. 

When editing a map that uses advanced mapping features, an advanced mode interface allows you to edit the JSON 

document representing the map.  

To edit a map using the Advanced Mode feature: 

1. From the Map Details page for a project, click on the Advanced Mode button.  
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You will be notified that entering Advanced Mapping Mode allows you to edit the map as JSON but may result in maps 

that cannot be represented in the standard mapping mode and therefore standard mapping may not be available for this 

map.  

 

Clicking Proceed – Enter Advanced Mapping Mode will open the Advanced Mapping page, similar to the example 

shown below.  
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It is possible to switch between the Advanced Mapping Mode and the Basic Mode, however some of the advanced 

mapping features may be lost.  

An example of an advanced mapping feature is the Advanced Depivot feature. Using the standard mapping interface, it 

is not possible to group multiple columns when depivoting, however this operation can be performed editing the JSON 

in the Advanced Mapping Mode. 

14.4.7  Downloading a Map 

1. From the Data drop-down list box, select Maps. 

2. From the Download tab, select Show Unnamed Maps and /or Show All Map Versions to view unnamed 

maps  and/or all map versions.  

 

3. Click on a map to download it. 

14.4.8  Uploading a Map 

1. From the Data drop-down list box, select Maps 

2. From the Upload, select one or more maps to upload.   

 

3. Click Upload Map.  
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14.5 Information Design 

14.5.1  Entities and Attributes 

There is a single unified page that allows you to manage entity and measurement attributes.     

1. Navigate to Information Design > Entities and Attributes.   

 

The Attributes page is single page application for querying, adding, editing and deleting entity and measurement 

attributes. For example, from within the Compound and Batch tabs, you can manage the entity attributes. From the 

Measurement tab, you can manage the measurement attributes.  
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The table lists all currently defined attributes for the selected entity or measurement. Each row represents an attribute 

template. From the table, attributes can be edited or deleted. 

Note: You can enter a query string in the text box located above the table on the right-hand side to filter the attributes 

in the table. 

14.5.1.1  Defining a New Entity or Measurement Attribute 

To add a new attribute:  

1. Select entity or measurement tab to which you want to add a new attribute.  

2. Click the NEW button to add a new row to the top of the table  

 

 

3. Enter a unique Attribute Name in the Name field. .  

4. Select the Data Type from the drop down list.  An optional description can be entered.  By default, the attribute 

is Searchable.  

5. Click SAVE. You will be notified if the attribute fails to save.  

6. Repeats steps 1-4 to add additional attributes.    
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 14.5.1.2  Editing an Existing Attribute 

To edit an attribute: 

1. Click the EDIT button for the attribute you want to edit. .  

2. Make the necessary modifications.  

3. Click SAVE.  

14.5.1.3  Deleting an Attribute 

To delete an attribute: 

1. Hover the mouse over the attribute to delete. An   icon appears in the last column for that row.  

2. Click the   icon. The attribute is deleted. 

NOTE: Signals Data Factory also provides the features and user interface components for managing measurement 

types, and attributes. However, these are general features that support common scientific data transformation use 

cases. With the exception of Compound/Batch attribute management, it is strongly recommended you use the 

measurement type and attributes management features in Signals Inventa to accomplish information design, as the 

features in Signals Inventa may provide you advanced capabilities such as assay endpoint mapping definition, guided 

measurement type creation, etc. 

 14.5.1.4  Custom Entities 

Signals Data Factory supports the addition of custom entities (or related entities). Related entities are an optional feature 

in Signals Inventa. They allow you to associate entity tables to your core entity (e.g. Compound, Batch) tables and then 

leverage those relationships while querying data.  

The following section describes creating custom entities and relationships in Signals Data Factory.  

A custom entity does not have a parent/child relationship (i.e. it is not a core entity), but it does have some relationship 

to a core entity (e.g. Compound, Batch). Often there is more information that is related to a core entity. Custom entities 

allow you to have another table (entity) in the system that describes the custom entity.  

Adding Custom Entities 

1. From the main tool bar, select Information Design > Entities and Attributes > Add+. 

2. Enter the desired Entity name. Click on the Create button. The custom entity will be added as a tab next to the 

core entities. 
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3. Select the tab with the newly added custom entity and click on the  button. A new entry will be added as a 

row (column in the table). Enter the desired attribute Name, Data Type, Searchable, Description, then click on 

the Save button. Continue to add attributes as desired. 

 

Now there is a Custom Entity table that can relate to a core entity table.  

Defining Relationships and Dynamic Joins 

Relationships between core entities and custom entities are defined from the core entity menus.  

1. Signals Inventa only supports relationships defined on core entities (Compound, Batch). From the main tool 

bar, select Information Design > Entities and Attributes, then the desired core entity (e.g. Compound).  

Signals Inventa only supports relationships between core tables (Compounds and Batches) and custom entity 

tables.  

Note: The user may need to add the desired attribute to the core entity which will be linked to the custom entity if it 

does not already exist. 

2. Select the Relationships tab >  button.   

 

The Core Entity (e.g. Compound) Relationship window opens.  
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3. Specify a unique Relationship Name. Select the target entity (e.g. Molecular Target) from the ‘Compound links 

to’ dropdown list. The relationship can exist within its own project or globally. In the case that you want to load 

your custom entities in a different project, you would need to link  ‘Globally’ here. By default, ‘Within its own 

project’ is selected.  

4. The textboxes allow you to describe the relationship in more detail to drive the query capabilities in Signals 

Inventa. For example, you can add an adjective (e.g. primary). This is useful when two relationships are linked 

to the same custom entity. This allows you to define the relationship in more detail, for example primary target 

and secondary target. These descriptions will drive the Global Search interface when you are doing queries in 

Signals Inventa and therefore it is important to describe the relationship. However, this is optional and can 

simply be left as ‘a’.  

5. The Join on dropdown menus allows the user to define what columns you are going to join. The first 

dropdown is the list of columns from the core entity (e.g. Compound) table. The link source attribute must 

exist. The second dropdown is the list of columns from the custom entity (e.g. Molecular Target) table. Select 

Create Relationship to save the settings and close the menu.  
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Note: It is recommended that the second attribute to be linked is unique (i.e. $$*attribute*ID). 

Note: Composite joins can be created by adding additional joins via the  button. This describes one way to join 

where all items must match to be returned in a query. 

Individual relationships can be edited or deleted via the Edit and Delete buttons under Actions in the table. 

 

Custom Entities in Global Search 

1. Custom entities can be added as a table and mapped in the same way that core entities are and can be 

viewed in Signals Inventa’s Global Search via the Entity Condition tag. Refer to the Global Search section for 

more details using custom entities in Global Search.   
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2. Select the  icon > Add Condition, then select the desired relationship in the <enter a value> dropdown. 

Continue to add conditions as desired.   

 

3. Select the arrow next to Download these results to view additional options.  

 

4. The user can select the desired related entities from the Select attributes for download menu. 
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Refer to the Search by Related Entity section for more information on custom entities in Global Search.  

14.5.2   Measurement Types 

Measurement Types are a category of similar measurements and are managed on the Measurement Types page. 

From this page, you can define and  manage measurement types. 

To access the Measurement Types page: 

1. From the Information Design drop-down list box, select Measurement Types. 

The Measurement Types page opens, similar to the example shown below. 
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From the Measurement Types page you can define new measurement types or manage existing ones.  

Note: Do NOT delete the ‘Assay Endpoint Results’ measurement type. This measurement type is added by Signals 

Inventa and required for functionality (e.g. Global Search hierarchy display, SAR table generation, endpoint management, 

etc) to work properly.  

Measurement attributes can be added or removed, applicable entities specified, privileges for accessing the sensitive 

measurement type data can be defined.  

The table lists all currently defined measurement attributes for the selected measurement type. Each row represents 

an attribute template.  

14.5.2.1  Add Measurement Types 

To add a new measurement type:  

1. Click the +Measurement Type button. 

2. The Create Measurement Type page opens similar to the example shown below.  
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Note: Within Signals Data Factory, there are some symbols which should not be used when specifying names 

especially in the case of Measurement Types and Attributes. Refer to Signals Data Factory Restricted Characters.  

3. Enter a unique name and optional description.   

4. The Measurement Type requires Entity Rules. Click ‘Click to change’ to add entity rules. The Entity Rules 

screen appears. 

 

 

Note: At least one entity must be selected. Also, measurements associated with Groups cannot be associated with any 

other entity. 

5. Select the types of entities to be contained in the measurement type and click Apply. 

6. Optionally, specify security settings (defining who can view/search and download the measurement type. 

  

Note: For more information. refer to the Measurement Types - Security Settings section. 

7. Click the Save button.  

 

14.5.2.2 Measurement Type – Security Settings  

By default, there are no restrictions on who can view, search or download data for specific measurement types. 

However, it is possible to restrict both the visibility and downloadability of a measurement type independently. 

Note: These restrictions do not apply to Administrators, who will always be able to view/download all data. 

To apply restrictions for a measurement: 

1. Click the Click to change link, you can grant access rights to groups. 
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2. From the Measurement Type Permissions page, you can define which groups have access to the 

measurement type.  

 

 

3. There are 2 settings that can be controlled. View/Search and Download. 

• In the View/Search setting, if no group is selected then everyone can view/search the measurement type 

details. Selecting one or more group(s) in this field means that you have restricted the view/search permission 

to users that are members of any of the selected groups. 

• In the Download setting, it is possible to restrict the download of the measurement type. This will not impact 

any user’s ability to View/Search the measurement type (unless specified above).  

Note: Restricting View/Search will disable download of the measurement type for all users. To re-enable download, it 

is necessary to assign a group to the download setting. To download in this situation, users must be a member of a 

group assigned View/Search permissions and a group assigned Download permissions – this does not have to be the 

same group. (i.e. they must be able to View/Search in order to be able to Download). 

4. Click the Save button. 

Note: Download permission for a measurement type is required to perform any of the following functions: 

• Map new files to the measurement type, or change maps for files already mapped to the measurement type 

(including, on the file mapping page, loading a map associated with that measurement type) 

• Download or preview the measurement type’s data directly from the Project details page.  

• Download the measurement type from a completed export (this does not restrict you from including the data in 

an export). 
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14.5.2.3  Derived Data 

In some circumstances, if can be beneficial to store a measurement type in 2 formats. For example, data may be 

presented in both a short-wide and a tall-skinny format.  

Consider a case where a measurement type contains multiple endpoints. 

 

It may be desirable to also store the data in a different (in this case de-pivoted) format, e.g.: 

 

Measurement types support the specification of derived data – in the form of a map applied to the measurement type 

itself. This map would be applied whenever data is loaded into that measurement type, enabling you to populate two 

measurement types from a single file…e.g. File → IC50 → Endpoints. 

To implement this for a measurement type, choose to change the setting for the derived data: 

 

The mapping screen will appear, allowing you to use the full mapping functionality to map data from the source 

measurement type into another (you cannot map to the same measurement type!) 

Once a measurement type is configured to generate derived data, when used in a project, the derived measurement 

type will appear as an additional row alongside any files mapped to that measurement type: 
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Note: These additional rows are displayed for information only – no actions are available here. 

14.5.2.4  Measurement Type Attributes 

To add attributes to measurement types: 

1. From the Measurement Types page or in the Create Measurement Types page, click + Attribute button. 

The Add Attribute to Measurement Type dialog is displayed.  

 

From here, you can select an existing attribute to associate with the measurement type or create a new attribute. 

a) From the drop-down list box, select an existing attribute directly or type to search for an existing attribute and 

then click the Add New Attribute button to add the selected attribute to the measurement type. 

b) To create a new attribute, type a new attribute name to display the Create New Attribute option, similar to the 

example shown below, and then click Add New Attribute button.  

 

Note: Within Signals Data Factory, there are some symbols which should not be used when specifying names 

especially in the case of Measurement Types and Attributes. Refer to Signals Data Factory Restricted Characters.  

Note: The attributes that have already been added to the measurement type will not be shown in the   drop-down list 

box. 

To edit an attribute: 

1. Click the cell to edit.  

2. Make the necessary modifications.  

3. Click Save.  

To delete an attribute: 

1. Hover the mouse over the attribute to delete. An   icon appears in the last column for that row.  
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2. Click the   icon. The attribute is deleted. 

14.5.3  Import/Export 

There is a single unified page that allows you to import/export entities and measurement types. 

1. Navigate to Information Design > Import / Export.  

Under the Export tab, you can export the entire system (all entities and measurement types) or selectively choose 

which entities and measurement types to in include in the export. 

 

The number of attributes for each entity and measurement type is displayed.  

Under the Entities list, Sample and Group are not used by Signals Inventa. Measurement is the measurement 

attributes. You can export all attributes that are stored for measurements. When exporting the full Measurement set,  it 

will include all measurement attributes whether they are used or not.  

You can also export a measurement type which will export an information design that will create the measurement 

type and all the attributes that it uses.  

For example in the export page shown above, of the 137 measurement attributes, 8 of them are used in the a42 Cell 

HeLa HSP27 IC50 measurement type.  

Clicking the Export button will generate an information design export file (*.csv) and download it to your local system 

from which you can view the information that has been exported.   

Under the Import tab, you can drag and drop an  Information Design File (*.csv), or click to browse for the file that you 

have generated using the Export functionality.   
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A preview is displayed showing the entities and measurement types contained in the file and their associated action, 

attributes and warnings.   

The example shown below illustrates a full export file. 

 

Although there are no changes to the attributes in the example shown here, the Action for the measurement type is 

listed as ‘Update’ because when you are importing a measurement type, you are not just associating its attributes, a 

measurement type has other setting associated with it. For example which entities it can link to, secondary maps, 

security on the measurement type could be updated for this measurement type.  
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In the example shown abovre, if you choose to import this file, it will create a new measurement type (e.g. IC50) with 6 

attributes.  

At the same time, it will import the attributes for that measurement type. In the example above, there are 6 attributes 

for the new measurement type, and in this case, all 6 are new.  

In the example shown below, the measurement type (e.g. IC50) is already in the system and is going to have 6 

attributes, and the action will be to update one of them. You can also see there are 6 measurement attributes and one 

is being updated. One attribute is being changed in some way by this import, for example, the data type may be 

changing from text to a keyword.  

It is important to verify what consequences updating an existing attribute may have as it could be affecting other 

measurement types as well.  

 

 

 

From here, you can select the entities and measurement types to import into your system.  

Clicking the Import button will import the file into the system.  
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14.5.4  Inventa Configuration 

Signals Data Factory also provides the features and user interface components for managing measurement types, 

attributes and maps. However, these are general features that support common scientific data transformation use 

cases. With the exception of Compound/Batch attribute management, it is strongly recommended you use the 

measurement type, attributes and maps management features in Signals Inventa to accomplish information design, as 

the features in Signals Inventa may provide you advanced capabilities such as assay endpoint mapping definition, 

guided measurement type creation, etc.  

To access the Signals Inventa configuration for measurement types, attributes and maps, select the Inventa 

Configuration sub-menu from Information Design in Signals Data Factory. Once you have been redirected to the 

Signals Inventa configuration page, you can navigate back to Signals Data Factory by selecting the SDF 

Configuration sub-menu from Information Design in Signals Inventa. 
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14.6 Administration  

Using the Administration dropdown menu, you can access the administrative tasks.  

 

14.6.1  Advanced Security  

(This is an optional feature, and requires a System Administrator to enable it) 

In addition to the Project Security and Measurement Type Security, there is also an option to restrict users access to 

data at the row-level. These restrictions can apply to core entities (Compounds, Batches, Samples etc) as well as their 

measurements.  

Note: These permissions are combined with any existing Project and Measurement type security and will not override 

any of those settings. For example, if you do not have permission to see a project or measurement type, then granting 

permissions from the Advanced Security screen module will have no effect. 

By default, there are no restrictions on any entities or measurements. 

Once a ‘permission’ for an entity or measurement is assigned to a group, it immediately becomes restricted and only 

users belonging to that group can see that restricted entity. 

Note: Once an entity is restricted, that restriction will also apply to all child entities. For example, a user that can only 

see ‘Signals Inventa’ project would also be restricted to only seeing Compounds and Batches belonging to this project, 

as well as their measurements. 

Permissions are additive so, if different permissions for the same entity are assigned to two groups, and a user is a 

member of both groups, they will be able to see the union of both sets of permissions. 

Default permissions – i.e. permission that you wish to be granted to any user – can be assigned to the group entry 

named ‘All Users’. (there is no requirement to create an actual ‘All Users’ group – this is managed internally) 

Example – Assigning groups to see Compounds by a specified Compound ID:  

• Starting from a position where projects are not restricted 

• Create a User Groups named “View Compounds” 

• Navigate to the Advanced Security page (via the Signals – Advanced Security menu) 

• Select the “View Compounds” group, and the “Compound” Entity  
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• Click the “Set/Edit Group Permission” button and type an advanced search criteria which identities the 
Compounds you wish to allow the selected group to see. In this case, the following search is likely applicable: 

 

 
 

• Select the “Batch” Entity  

• Click the “Set/Edit Group Permission” button and type an advanced search criteria: 

 

 
 

• Select the “BatchRow” Entity  

• Click the “Set/Edit Group Permission” button and type an advanced search criteria: 
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• Once this setting has been applied, only users within the “View Compounds” group will be able to see 

compounds, and they will only be able to see the compound “REG0000001”. 

o Those users will also be restricted to only seeing child Batches and Measurements related to this 

compound.  

• This can be repeated, creating a group that can see the compounds with other Compound IDs. 

The above configures for Batch and BatchRow are to allow the group users see all Batch and BatchRow data with the 

union of the above specified Compounds when you perform searching by Global Search in Spotfire.  

Notice that ‘All Users’ has a warning showing – this is indicating that there is an entity (Compound, Batch or BatchRow 

in this case) that has restrictions and which there is no default permission for all users – meaning that users must be a 

member of a group in order to see any Compounds, Batches or BatchRows. This is just a warning - this may be the 

desired configuration and is a perfectly valid setup. 

On the Advanced Security page there are two view modes – View Permissions by Groups, and View Permissions by 

Entities. Switch between these views using the button at the top-right of the screen. 

View by Groups: 

In this view the groups are listed first, with indicators to whether that group has permissions assigned the currently 

restricted entities. 

Selecting a group will display the permissions for each entity for that group, and from there it is possible to set/clear 

permissions. 
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View by Entities 

An alternative view is by Entity– selecting an entity will then update each group listed in the second column to indicate 

permissions granted to that group for the selected entity. 
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Note: Currently, this security is not applied when accessing project data from the project details pages, or when 

staging exports using the export mechanism – therefore these features are restricted and/or disabled when this 

security feature is enabled. 
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Examples of Advanced Security: 

Restriction examples for a group ‘ExampleGroup’ 

# Description Project  

Setting 

MType 

Setting 
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1 ExampleGroup 
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data in the 
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{ 

  "@entity": 

"Compound", 

  "@query": { 

    "@entity": "Project" 

  } 

} 

{ 

  "@entity": "Batch", 

  "@query": { 

    "@entity": 

"Project" 

  } 

} 

{ 

  "@entity": 

"BatchRow", 

  "@query": { 

    "@entity": "Project" 

  } 

} 

2 ExampleGroup 

can only access 

the data of the 

compound 

'REG00046426" 
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{ 

  "@entity": 

"Compound", 

  "@query": { 

    "@criteria": { 

      "$$Compound ID": 

[ 

        "REG00046426" 

      ] 

    } 

  } 

} 

{ 

"@entity": "Batch", 

"@query": { 

"@entity": "Project" 

} 

} 

{ 
  "@entity": 
"BatchRow", 
  "@query": { 
    "@entity": "Project" 
  } 
} 
 

3 ExampleGroup 

can only access 

the data of the 

compounds 

whose 'Batch 

Project ID' is 

'234" 
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{ 
  "@entity": 
"Compound", 
  "@query": { 
    "@entity": "Project" 
  } 
} 
 

{ 
  "@entity": "Batch", 
  "@query": { 
    "@criteria": { 
      "Batch Project 
ID": [ 
        "234" 
      ] 
    } 
  } 
} 

{ 

"@entity": "BatchRow", 

"@query": { 

"@entity": "Project" 

} 

} 
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4 ExampleGroup 

can only access 

the data that the 

'Temperature' in 

the mtype 

'SLDIntegrationT

estMeasurement

Type' is greater 

or equals to 30 

(only the rows in 

SLDIntegrationT

estMeasurement

Type' is 

restricted, and all 

rows in 

Compounds, 

Batch and AER 

will be returned 

with no 

restriction). 
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{ 
  "@entity": 
"Compound", 
  "@query": { 
    "@entity": "Project" 
  } 
} 
 

{ 

"@entity": "Batch", 

"@query": { 

"@entity": "Project" 

} 

} 

{ 
  "@entity": 
"BatchRow", 
  "@query": { 
    "@or": [ 
      { 
        "@criteria": { 
          "$$Type ID": [ 
            "Assay 
Endpoint Results" 
          ] 
        } 
      }, 
      { 
        "@criteria": { 
          "$$Type ID": [ 
            
"SLDIntegrationTestMe
asurementType" 
          ], 
          "Temperature": [ 
            { 
              "@range": { 
                "gte": 30 
              } 
            } 
          ] 
        } 
      } 
    ] 
  } 
} 

5 ExampleGroup 

can only access 

the data of 

compounds 

whose 

'Temperature' in 

'SLDIntegrationT

estMeasurement

Type' mtype 

equals to '21'. 
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{ 
  "@entity": 
"Compound", 
  "@query": { 
    "@entity": 
"Compound", 
    "@query": { 
      "@entity": 
"BatchRow", 
      "@query": { 
        "@and": [ 
          { 
            "@criteria": { 
              "$$Type ID": 
"SLDIntegrationTestM
easurementType" 
            } 
          }, 
          { 
            "@criteria": { 
              
"Temperature": { 
                "@in": [ 
                  "21" 
                ] 
              } 
            } 
          } 
        ] 
      } 
    } 
  } 
} 

{ 
  "@entity": "Batch", 
  "@query": { 
    "@entity": 
"Project" 
  } 
} 
 

{ 
  "@entity": 
"BatchRow", 
  "@query": { 
    "@or": [ 
      { 
        "@criteria": { 
          "$$Type ID": [ 
            "Assay 
Endpoint Results" 
          ] 
        } 
      }, 
      { 
        "@criteria": { 
          "$$Type ID": [ 
            
"SLDIntegrationTestMe
asurementType" 
          ], 
          "Temperature": [ 
            { 
              "@range": { 
                "gte": 30 
              } 
            } 
          ] 
        } 
      } 
    ] 
  } 
} 
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6 ExampleGroup 

can only access 

the data of the 

compound 

'REG00046426" 

whose 'Batch 

Project ID' is 

'234" 
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{ 

"@entity": 

"Compound", 

"@query": { 

"@criteria": { 

"$$Compound ID": [ 

"REG00046426" 

] 

} 

} 

} 

{ 

"@entity": "Batch", 

"@query": { 

"@criteria": { 

"Batch Project ID": [ 

"234" 

] 

} 

} 

} 

{ 

"@entity": "BatchRow", 

"@query": { 

"@entity": "Project" 

} 

} 

7 ExampleGroup 

can only access 

the data of the 

compound 

'REG00046426' 

whose 

'Temperature' in 

the mtype 

'SLDIntegraionT

estMeasurement

Type' is greater 

or equals to 30. 
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{ 

"@entity": 

"Compound", 

"@query": { 

"@criteria": { 

"$$Compound ID": [ 

"REG00046426" 

] 

} 

} 

} 

{ 

"@entity": "Batch", 

"@query": { 

"@entity": "Project" 

} 

} 

{ 
  "@entity": 
"BatchRow", 
  "@query": { 
    "@or": [ 
      { 
        "@criteria": { 
          "$$Type ID": [ 
            "Assay 
Endpoint Results" 
          ] 
        } 
      }, 
      { 
        "@criteria": { 
          "$$Type ID": [ 
            
"SLDIntegrationTestMe
asurementType" 
          ], 
          "Temperature": [ 
            { 
              "@range": { 
                "gte": 30 
              } 
            } 
          ] 
        } 
      } 
    ] 
  } 
} 
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8 ExampleGroup 

can only access 

the data of the 

compounds 

whose 'Batch 

Project ID' is 

'234" and 

'Temperature' in 

the mtype 

'SLDIntegraionT

estMeasurement

Type' is greater 

or equals to 30. 
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{ 
  "@entity": 
"Compound", 
  "@query": { 
    "@entity": "Project" 
  } 
} 
 

{ 

"@entity": "Batch", 

"@query": { 

"@criteria": { 

"Batch Project ID": [ 

"234" 

] 

} 

} 

} 

{ 
  "@entity": 
"BatchRow", 
  "@query": { 
    "@or": [ 
      { 
        "@criteria": { 
          "$$Type ID": [ 
            "Assay 
Endpoint Results" 
          ] 
        } 
      }, 
      { 
        "@criteria": { 
          "$$Type ID": [ 
            
"SLDIntegrationTestMe
asurementType" 
          ], 
          "Temperature": [ 
            { 
              "@range": { 
                "gte": 30 
              } 
            } 
          ] 
        } 
      } 
    ] 
  } 
} 

9 ExampleGroup 

can only access 

the data of the 

compound 

'REG00046426' 

whose 'Batch 

Project ID' is 

'234" and 

'Temperature' in 

the mtype 

'SLDIntegraionT

estMeasurement

Type' is greater 

or equals to 30. 
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{ 
"@entity": 
"Compound", 
"@query": { 
"@criteria": { 
"$$Compound ID": [ 
"REG00046426" 
] 
} 
} 
} 
 

{ 
"@entity": "Batch", 
"@query": { 
"@criteria": { 
"Batch Project ID": [ 
"234" 
] 
} 
} 
} 
 

{ 
  "@entity": 
"BatchRow", 
  "@query": { 
    "@or": [ 
      { 
        "@criteria": { 
          "$$Type ID": [ 
            "Assay 
Endpoint Results" 
          ] 
        } 
      }, 
      { 
        "@criteria": { 
          "$$Type ID": [ 
            
"SLDIntegrationTestMe
asurementType" 
          ], 
          "Temperature": [ 
            { 
              "@range": { 
                "gte": 30 
              } 
            } 
          ] 
        } 
      } 
    ] 
  } 
} 
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10 ExampleGroup 

can only access 

the data that any 

fields match 

'54.1523031' OR 

'3.532165686' 

E
x
a
m

p
le

G
ro

u
p
 

<
d
e
fa

u
lt
>

 

<
d
e
fa

u
lt
>

 

<
d
e
fa

u
lt
>

 

<
d
e
fa

u
lt
>

 

{ 
  "@entity": 
"Compound", 
  "@query": { 
    "@entity": "Project" 
  } 
} 
 

{ 
  "@entity": "Batch", 
  "@query": { 
    "@entity": 
"Project" 
  } 
} 
 

{ 
  "@entity": 
"BatchRow", 
  "@query": { 
    "@queryString": { 
      "query": 
"54.1523031 OR 
3.532165686" 
    } 
  } 
} 

11 ExampleGroup 

can only access 

the compounds 

with the 'exact' 

structure query 

criteria 
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{ 
  "@entity": 
"Compound", 
  "@query": { 
    "@criteria": { 
      "Chemical 
Structure": { 
        "@chemSearch": 
{ 
          
"chemicalStructure": 
"CN1N(C2=CC=CC=
C2)C(C(NC(C(N(C)C)
C)=O)=C1C)=O", 
          
"chemicalStructureTy
pe": 
"chemical/smiles", 
          "searchType": 
"exact" 
        } 
      } 
    } 
  } 
} 

{ 
  "@entity": "Batch", 
  "@query": { 
    "@entity": 
"Project" 
  } 
} 
 

{ 
  "@entity": 
"BatchRow", 
  "@query": { 
    "@entity": "Project" 
  } 
} 
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12 ExampleGroup 

can only access 

the compounds 

with the 

'substructure' 

structure query 

criteria 
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{ 
  "@entity": 
"Compound", 
  "@query": { 
    "@criteria": { 
      "Chemical 
Structure": { 
        "@chemSearch": 
{ 
          
"chemicalStructure": 
"[N]C1=CC=CC=C1", 
          
"chemicalStructureTy
pe": 
"chemical/smiles", 
          "searchType": 
"substructure", 
          
"tautomericSearch": 
true, 
          
"tetrahedralstereo": 
"either", 
          
"doublebondstereo": 
true, 
          
"hitanychargehetero": 
true, 
          
"hitanychargecarbon": 
true 
        } 
      } 
    } 
  } 
} 

{ 
  "@entity": "Batch", 
  "@query": { 
    "@entity": 
"Project" 
  } 
} 
 

{ 
  "@entity": 
"BatchRow", 
  "@query": { 
    "@entity": "Project" 
  } 
} 
 

13 ExampleGroup 

can only access 

the compounds 

with the 'full' 

structure query 

criteria 
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{ 
      "@entity": 
"Compound", 
      "@query": { 
        "@criteria": { 
          "Chemical 
Structure": { 
            
"@chemSearch": { 
              
"chemicalStructure": 
"CN1N(C2=CC=CC=
C2)C(C(NC(C(N(C)C)
C)=O)=C1C)=O", 
              
"chemicalStructureTy
pe": 
"chemical/smiles", 
              
"searchType": "full", 
              
"tautomericSearch": 
true 
            } 
          } 
        } 
      } 
    } 

{ 
  "@entity": "Batch", 
  "@query": { 
    "@entity": 
"Project" 
  } 
} 
 

{ 
  "@entity": 
"BatchRow", 
  "@query": { 
    "@entity": "Project" 
  } 
} 
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14 ExampleGroup 

can only access 

the compounds 

with the 'similar' 

structure query 

criteria 
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{ 
      "@entity": 
"Compound", 
      "@query": { 
        "@criteria": { 
          "Chemical 
Structure": { 
            
"@chemSearch": { 
              
"chemicalStructure": 
"CN1N(C2=CC=CC=
C2)C(C(NC(C(N(C)C)
C)=O)=C1C)=O", 
              
"chemicalStructureTy
pe": 
"chemical/smiles", 
              
"searchType": 
"similar", 
              
"substructureSearch": 
false, 
              
"similarityThreshold": 
90 
            } 
          } 
        } 
      } 
    } 

{ 
  "@entity": "Batch", 
  "@query": { 
    "@entity": 
"Project" 
  } 
} 
 

{ 
  "@entity": 
"BatchRow", 
  "@query": { 
    "@entity": "Project" 
  } 
} 
 

4.6.2  Manage Users 

Administrators can create new Users and Groups and assign roles to each.  

To manage users: 

1. Log in to Signals Data Factory as an Administrative User. 

2. Navigate to Administration > User Manager.   

The User Manager screen appears. The Users tab is displayed by defaults displaying a list of existing users.  

 

Note: Click the Download Permissions Report button to download a permissions report allowing you to verify 
access rights of all users and groups for the application.  

To create a new user group: 

1. From the User Groups tab, click New User Group.  
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2. Enter a Name and Description for the new group.  
3. Click Save.   

Note: The Administrative User must sign out of Signals Data Factory for changes to user roles or groups to take 
effect.  

To delete a group: 

1. Hover the mouse over the user to delete. An   icon appears in the Name column for that row.  

2. Click the   icon. The user is deleted. 

To create a new user: 

1. Click New User. 

 

2. Enter user details as required. 
3. Assign user to Roles and User Groups (if applicable).  
4. From the Host drop down list, select a host URL to associate with the user.  
5. Click Save.  
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Note: It is not possible to create new roles, as the Roles tab displays only the System defined roles such as 
ROLE_ADMIN, ROLE_USER, AND ROLE_SUPERADMIN.  

Note: The Administrative User must sign out of Signals Data Factory for changes to user roles or groups to take 
effect.  

To delete a user: 

1. Hover the mouse over the user to delete. An   icon appears in the Username column for that row.  

2. Click the   icon. The user is deleted. 

 14.6.2.1  API Keys 

Signals Data Factory supports the use of API keys for third party integrations.  

To create an API key for a given user, select the user and click the Add API Key to User button.  

Active API keys will be listed beneath the User Groups list and can be de-activated by deleting them using the trash 

icon.  

14.6.3  Managing Jobs 

Here you can verify all jobs running on the system and manage them as required. You can also navigate directly to the 

respective project page for a job. You can also view the Job Execution Log for each job.  

You can toggle the Jobs page to Auto-Refresh.  

To view the job details: 

1. Navigate to Administration > Jobs.  

From the Jobs page, you can view/analyse the last five days of project data.  
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2. Select a job and click Go to Project or  Go to Job Details to view additional details for the 

project/job.    

14.6.4  Audit Log 

Here you can view the history of actions in Signals Data Factory including Projects, Information Design settings, User 
Management, and export/download operations. 

You can also view the history of a selected project or measurement type (and associated attributes). 

You have the option to Download the current view.  

To open the audit log: 

1. Navigate to Administration > Audit Log.  
2. Click on any audit log for additional information.  

 

There are 3 elements to an audit log entry: target, result, and parameters: 

• Target - details of the object, if it is being updated (in the state before the update). It will also include details of 

any other related objects that are affected by the change. For example, updating an attribute will also list all 

measurement types that include the attribute at the time of the update. 

• Result: details of an updated item; or of a new item, if the action is ‘create’. 

• Parameters: details of all parameters provided in the API call that invoked the operation. 

 

3. Filter the audit logs based on Projects or Measurement Types using the dropdown list box and entering the 

project or measurement type, by selecting them as follows and then enter the name of the project or 

measurement type. 

Note: There are links to filter the audit log directly from the Project Detail or Measurement Type pages. 

4. Click the Download Current View button to download the current audit log page details to your system. 
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14.6.5  System Monitor  

The System Monitor page allows you to monitor the status of the Elastic Search cluster and the general storage.   

To open the System Monitor page: 

1. Navigate to Administration > System Monitor.  

Elastic Search 

 

Storage  

This page allows you to ensure that you are not going to run out of disk space. This is the SETH general data storage 
and is indepent of the Elasticsearch storage.  

 

14.6.6  External Connections 

Signals Data Factory supports connections to external data sources – currently SQL data source is supported, which 

can be used to connect to other databases.  

To load data from an external connection, an administrator must first configure the external connection. 
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Note: The configured external connections can be used with the Import from SQL feature on the Projects page. 

To configure external connection: 

1. Navigate to Administration > External Connections. The Add External Connection page is displayed.  

 

2. Click Add External Connection button.  

When adding a connection, the following information is required: 

• the connection type (currently only SQL is available) 

• the database type  

o Oracle 

o MySQL 

o MSSQL 

o Redshift (also supports Redshift Spectrum) 

o Impala 

o Postgres 

o Snowflake 

• the connection string 

• username and password credentials 
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Once configured, project administrators will be able to import using this connection on the project details page. 

14.6.7 Signals Notebook Connection 

Compounds in Revvity Signals Notebook can be published to Signals Data Factory via the material synchronization 

feature so that these assets are then available in Signals Inventa’s Global Search.  

Once enabled in Signals Notebook, a Streams tab is added to each project in Signals Data Factory allowing the user to 

manage the subscription to the stream at the project level.   

From Signals Data Factory, select Administration > Signals Notebook Connection from the top toolbar. 

 

 

The available streams (buckets) from Signals Notebook are listed. The following controls are also available: 

• Pause: stops the monitoring of the system by temporarily disrupting the stream 

• Resume: restarts a paused stream 

• Delete: removes all buckets in the stream (can only be applied when the stream is retired and there are no 

subscribed projects) 

• Flush: forces a refresh and sync 

Refer to Appendix E: Signals Notebook Integration for more information.  
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14.6.8 System Configuration 

The System Configuration page displays current system settings for Retention Policy and Garbage Collection with the 
ability to modify the settings. Changes will take effect immediately and it is not necessary to restart your system in 
order for changes to take effect.  

 

A user with the ROLE_ADMIN role will be able to the menu to access this page and will be able to update the settings. 

Any other user will not see the menu to access the page. 
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Retention Policy 

The retention policy determines the number of days exports and project revisions are stored in the system before they 
are deleted.   

Export (days): 

• The period to time in days that an export is retained in the storage system  

Project Revisions 

• The period to time in days that a project revision is retained in the storage system  

Minimum Number of Project Revisions: 

• The minimum number of project revisions to retain before deleting revisions from the system  

In the example above, a project revision will be deleted provided it is over 30 days, and there are at least 50 
subsequent revisions in the system. 

Garbage Collection 

At a designated interval the trawler will go through the system storage and check all files. If a file is orphaned a tag is 
added which sets a target deletion date. This date is set according to the retention policy. If a file is orphaned and the 
date has passed it will be deleted. 
 

A file is considered not-orphaned if 

• it is referenced by any dataset in an active (i.e. not deleted) revision 

• it is the output of an import job for a revision 

• it is referenced by an ontology 

• it is part of an export 
 

Orphaned File Retention Period (minutes): 

• The period after being identified as an orphan that the file is retained in the system storage 

Default Garbage Collection Run Interval (minutes): 

• The interval at which the garbage collection process is run 

ES Garbage Collection Run Interval (minutes): 

• The interval at which garbage collection is run for the search index 
 
Security  
 
Restricted File Extensions 

• Comma separated list of file extensions restricted from being uploaded. Wildcards are not permitted. 
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14.7 Signals Data Factory Restricted Characters 

 

Measurement Type Name 

 

Attribute Name 

II  double pipe II  double pipe 

`   back tick `   back tick 

\   back slash \   back slash 

#  number sign  #  number sign 

:   colon .   period 

/  forward slash   \r\n  new line 

~  tilde “ double quote 

& ampersand ^ caret 

+  plus  $$ double dollar sign (at the beginning) 

*  star  

?  question mark  

[   opensquare bracket  

]   closesquare bracket  

{   open brace  

}   close brace  

_  underscore  
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15 Appendix C: Transformation Steps and Templates for 

Custom Aggregates 

A custom aggregation consists of one or multiple transformation steps, each of which is described as a JSON object (a 

JSON snippet that is included in a pair of braces). A custom aggregation is actually defined by a JSON object array 

that contains multiple JSON objects. 

For example, the following JSON document describes a custom aggregation that has two transformation steps: 

[ 

  { 

    "Expression": "(Avg([Result Number]) OVER ([Result Name],[%IdentityColumn%])) & ' ' & (First([Endpoint 

Unit]) OVER ([Result Name],[%IdentityColumn%])) & ' +/- ' & (StdDev([Result Number]) OVER ([Result 

Name],[%IdentityColumn%])) & ' (' & (Count() OVER ([Result Name],[%IdentityColumn%])) & ')'", 

    "ResultColumnName": "Temp Result", 

    "Actions": null, 

    "name": "siaAddCalculatedColumnTransformation_New", 

    "typeId": "signals.transformations.addCalculatedColumn" 

  }, 

  { 

    "CategoryColumns": [ 

      … 

    ], 

    "Actions": null, 

    "name": "siaPivotTransformation_New", 

    "typeId": "signals.transformations.pivot" 

  } 

] 

 

In the above example, the first step is to add a calculated column, the calculation expression is defined in the 

“Expression” element, and the resulting column will be named as “Temp Result”. In the second step, it does a pivot 

operation and the generated columns are then added to the SAR table.  

Signals Inventa provides two kinds of JSON objects that users can use for building their custom aggregations: 

Transformation Steps and Templates. Transformation Steps are the steps that are already implemented in Spotfire. 

Providing Transformation Steps in Signals Inventa allows the users to describe the custom aggregations in a text-

based JSON format. Templates are custom aggregations made up of several Transformation Steps, they are provided 

out-of-the-box: Users can create one custom aggregation by using a template and then make slight changes to meet 

their needs. Users can also define the custom aggregations by using the Transformation Steps from scratch so as to 

address more complex data process scenarios. 

For each of the transformation step, its JSON object could have the following elements: 

• name: The name of the current step, users can modify the name when necessary 

• typeId: The transformation step type identifier. Do not change the value of this property, it is used by the 

custom aggregation execution engine 

• Actions: A list of actions to be executed before or after a column is going to be/has been processed. Actions 

are described in its own section below 
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Transformation Steps 

Signals Inventa offers the following Transformation Steps. Most of these steps have the same name and function as 

the data transformations offered in Spotfire: 

• Exclude columns 

• Replace value 

• Replace specific value 

• Unpivot 

• Change data types 

• Change column names 

• Calculate new column 

• Filter rows 

• Pivot 

• Calculate and replace column 

 

The following table lists the parameters (JSON elements) for each transformation step. 

Transformation 

Step 

Parameter Description Example 

Exclude columns ColumnsToExclude 

An array of JSON 

elements that 

describes the 

name and data 

type of the 

columns to 

exclude 

{ 

  "ColumnsToExclude": [ 

   { 

      "Name": "Salt Name", 

      "DataType": "String" 

   }, 

   { 

      "Name": "Salt MW", 

      "DataType": "Real" 

   }, 

   { 

      "Name": "Assay Date", 

      "DataType": "DateTime" 

   }, 

   { 

      "Name": "QATest-Image-1", 

      "DataType": "Binary" 

   } 
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  ], 

  "Actions": null, 

  "name": 

"siaExcludeColumnsTransformation_New", 

  "typeId": 

"signals.transformations.excludeColumns" 

} 

Replace value 

Column 

A JSON object 

that represents 

the data column 

whose value 

should be 

replaced 

{ 

    "Column": { 

      "Name": "Temperature", 

      "DataType": "Real" 

    }, 

    "NewValue": "1", 

    "OriginValue": "77", 

    "Actions": null, 

    "name": 

"siaReplaceValueTransformation_New", 

    "typeId": 

"signals.transformations.replaceValue" 

} 

NewValue 
The new value to 

replace 

OriginValue 
The original value 

to be replaced 

Replace specific 

value 

Column 

A JSON object 

that represents 

the data column 

whose value 

should be 

replaced 

{ 

  "Column": { 

      "Name": "Temperature", 

      "DataType": "Real" 

  }, 

  "NewValue": 1, 

  "OriginValue": 66, 

  "RowIdentifyingColumns": [ 

    { 

      "Name": "Lit Ref", 

      "DataType": "String" 

    } 

  ], 

NewValue 
The new value to 

replace 

OriginValue 
The original value 

to be replaced 

RowIdentifyingColumns 

An array of JSON 

elements that 

describes the 

data columns 

whose values will 

be used for 

identifying the 

rows to be 

replaced 

RowIdentifyingColumnValues An array of JSON 

values that 
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identifies the 

rows 

  "RowIdentifyingColumnValues": [ 

      "TH1318:K10" 

  ], 

  "WarnWhenReplacingMultipleValues": false, 

  "Actions": null, 

  "name": 

"siaReplaceSpecificValueTransformation_New", 

  "typeId": 

"signals.transformations.replaceSpecificValue" 

} 

WarnWhenReplacingMultipleValues 

A Boolean value 

which indicates 

whether a 

warning should 

be prompted 

when multiple 

values are 

replaced. Default 

value is false 

Unpivot 

CategoryName 

The name of the 

column that 

summarizes the 

information 

provided in the 

columns that you 

have selected to 

transform. For 

instance, "Year" 

could be used 

when sales 

figures for 

several different 

years are to be 

combined to a 

single column 

{ 

  "CategoryName": "Category", 

  "DataType": "String", 

  "IdentityColumns": [ 

    { 

      "Name": "Compound ID", 

      "DataType": "String" 

    } 

  ], 

  "RemoveNull": true, 

  "ResultName": "Value", 

  "ResultType": "String", 

  "ValueColumns": [ 

    { 

      "Name": "Assay Date", 

      "DataType": "DateTime" 

    }, 

    { 

      "Name": "Salt Name", 

      "DataType": "String" 

    }, 

    { 

      "Name": "Temperature", 

DataType 

The data type of 

the category 

column name if 

several are 

possible 

IdentityColumns 

The identity 

columns that 

should be 

transferred to the 

unpivoted data 

set without any 

transformation 

RemoveNull 

A Boolean value 

which indicates 

whether the null 

values should be 

removed. The 

default value is 

false 

ResultName 
The name of the 

value column 
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ResultType 
The data type of 

the value column 

      "DataType": "Real" 

    } 

  ], 

  "Actions": null, 

  "name": "siaUnpivotTransformation_New", 

  "typeId": "signals.transformations.unpivot" 

} 

ValueColumns 

An array of JSON 

elements that 

represents the 

column values to 

be combined into 

a single column 

Change data types 

Columns 

An array of JSON 

elements whose 

data type needs 

to be changed 

{ 

  "Columns": [ 

    { 

      "Name": "Salt Name", 

      "DataType": "String" 

    }, 

    { 

      "Name": "Salt MW", 

      "DataType": "Real" 

    } 

  ], 

  "NewDataType": "String", 

  "Actions": null, 

  "name": 

"siaChangeDataTypeTransformation_New", 

  "typeId": 

"signals.transformations.changeDataType" 

} 

NewDataType 

The new data 

type for the 

specified 

columns 

Change column 

names 

ColumnNameExpression 

An expression 

which defines the 

name to which 

the column name 

should be 

changed 

{ 

  "ColumnNameExpression": "Upper([%C])", 

  "ColumnsToRename": [ 

    { 

      "Name": "Salt Name", 

      "DataType": "String" 

    }, 

    { 

      "Name": "Salt MW", 

ColumnsToRename 

An array of JSON 

elements that 

specifies the 

columns whose 

names are going 

to be changed 



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 344 of 366 

  

      "DataType": "Real" 

    } 

  ], 

  "Actions": null, 

  "name": "siaChangeNameTransformation_New", 

  "typeId": 

"signals.transformations.changeName" 

} 

Calculate new 

column 

Expression 

The expression 

that is used for 

calculating the 

new column 

{ 

  "Expression": "[Salt MW]*2", 

  "ResultColumnName": "SALT NAME * 2", 

  "Actions": null, 

  "name": 

"siaAddCalculatedColumnTransformation_New", 

  "typeId": 

"signals.transformations.addCalculatedColumn" 

} 

ResultColumnName 
The name of the 

resulting column 

Filter rows Expression 

The expression 

which defines the 

rule of the row 

filtering 

{ 

  "Expression": "[Result Number]=1700", 

  "Actions": null, 

  "name": "siaFilterRowsTransformation_New", 

  "typeId": 

"signals.transformations.filterRows" 

} 

Pivot CategoryColumns 

Each unique 

value in the 

chosen category 

column or 

hierarchy 

produces a new 

column for each 

aggregation 

method in the 

generated data 

table. 

Selecting more 

than one column 

means that the 

new data table 

will have a 

separate column 

for each unique 

combination of 

{ 

  "CategoryColumns": [ 

    { 

      "Name": "Result Text", 

      "DataType": "String" 

    }, 

  { 

      "Name": "Temperature", 

      "DataType": "Real" 

    }, 

  { 
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values in the 

chosen columns 

      "Name": "Assay Date", 

      "DataType": "DateTime" 

    } 

  ], 

  "CategorySeparator": "$$", 

  "IdentityColumns": [ 

    { 

      "Name": "Compound ID", 

      "DataType": "String" 

    } 

  ], 

  "ResultNamingExpression": "%M(%V) for %C", 

  "TransferColumns": null, 

  "TransferNamingExpression": null, 

  "ValueColumns": [ 

    { 

      "Aggregation": "Concatenate", 

      "Column": { 

        "Name": "Result Text", 

        "DataType": "String" 

      } 

    } 

  ], 

  "Actions": null, 

  "name": "siaPivotTransformation_New", 

  "typeId": "signals.transformations.pivot" 

} 

CategorySeparator 

A string that 

represents the 

category 

separator 

IdentityColumns 

An array of JSON 

elements that 

represents the 

identity columns. 

Each unique 

value in the 

chosen identity 

column or 

hierarchy 

produces a row in 

the generated 

table. 

If you choose 

more than one 

column, the new 

table will have a 

separate row for 

each unique 

combination of 

values in the 

chosen columns 

ResultNamingExpression 

Specifies how the 

pivoted columns 

should be named 

TransferColumns 

An array of JSON 

elements that 

specifies the 

transfer columns 

TransferNamingExpression 

Specifies how the 

transfer columns 

should be named 

ValueColumns 

An array of JSON 

elements that 

specifies the 

value columns 

Calculate and 

replace column 

ColumnToReplace 

The JSON object 

which represents 

the column to be 

replaced 

{ 

  "ColumnToReplace": { 

    "Name": "Salt Name", 

    "DataType": "String" 

  }, 

Expression 

The calculation 

expression for 

generating the 

new value 
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ResultColumnName 

Specifies the 

result column 

name 

  "Expression": "[Temperature]+2", 

  "ResultColumnName": "aaa", 

  "Actions": null, 

  "name": 

"siaReplaceColumnTransformation_New", 

  "typeId": 

"signals.transformations.replaceColumn" 

} 

 

Example - Concatenate Quoted Result Values 

Suppose the Batch Assay Endpoint Results table has the following rows: 

 

After the SAR table has been generated, by default, the result value will be aggregated by the Avg method: 

 

Follow the steps below to create a custom aggregation which doubles the result value: 

1. From the Configuration tab in the SAR app, click the Manage Custom Aggregations button.  
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2. In the Advanced Aggregation Setting dialog, click Create new button to create a new custom aggregation.  

3. For the Name field, input Concatenate Quoted Results. 

4. Optionally input the Description field to give the custom aggregation a descriptive text. 

5. In the Transformation Steps drop-down, choose Calculate new column, then click Add button. This will add 

a JSON object to the JSON array in the JSON editor. 

6. Edit the added JSON object in the JSON editor: 

a) Modify the value of “Expression” element to Concatenate('\"', Substitute([Result 

Text],'\"','\\\\\"'), '\"') 

b) Modify the value of “ResultColumnName” element to TmpResultText 

7. In the Transformation Steps drop-down, choose Pivot, then click Add button. This will  add another JSON 

object to the JSON array in the JSON editor. 

8. Edit the added JSON object in the JSON editor, the modified JSON object should be similar to the following: 

{ 

    "CategoryColumns": [ 

      { 

        "DataType": "String", 

        "Name": "Result Name" 

      } 

    ], 

    "CategorySeparator": ",", 

    "IdentityColumns": null, 

    "ResultNamingExpression": "%C", 

    "TransferColumns": null, 

    "TransferNamingExpression": null, 

    "ValueColumns": [ 

      { 

        "Aggregation": "Concatenate", 

        "Column": { 

          "DataType": "String", 

          "Name": "TmpResultText" 

        } 

      } 

    ], 

    "Actions": null, 

    "name": "siaPivotTransformation_New", 

    "typeId": "signals.transformations.pivot" 

  } 

9. Click the Save ( ) button to save the custom aggregation. At this point, your Advanced Aggregation 

Settings dialog would be similar to the example shown below: 
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10. Click Close button to close the dialog. 

11. In the Custom Aggregation(s) drop-down box, choose Concatenate Quoted Results, and click the OK 

button. 

 

12. After the SAR table refreshes, you will see an additional column whose name is the name of the result in the 

visualization layout: 
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Note: The column is named after the result name because in the Pivot transformation step, we set the 

ResultNamingExpression to “%C”, which means it will take the pivoted column name as the name of the result 

column.  

13. Check the checkbox on this column, it will be displayed in the SAR table: 

 

 

Actions 

For each of the Built-in Transformation Steps, users can specify a series of actions that are applied before or after the 

step has been executed. Currently Signals Inventa supports the action of replacing the values of the specified columns 
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with a ChemCharts SmartCell configuration, so that the values could be rendered by the ChemCharts SmartCell 

renderer. 

Append the following JSON schema to the Actions JSON array to achieve the SmartCell rendering: 

{ 

  "ApplyNumericShadowColumnProperty": true, 

  "NumericShadowColumnPattern": "%C Avg", 

  "ReplaceOriginColumn": true, 

  "SmartCellTemplate": { 

    "version": 0, 

    "views": { 

      "default": [ 

        { 

          "type": "list", 

          "values": [ 

            "%value%" 

          ], 

          "anchor": { 

            "horizontal": "center", 

            "vertical": "center" 

          }, 

          "font": { 

            "italic": false, 

            "size": 14 

          } 

        } 

      ] 

    } 

  }, 

  "ColumnMatchExpression": null, 

  "ResultColumnName": null, 

  "Type": "SiaReplaceSmartCellAction" 

} 
The explanation of the JSON elements in this schema is as follows: 

• ApplyNumericShadowColumnProperty: If this value is set to true, the NumericShadow column property will 

be added to the resulting column, with the value of the column name that matches the pattern specified on the 

NumericShadowColumnPattern element 

• NumericShadowColumnPattern: The pattern that defines how the Numeric Shadow column should be 

determined. Use “%C” as the wildcard that stands for the name of the original column based on which the 

pivoted column is generated 

• ReplaceOriginColumn: The Boolean value which indicates whether the SmartCell action should replace the 

original column. True to replace the original column, set it to false to add a new column 

• SmartCellTemplate: A SmartCell template string that describes how the content of the value should be 

rendered. For the detailed explanation about the SmartCell template, please refer to Revvity Lead Discovery 

Premium 3.5 Smart Cell Guide. Note you can use the %value% placeholder to indicate the place where the 

column value should be put in the template 

• ColumnMatchExpression: A regular expression that defines the columns that match this pattern should be 

processed by the current action 

• ResultColumnName: The name of the result column 

Example - Rendering Concatenate Quoted Results with SmartCell 

Follow the steps below to render the values generated by the Concatenate Quoted Results custom aggregation with 

the SmartCell renderer: 
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1. Under the Configuration tab of the SAR app, click Manage Custom Aggregations button. 

2. In the Advanced Aggregation Settings dialog, choose Concatenate Quoted Results custom aggregation 

that we created previously. 

3. Click the Edit ( ) button to edit this custom aggregation. 

4. In the JSON editor, scroll down to the second JSON object (which is the Pivot transformation step), modify its 

Actions element as follows: 

"Actions": [ 

      { 

        "ApplyNumericShadowColumnProperty": true, 

        "NumericShadowColumnPattern": "%C Avg", 

        "ReplaceOriginColumn": true, 

        "SmartCellTemplate": { 

          "version": 0, 

          "views": { 

            "default": [ 

              { 

                "type": "list", 

                "values": [ 

                  "%value%" 

                ], 

                "anchor": { 

                  "horizontal": "center", 

                  "vertical": "center" 

                }, 

                "font": { 

                  "italic": true, 

                  "bold": true, 

                  "size": 14 

                } 

              } 

            ] 

          } 

        }, 

        "ColumnMatchExpression": null, 

        "ResultColumnName": null, 

        "Type": "SiaReplaceSmartCellAction" 

      } 

    ] 

5. Click Save ( ) button to save the changes. 

6. If the Concatenate Quoted Results has already been selected in the Custom Aggregation(s) drop-down, 

the SAR table will be refreshed automatically when the custom aggregation is saved. If it is not selected, 

select it from the Custom Aggregation(s) drop-down: 

 
 

7. After the SAR table refreshes, the resulting column will be displayed, similar to the example shown below: 
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8. In Spotfire Analyst Client, from Data menu, click Column properties 

9. Check the column property of the resulting column on SAR Table, the NumericShadow property has been set 

correctly: 
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Important Note: SmartCell action only works in Lead Discovery ChemCharts. Spotfire Table Plot visualization doesn’t 

support SmartCell rendering. 

Out-of-the-Box Templates 

By default, the SAR Analysis app comes with four pre-defined templates that helps you to create your aggregations on 

the fly: 

• Avg +- StdDev 

• Avg +- StdDev (Count) 

• Avg +- StdDev (Count)[MultiAnchor] 

• Avg +- StdDev (Range, Count) 

• All-In-One 
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To create a custom aggregation based on the template: 

1. Under the Configuration tab of the SAR app, click Manage Custom Aggregations button. 

2. On the Advanced Aggregation Settings dialog, click Create new button. 

3. In the Name field, input the name of the new custom aggregation. 

4. In the Description field, optionally input the description. 

5. In the Transformation Steps drop-down box, choose the template you want to use, templates have the 

“(Template)” suffix on their names, then click Add button, this will add the template JSON to the Detail JSON 

editor. 

6. Click Save ( ) button to save the custom aggregation. 

To use the custom aggregation created based on a template, in the Custom Aggregation(s) drop-down box, choose 

the custom aggregation that you just created. 

Avg +- StdDev 

This custom aggregation aggregates the result value by both Avg and StdDev methods and combines the aggregated 

result with +/- sign. 

For example, the measurement result for compound REG00046419 in the Batch Assay Endpoint Result table: 

 

will result in the following Avg +- StdDev result: 

 

Avg +- StdDev (Count) 

This custom aggregation aggregates the result value by both Avg and StdDev methods and combines the aggregated 

result with +/- sign, followed by the number of results being aggregated. 



Revvity Signals InventaTM  3.5.1 User Guide 

 

 

© 2017 – 2024 Revvity Signals Software, Inc. All rights reserved. 355 of 366 

  

For example, the measurement result for compound REG00046419 in the Batch Assay Endpoint Result table: 

 

will result in the following Avg+- StdDev (Count) result: 

 

 

Avg +- StdDev (Count)[MultiAnchor] 

This custom aggregation behaves similarly to  Avg +- StdDev (Count), however,  it will put the result into different part 

with different location. 

For example, the measurement result for compound REG00046419 in the Batch Assay Endpoint Result table: 

 

will result in the following Avg+- StdDev (Count) [MultiAnchor] result:
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Avg +- StdDev (Range, Count) 

This custom aggregation aggregates the result value by both Avg and StdDev methods and combines the aggregated 

result with +/- sign, followed by both the range and number of results being aggregated. 

For example, the measurement result for compound REG00046419 in the Batch Assay Endpoint Result table: 

 

will result in the following Avg+- StdDev (Range, Count) result: 

 

All-In-One 

This custom aggregation concatenates the result value with the endpoint qualifier and aggregates the concatenated 

strings with the new-line separator. 

For example, the measurement result for compound REG00046419 in the Batch Assay Endpoint Result table: 

 

will result in the following All-In-One result: 
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16 Appendix D: Tips for Importing Images into Spotfire 

Thumbnails, curve images, and other images can be encoded differently depending on the file source. Often curve 

images from Signals VitroVivo and other programs are represented as ‘Strings’. In order to be interpreted as an image, 

the format much be converted from string to binary. The “Base64Decode()” option from the ‘Calculate New Column’ 

dialog can be used to convert strings into binary options. When mapping/publishing measurement types where the 

expected format is an ‘image’, users must select a binary column.  

Additional Notes: 

• Thumbnails are static images and cannot be edited directly 

• There's not a way to automatically take a base64-encoded string and interpret it as binary upon import into 

Spotfire (users must do the manual data transformation) 

• Base64-encoding strings can be quite long, so it's preferable files with strings are saved as delimited file type 

(csv, tsv).  Excel (xlsx, xls) is not recommended since the max string length for excel is 32,767 characters.  If 

the base64-encoded string is >32767 characters, the string will be truncated and images won't display 

properly. You can check to see if this is an issue by using the excel LEN() function to count the number of 

characters in a string. 

• JPEG and PNG are supported image types.   

• Formats like BMP and TIFF are not normally displayable within a web browser and thus not in Spotfire. 
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17 Appendix E: Signals Notebook Integration 

17.1 Signals Notebook Material Synchronization 

Compounds in Revvity Signals Notebook can be published to Signals Data Factory via the material synchronization 

feature so that these assets are then available in Signals Inventa’s Global Search.  

Once enabled, a Streams tab is added to each project in Signals Data Factory allowing the user to manage the 

subscription to the stream at the project level.   

17.1.1  Enabling Signals Notebook Material Synchronization  

1. From Signals Notebook, select your username in the top right-hand corner > System Configuration. 

Administrative privileges are required to select this option. 

2. Login at the prompt. 

3. Select the Materials        icon from the top toolbar, then the configured link to open Signals Inventa Integration. 

 

 
 

Note: This menu may also be accessed from the System Settings       icon from the top tool bar > Other > Signals 

Inventa Integration. 

 

4. Enter a Secret Key into the textboxes provided and select Save Settings, then copy the provided connection 

string. 

 

5. From Signals Data Factory, select Administration > Signals Notebook Connection from the top toolbar. 

6. Select Connect and paste the connection string and Secret Key into the appropriate textboxes. 
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7. Select Connect to establish the connection. 

Note: If the Secret Key is updated in Signals Notebook, it must also be updated from this page by selecting the  

button in the upper-right-hand corner > Update Secret Key. 

8. Return to Signals Notebook, from the Materials page, toggle on the Integrate with Signals Inventa toggle to 

begin the publishing process. 

 
 

Note: At this time, only the Compounds material can be toggled on. 

 

9. Return to Signals Data Factory, from the Signals Notebook Connection page, note the available streams 

(buckets) now listed. The following controls are also available: 

• Pause: stops the monitoring of the system by temporarily disrupting the stream 

• Resume: restarts a paused stream 

• Delete: removes all buckets in the stream (can only be applied when the stream is retired and there are no 

subscribed projects) 

• Flush: forces a refresh and sync 
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Note: New buckets are only added if the shape of the data changes (i.e. a new column is added) so that the user 

may map the new data appropriately. 

17.1.2  Selecting and Mapping a Stream in Signals Data Factory 

1. Open the desired project in Signals Data Factory. 

2. From the Streams tab, select . 

 

3. Select the desired steam entry and then the Select stream button. 

 

4. From the Streams tab, select <click to map> under the Map (Version) header. Refer to Mapping section in 

Appendix B:Signals Data Factory for more details on how map data. The ‘assetID’ must be mapped to 

Compound, and batchID’ to Batch. Alternatively, the user can select a pre-existing map via Load Map. 

Note: The user cannot map materials to a measurement type and this feature is therefore disabled. 

5. Select Update Bucket to return to the Streams tab. 
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6. Selecting Process Now will save the file and messages as a dataset, apply the specified map, and load the 

data. This button can be selected at any time to update the data from Signals Notebook to Signals Data 

Factory. 

 

Note: When a new field is added in Signals Notebook, a new bucket is created once processed. By default, it will use 

the previous bucket’s map. The user may optionally map the new field via the Streams tab to update the map, if 

desired. The most recent map is applied to all records and only the most recent bucket’s map can be edited. 

 

7. The dataset will now appear in the Datasets tab. These entries can be hidden by disabling the Show stream 

dataset in list toggle in the Streams tab. 

Note: Even if an entity or compound is deleted from Signals Notebook, a record will exist in Signals Data Factory. This 

can be viewed using an New Search (beta) feature with the tag “$$$isDeleted”: true. 

17.1.3  Configuring a Process Schedule  

1. From the Streams tab, select the  icon to launch the Configure Schedule menu. Specify a numerical 

value for how often the system should check for changes and the desired unit of time (minutes, hours, days). 

Optionally select the date and time to begin the process schedule and select Update Process Schedule. 

 

2. The Streams tab will now display the process schedule. 
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17.1.4  Retiring and Restarting a Stream 

1. If the user wishes to resend all stream data, they can turn off the Integrate with Signals Inventa toggle from 

the Materials page of Signals Notebook. A message warning the user that the stream will be deactivated is 

shown, select Deactivate. 

2. The Selected Stream (Status) will update in SDF to indicate it has been Retired. 

 

3. Turn on the Integrate with Signals Inventa toggle from the Materials page of Signals Notebook to begin a 

new stream. 

4. From the Administration > Signals Notebook Connection page in Signals Data Factory, the original stream 

will show as Retired and the new stream will show as Started. Select Flush to begin receiving messages. 

 

5. From the Streams tab, select the arrow next to the  button > Delete stream. 

6. Select the  button again and select the Started stream > Select stream. 
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7. Select <click to map> under the Map (Version) header and map as previously described. Select Process 

Now to save the file and messages as a dataset, apply the specified map, and load the data. 

8. From the Administration > Signals Notebook Connection page in Signals Data Factory, the retired stream 

can now be deleted via the Delete button. 
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18 Glossary 

Measurement  

A Measurement is a collection of values.  

Measurement Attribute 

A Measurement Attribute is the definition of the values. A single conceptual column information that can be collected 

when data is published to Signals Data Factory through Signals Inventa.  Measurement Attributes represent the 

abstract or conceptual definition of that information (e.g. "Assay Date", "IC50", "Assay Scientist") rather than the data 

itself.  A Measurement Type will be a set of Measurement Attributes that together capture all the information about a 

particular type of result, annotation, or experiment that would be helpful to scientists that access those data later.  A 

good analogy is that Measurement Attributes are like the columns of an Excel spreadsheet or a coma delimited tabular 

file. 

Measurement Type 

A Measurement Type represents the conceptual definition of some data that you would like to capture and publish 

through Signals Inventa.  For example, a particular assay protocol that generates IC50 results could be represented 

with a Measurement Type.  Measurement Types are composed of a collection of Measurement Attributes that together 

capture all the information about a particular measurement. A good analogy is that Measurement Types are like an 

Excel spreadsheet that is used to report assay or experimental results to other scientists. 

Measurement Type Map 

A Measurement Type Map is a set of information that relates the columns of a spread sheet or a csv table of results to 

the Measurement Type and Measurement Attributes that capture and publish those results through Signals 

Inventa.  This map is generally built once for relating given spreadsheet to a Measurement Type and then can be 

reused whenever new similar spreadsheets are published to the system. 

Endpoint 

An Endpoint is a multi-valued attribute that includes the key measured value together with additional information that 

puts the measured value in context.  For example, the IC50 endpoint attribute includes the numerical IC50 measured 

value, a textual representation of that value, its units, the name of the measured quantity, the type of the measured 

quantity, and optionally a qualifier for the measured value.  Defining the measured value with such consistent and 

detailed result attributes allows for the unification of endpoints from disparate assay protocols so that they can be 

searched and retrieved for analysis. 
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Endpoint Publication Map 

A special map that is created by a Data Administrator to relate a Measurement Type, and importantly the Endpoints of 

the Measurement Type, to the overall Signals Inventa data index.  This map is defined once and only once for each 

Measurement Type and includes information about how each Endpoint should be represented in the index - this drives 

data discovery and access. 

Publication  

A term for making data available to an index.  

Data Set 

A set of measurements that are collected together and labelled for future reference.  

When data is published to Signals Inventa you can create Data Set to organize the data into manageable groupings.  

As part of the act of publishing data you can elect to create a new data set, update, or overwrite an existing Data Set. 

 

 


